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Thank you for choosing SATlive.

[bookmark: __RefHeading__22009_1736061587]License / Registration / Terms of use
· If you like SATlive after some testing, you can order the full version which does not contain any limitations.
· Please use the demo to check the program's compatibility with your hardware and operating system.
· If you're facing troubles with the demo, the full version will not fix them. In this case please feel free to contact me, so we can try to solve your problem prior to registration.
· Please understand, that no liability can be taken for the proper function of the software with a specific hardware configuration. This case does not establish any claim to refund.
· According to today's level of engineering it is impossible to build a software which is properly working on all hardware / OS configurations.
1. Please report all kind of problems to the forum or via e-mail (info@satlive.audio).
· The process of demo registration starts with the request of a demo key. The demo key has to be enabled after you received it via e-mail.
· To get and install a full version license, please follow the steps shown in the full key menu
· [bookmark: RegistrationFull]There are two kinds of registration:
· FULL: This license is linked to one computer and no physical device is used.
· DONGLE: An external hardware device, a so called dongle is used to enable the software. Therefore the license is not tied to a certain computer.
· The current price list can be found in the internet at https://www.satlive.audio/order, where you could place your order, too.
· After the purchase is completed, then in case of Full registration the buyer (license owner) gets the KEY-files via e-mail, which enable him to create a full-version basic-key. For the completion of the registration, he needs to send the full-version basic-key via e-mail to Registration@SATlive.audio. In return he receives a key-file which will unlock SATlive on the PC on which the full-version basic-key was created.

· For the dongle version, the buyer (license owner) gets a small hardware device, which could be plugged into any usb port. SATlive will operate as long as the dongle is attached to the computer.
· All following updates and versions (until recalled) are licensed to the license owner. Just look on the sat-page (https://www.satlive.audio) and when you see a higher version-number just download the newest version.
[bookmark: __RefHeading___Toc41126_2823577171]Demo version
The following limitations apply to the demo version:
· When starting the program there is a DEMO display for 10 seconds.
· The program stops after 10 minutes of operation.
· The program runs only for 30 days after first start.
· You can register for a 30 days full featured demo using the demo basis key.
[bookmark: __RefHeading___Toc41128_2823577171]Terms of license
[bookmark: __RefHeading___Toc41130_2823577171]Demo:
· You are allowed to handle the demo to other computer-users, so that they can also test the program. This is only allowed on the condition that all files are handled completely and in unchanged original state
· Remark for online-representatives, shareware-dealers and shareware-distributors: This demo can be put on CDs or be offered in online-services.
· You can find the most current version at
https://www.satlive.audio/en/portfolio/the-current-version/
[bookmark: __RefHeading___Toc41132_2823577171]Both, full version and demo:
· There is no liability on the declarations made in this help file and I reserve the right to change it without notice. There is no liability for the correctness of the declarations and descriptions in this file.
· Your report of problems or bugs helps to make the program and the help better.
· I don't take any guarantee for the suitability of this program and/or other programs for a special case of application or special hardware-configuration.

· I take no liability for any kinds of damages which result from the application of this program or the inability to use this software. This includes the loss of profit, the loss of data and all other material and immaterial damages and deduced damages. This applies also in the case that I've been informed of the possibility of that kind of damage.
· Any bug report can help to make SATlive better. So please report bugs using the error reporting window.
· It is not allowed to disassemble and/or to patch this program or parts of this program or any other file supplied with this demo or full version.
[bookmark: __RefHeading___Toc41134_2823577171]Full-version
· I grant you, the user and owner,. the license to copy the software on one computer and to use the program on that computer. It is allowed for other persons to use it on that computer too.
· Both licenses, full and demo are valid for one computer only. The user selects this computer by creating the basic-key on that machine. The keys will work only on the machine where their basic-key was created.
· The user declares his convenience with these terms of license without any limitations by installing and using this program.
[bookmark: __RefHeading___Toc41136_2823577171]LIMITATIONS on the FULLVERSION
· This software is only dedicated to the user and license-owner. It is not allowed to handle the license to other people, to sell or rent the software, the key-files or the dongle either temporary or lasting. To do so, a written permission is necessary.
[bookmark: __RefHeading___Toc41138_2823577171]FINALIZATION of the LICENSE
The license is valid until finalization. The license is finalized, even without notice, by any offense against these terms of license. After finalization you must destroy the original license and all kinds of copies of this program. On demand you have to confirm the destroying of the program and of the copies by a written statement.
All product- and company's names are trademarks of the corresponding manufacturer.

[bookmark: __RefHeading__27668_823354303]Request a Demo Key
[image: ]The first step to get the 30 day unlimited demo is to request a demo key. 
Open the Request Demo Key window located at Help menu → Registration → Demoversion.

[image: ]Now mail the demo basic-key shown in the window to the e-mail address demo@satlive.audio.
You can either create the e-mail by your own and add the demo basic-key using copy and paste, or simply click on the e-mail button to let SATlive create the mail.
If your PC is not connected to the internet, you can store the information into a text file using the Text File button. Use a portable device to carry the file to a PC with an internet connection.
In return you'll receive the demo key, which you need to activate.
Hints:
· The demo key you'll receive is valid only on the computer where the demo basic-key was created on.
· Please use the e-mail option to avoid typos, which would delay the delivery of the demo key.
· Please check the date and time settings of your computer before the creation of the demo basic-key.
· The demo-key handling is not automated, so please allow some time for response.

[bookmark: __RefHeading___Toc41140_2823577171][image: ]Enable the Demo-key
After the request of the demo key you'll receive the demo key via e-mail. Open the Enable Demo window located at 
 Help → Registration → Demo version
[image: ]Just copy and paste the demo-key from the e-mail into the editor field on the enable demo window. Then click on OK and restart SATlive.

Hints:
· The demo-key you'll receive is valid only on the computer where the demo basic-key was created.
· Please check your date and time settings before creation of the demo basic-key.
[bookmark: __RefHeading__28536_823354303][image: ]Dongle
An external hardware key device for the USB port, a so called dongle, is available for SATlive. The dongle enables SATlive on the computer on which it is plugged in.
SATlive locks if you remove the dongle.
[image: ]If the dongle is plugged in again, then SATlive unlocks and you can go on working.
If you close the window, SATlive terminates.
You can check for a valid dongle in setup → internal configuration (see page  213).
Hints:
· The dongle must be plugged in before SATlive is started.
· The current display settings are stored on the dongle.
[bookmark: __RefHeading___Toc41142_2823577171][bookmark: hs6]Basics
All rights reserved by Dipl.- Ing. (FH) Thomas Neumann (1998-2019).

· The author does not take any liability for damage caused by the usage of this software.
· This program is able to create sounds, which can destroy technical equipment and cause damage to human hearing.
· We suggest that you start with very low level and then adjust them to the level needed. 
· For proper usage of this program you need basic knowledge of working with a computer and of acoustic measurement.
[bookmark: __RefHeading___Toc41144_2823577171][image: ]The three main modules of SATlive
· Impulse response: Here you can measure the system's impulse response using a maximum length sequence (MLS), or calculate it by comparing two signals.(Music Impulse Response (MIR)). An oscilloscope and a sweep based measurement can be found here as well.
· FFT: Shows phase and amplitude response of the impulse response measured in impulse response module. Furthermore you can compare and analyze traces
· MAT: Performs a dual channel FFT, shows the 'classic' RTA display or a FFT of one or both input channels.
[bookmark: __RefHeading___Toc41146_2823577171]The support and setup areas in SATlive
· Setup Allows you to customize SATlive to meet your needs. See page 180 for details.
· Clock Shows the current time or counts down to a given time. More details can be found on page 215 of this document.
· The Project management, described on page 248, eases the handling of larger speaker configurations. 
· Help access to the help file and the registration menu.

[bookmark: __RefHeading___Toc41148_2823577171]How to invoke a module?
To invoke a module, simply click on the particular button in the upper menu bar.
If you want to create a FFT of a measured impulse response, just invoke the FFT from within the impulse-response module.
[bookmark: __RefHeading___Toc41150_2823577171]What are the different areas in SATlive?
Because you can move the menus, the positions mentioned below refer to the default positions.
· Upper menu-bar located directly below the module – selection menu. Here you find the main measurement functions.
· Infodisplay located at the top of the trace display window. Shows information about the values at the cursor's position.
· Tracewindow the main window, showing the current trace(s). In most cases its popup menu contains tools and functions for analyzing the current trace.
· Lower menu-bar located below the trace window, it contains functions and settings for the layout of trace window. In MAT module it also contains functions for delay setting.
· VU-meter located right of the trace window. It shows the current input levels.
· Right menu-bar this menu is located below the VU-meter and features more functions.
· Generator located on the lower right edge. It supplies different kinds of audio-signals.

[bookmark: __RefHeading___Toc41152_2823577171][bookmark: Ref_LanguageFile]Language files
– This information is not valid for the Spanish language version of SATlive –
All the text information used in SATlive is stored in an external file, the so called language file.
[image: ]You can select the language file you want to use in the Setup → Features window by clicking on the change button in the lower area.
[image: ]This opens the language file selection window.
To select the language file you want to use, click on Select Language File.
The top most line shows the name of the currently selected language file. If no valid file is selected, then this line shows ---.
The bottom line shows the folder in which the currently selected language file is located.

Hints:
· On the start of SATlive the software scans for language files in the current directory. If it finds more than one language file, it uses the youngest file of the selected language.
· [image: ]If you're using an older language file, which may lack some strings needed, SATlive will display Text ID: followed by the missing index instead, and it will show the language-file selection window on each start.
· On the first start of a new version the language selection window is shown during start-up.

[bookmark: __RefHeading___Toc41154_2823577171]About this document
· Button's names and menu entries are shown in italic letters: Button Save means that you need to click with the left mouse button on the button labeled 'Save'. Please be aware that in some modes, the buttons will show only the icon, not the label.
· When you need to select an item from a menu or a list, the different steps are separated by an arrow. Setup → Options means: Do a left click on the button Setup then select Options from the popup menu.
· Nearly all buttons and displays in SATlive contain a popup menu. On the buttons this is indicated by a small arrow at the button's right side. To open a popup menu, you can either perform a click with the right mouse button on the button or a click with the left mouse button on the arrow.
Hint:
· SATlive features two kinds of menu layout which can be changed in the setup → display window. See page 193 for details.
[bookmark: __RefHeading___Toc41156_2823577171]Terms
· Live Trace and Current Trace are used to label the result of the current measurement. Depending on the module, the measurement can be still active or finished.
· The Selected Trace is used to indicate the trace currently selected for processing. By default the selected trace equals the current trace.
· The current measurement is the measurement which created the current trace.
· [image: ]Popup menu: A popup menu, also known as context menu, contains specific functions for related area. You can open it with a click with the right mouse button on the related area (button, display and so on).
In a menu bar a popup menu is indicated by a small arrow at the button's right side. You can click on the arrow with the left mouse button to open the popup menu.

· In SATlive the term Peak is used for the point with the highest absolute value.
· In the impulse – response module, the peak is helpful for the time alignment. You can use it as the reference for the window's position or the group delay.
· In the MAT and FFT module the Peak is the point with the highest amplitude value.
· Use the shortcut P to place the cursor at the current trace's Peak.
· The FFT Resolution indicates the distance between two points calculated by the FFT algorithm. The FFT Resolution is displayed in the selection of the FFT size.
A better resolution means a larger FFT size.
[bookmark: __RefHeading___Toc41158_2823577171]Memory trace
In the impulse–response module, in the FFT module and in the MAT module you can copy the live trace into a memory using the shortcut F5.
This copy, called the memory trace, gets exactly the same settings (Gain, smoothing) as applied to the live trace. The shortcut F6 toggles the memory trace's visibility.
Hints:
· The memory trace is lost when you exit the program or assign a new memory trace.
· In the impulse – response module the current impulse response is assigned to the second impulse response trace, which means that in this case F5 is similar to a click on the Assign button in the top menu bar.
· To read out the values of the memory trace you select it as the selected trace (see page 286 for details).
· You can use the function Load memory trace from file in the Tools menu to assign a stored trace to the memory trace.
[bookmark: __RefHeading___Toc41160_2823577171]Move the cursor using keys
The following keys can be used to move cursor in SATlive:
· Cursor right, Cursor left move the cursor one step in desired direction.
· Cursor right/left and Shift move the cursor by ten steps.
· Cursor right/left and Ctrl move the cursor by one hundred steps.
· Home Set the cursor on display's right border.
· End Set the cursor on display's left border.

[bookmark: __RefHeading___Toc41162_2823577171]Averaging
Averaging is available for all measurements in SATlive.
If you use averaging then the same measurement is performed more than one time and a mean value of all results is calculated and displayed. This reduces the influence of ambient noise to the measurement's result.
· In the impulse – response module the trace is shown after all measurements are done.
· The amount of measurements to be averaged is selected in the measurement's setup.
· In setup advanced sampling you can select the way SATlive handles differences in the single measurements.
· In the MAT module all measurements are performed consecutively and a so called FiFo averaging is used, except for the Average All setting.
In a FiFo (First In, First Out) averaging the results of the older measurements remain in memory. When the memory is filled up, then the oldest measurement is replaced by the current measurement's result.
After each measurement, the mean value of all data in memory is calculated.
There are two options for the calculation of the mean value in the MAT module.
· First one is the complex averaging, which is performed prior to the calculation of amplitude and phase values.
· Second one is the RMS averaging, which averaging calculates the amplitude value of each single measurement and averages the amplitude values. This excludes the phase from the display and makes the amplitude display more stable, especial for larger distances between the speaker and the mic.
· There is no FiFo averaging used MAT module if you select Average all Values.
The amount of averages and the averaging mode can be set in the layout area, which is located in the bottom menu area. For more details related to averaging, especial in the MAT – Module see page 314.

[bookmark: __RefHeading___Toc32246_3187356472]Trace's description
In SATlive you can assign and edit a description to every trace.
If you’ve selected remarks in Setup → Features → Fileinfo then the trace's description is shown when the trace is used as calibration, overlay or mic – correction data.
[image: ]You can edit the trace's description in the information window. You can toggle the trace's weighting using the button right of the editor field.
You can open the info window by:
· A left mouse button click on the symbol 
· Using the keys shift + I on your keyboard.
· If the option Show Fileinfo when saving is selected in Setup →  Features, then the info window shows up every time you save a trace.

[bookmark: __RefHeading__22403_1358155583][bookmark: anschlu__an_die_ausenwelt]Connections
In order to do correct measurements, you must wire SATlive correctly.
WARNING: 
· Wrong connections can destroy the pc's soundcard or
even other parts of the pc.
· NEVER connect an output or input to a speaker output or mains.
· Lower all external volume controls to minimum before starting SATlive.
The Output signal (soundcard's Line out) should be connected to an input of the console or of the device under test.
[bookmark: __RefHeading___Toc41164_2823577171][image: ]Using an external signal source
· The Reference input (By default Left In) receives the signal from the external source.
· The measurement mic is feed into the Mic input (By default Right In).
· Make sure that you feed exactly the same signal into the computer and into your sound system.

[bookmark: __RefHeading___Toc41166_2823577171]Using a measurement signal created by your computer
· [image: ]Feed the output-signal from the computer's Audio-output into your soundsystem and in the Reference input (By default: Left Input).
· Feed the signal of your measurement mic into the MIC input (By default: Right Input).
· You can either use an external mic – preamp or an audio-interface with a build-in preamp.
· Your measurement mic will need phantom-power.
· If there is only one input on your computer, you can use the direct-reference feature, which is explained on page 330.

[bookmark: __RefHeading___Toc41168_2823577171]Measurement of an electronic device using the PC as signal source
· [image: ]Feed the signal from the PC's audio-output into the device under test and into the Reference input (By default: Left Input)
· Feed the output-signal of the device under test into the MIC input (By default: Right Input).
· Never connect any speaker output to an audio-interface.

[bookmark: __RefHeading___Toc41170_2823577171]Setup and verification:
· Use the VU meter to adjust the levels. Select Pink Noise at the signal generator and start signal using the speaker symbol  or the shortcut G. Adjust the level using the level adjustment in the signal-generator section or the shortcuts arrow up / arrow down, the windows mixers and your hardware.
· Go to the windows mixer, select the line input for recording, and adjust level so that VU meter's left (reference) bar shows approx. -10dB.
· Now set the gain of your mic-amp so that VU meter's right bar shows approx -10dB
To verify your settings, please perform the following checks:
· Stop the signal generator and talk into the mic.
· If you can hear your voice in the speaker, or you're faced with a feedback at the level – set procedure, there is a link between input and output.
You need to disable this 'feature', often called Direct (or zero latency) Monitoring. To do so, please refer to your manual of your audio device.
· Switch off the amp, and restart the signal-generator, using the (you remember?) the  button or the shortcut G.
· Now remove direct link between the output and reference input.
· If the VU meter's left side still shows a signal, you need to change your soundcard's recording mixer (set recording level for line out and mixerout to zero).
· If only the VU meter's left side shows signal, you've just flipped the inputs.

[bookmark: __RefHeading___Toc41172_2823577171][bookmark: messung]Measurement
Important: To archive a correct result, the system must not change during the measurement. Therefore any dynamic processing like exciter, compressors and so on have to be bypassed. 
Furthermore make sure that in the sound-card's mixer all 3D or the reverb effects or any other 'improvements' are disabled.
[bookmark: __RefHeading___Toc41174_2823577171]How to start a measurement?
In SATlive there are three different ways to start a measurement:

· Starting a measurement with a mouse-click (Impulse response module). You have to select the kind of measurement first, then you may adjust some parameters of measurement and finally start it by clicking on the button showing the selected measurement. In the complex menu layout this button is located above the trace-display window, in the simple menu layout it is in the lower menu bar. When the measurement is finished, you got a raw impulse response trace.
· Running a macro (Impulse response module). In this case you do not only start a predefined measurement with predefined settings, but also activate a defined treatment of the measurement's result. You can access two macros direct using Room/Speaker [image: ] and Direct/Equalizer [image: ]. To reach the other macros just click on User Macros M. This will open a list containing all twelve macros available. You can edit the macro settings at Setup → User Macros.
· [image: ]Automatic start of measurement (MAT module). In this case the measurement starts when you enter the module.
In the MAT module use the button Running/Frozen or the spacebar to control the operation. A green vertical line at the left of the button indicates a running measurement and a red line indicates a stopped one.
· When you change the measurement mode, the old measurement stops and afterwards the new measurement starts. Use the button Reset or the shortcut R to reset averaging and the Running/Frozen button on the right or the space-bar to start/stop the measurement.

[bookmark: __RefHeading___Toc41176_2823577171]How to prepare for the measurement?
· Connect your audio-interface and your hardware (See page 25).
· Check your wring and hardware settings by playing back pink noise (see page 223) and watching the VU meter during this test.
· For the impulse-response module you should create either a calibration file (see page 109) or the complex – calibration feature (see page 66)
· If you like to perform an absolute level measurement, you must adjust the level reference before the measurement (see page 217).
[bookmark: __RefHeading___Toc41178_2823577171]How to deal with problems?
· Problems related to wiring will bring up an error message (level too high, level too low) in the impulse-response module.
· Check the wiring and the settings of the soundcard's mixer, as described in the connection topic on page 25.
· Try using different latency settings.
· Try another soundcard or use a different audio driver. (Setup → I/O Devices). See page 180 for details.
· If you cannot solve your problems, please send an e-mail with a close description of the problem to Info@SATlive.audio.

[bookmark: __RefHeading___Toc41180_2823577171]Part one: Reference
[bookmark: __RefHeading___Toc41182_2823577171][bookmark: mt53][bookmark: Ref_irModul]The Impulse – Response Module
The impulse–response module features different methods to measure the impulse-response. Furthermore it contains an oscilloscope simulation, so you can look on the input signals directly.
To invoke impulse response module click on the Impulse response entry in top menu bar. The result of the measurements is an impulse response.
[bookmark: __RefHeading___Toc41184_2823577171]More about the Impulse Response
The impulse response is the output of a system feed with a very narrow and very high single impulse.
This is an ideal impulse response. There is now delay and you just see the initial impulse.
[image: ]This is a real world impulse response. Here you can see the initial delay and some discrete reflections.
The main purpose of the impulse response is the analysis of time related parameters, like delays and room acoustics.
You can transform an impulse response into a frequency response using a FFT calculation.
There are different ways to display an impulse response graph (see page 41 for details)

[bookmark: __RefHeading___Toc41186_2823577171]Select Measurement and start it (complex menu layout).
[image: ]You find this area in the top menu bar.
 Loop Measurement repeat the current measurement until you stop it, and display the result after each measurement's completion. You can combine this option with averaging.
· Select the measurement you want to perform from the selection, or select it using the shortcut F3.
· [image: ] MLS White MLS measurement using pure MLS sequence.
· [image: ] MLS Pink MLS measurement using pink filtered MLS sequence.
· [image: ] MIR Measurement dual Channel Algorithm to measure impulse response.
· [image: ] Sweep Measurement dual Channel Algorithm using a special excitation signal.
· [image: ] Oscilloscope show an oscilloscope to look on both input signals.
· GO the currently selected measurement's symbol is shown right to the selection box. Click on the symbol to start a measurement. The function's shortcut is F4.
· [image: ] Setup show the current measurement's setup. The function's shortcut is F9. The symbol changes with the measurement selected. There is no setup for the oscilloscope measurement here, because all settings for the oscilloscope are located in the right menu area.
· You can access the setting for the currently selected measurement in the Setup menu at the top menu bar also.

[bookmark: __RefHeading___Toc41188_2823577171]Using in the IR – Module
The Ir – module uses a more scientific approach to measurement than the MAT module (see page 117). The whole process consists of a defined sequence of different steps.
1. [image: ]Measure the impulse – response. There are different methods available to get the impulse – response of the system of interest. See page 67 for details of the different measurements and their options.
2. [image: ]Once you’ve measured the impulse – response you can show it in different ways (see page 41) and analyze it.:
1. You can simply read out time values by placing the cursor on the point of interest. If you’ve latch the cursor using the D key, SATlive will show the difference between both positions. See page 34 for more details about the options related to the cursor.
2. If wanted, you can use the impulse – response for room-acoustic calculations (see page 49).
3. Use the cursor (see page 34) to select a certain part of the impulse response for further analysis. This selection is called windowing (see page 36).
3. [image: ]You can transfer the selected part of the impulse – response into the frequency domain, where you’d be able to look on the frequency – response. To do so, use the FFT and Smooth – FFT functions. See page 81 for further details.

[bookmark: __RefHeading___Toc31293_3849671875]Using the cursor in the Impulse-Response Measurement
[image: ]Choose the current operation mode of the cursor from the popup menu of the main display area.
[bookmark: __RefHeading___Toc62864_477509012][bookmark: hs121]Move the left window border
· The option Left window border [image: ] can be found in the popup menu of the trace display in the impulse – response module.
· If this option is activated, then the left border of the upper trace window can be moved using the cursor keys.
· The actual value of the border will show above the trace window.
· The upper window always shows the data used for the FFT. The lower window shows the whole impulse response with the selected part marked in a different color. You can use the Left window border [image: ] function on both windows.
Hint:
· If the width of the window would exceed the maximum FFT size (64k Samples), the right border will be adjusted to keep the size at 64kSamples.
[bookmark: __RefHeading___Toc62866_477509012][bookmark: hs131]Move the right window border
· In the impulse-response module you find the option Right Window Border [image: ] in the popup menu of the trace display. In complex menu-mode it is also located in the right menu area.
· If this option is activated, then the right border of the upper window can be moved using the cursor keys.
· The actual position of the right border is shown above the trace display.
· The upper window always shows the data used for the FFT. The lower window shows the whole impulse response with the selected part marked in a different color. You can use the Right window border [image: ] function on both windows.
Hint:
· If the width of the window would exceed the maximum FFT size (64k Samples), the left border will be adjusted to keep the size at 64kSamples.

[bookmark: __RefHeading___Toc41190_2823577171]Cut right of cursor
In the impulse-response module you find this function in the trace's popup menu.
[bookmark: hs141]The right border of the upper window is set to the cursor's current position. This action is enabled only if the option [image: ] Set Cursor is selected.
[bookmark: __RefHeading___Toc41192_2823577171]Cut left of cursor
In the impulse-response module you find this function in the trace's popup menu.
The left border of the upper window is set to the cursor's current position. This action is enabled only if the option [image: ] Set Cursor is selected.
[bookmark: __RefHeading___Toc62868_477509012]Full Trace Display
The function Full Trace Display [image: ] is located in the impulse - response module's trace window's popup menu. It sets the upper window to the maximum FFT size (or to the size of the impulse response, if it is shorter than maximum FFT size).
Hints:
· The program tries to keep the current left border of the upper window. If the right border would exceed the actual size, then the left border is readjusted.
· This option can also be accessed using the shortcuts F or CTRL – F.
[bookmark: __RefHeading___Toc41194_2823577171]Save the Current Window
[image: ]In the impulse-response module this function saves the current border positions of the upper trace display as a user defined window. This function is located in the trace's popup menu.
· Click on [image: ] Save Current Window.
· Select the target to save the current window to.
· Select the reference for the window's position. Edit the window's name.
· You can verify and edit the window's parameter in the User Windowing section. See page 37 for details.

[bookmark: __RefHeading___Toc30017_3849671875]Windowing
For the analysis of the signal we use only a part of the signal. Just cutting might create some problems at the borders of our signal. So we can choose a so called windowing function to fade out. When you use an impulse – response we assume that there are no problems at the start of the interval because in most cases no significant amount of energy exists before the impulse response. In the dual – FFT measurements the windowing function will be used for both, fade – in and fade – out of the signal.
Use the windowing – window to control the windowing.
[image: ]You can access that window either by the entry User Windows in the popup menu of the trace – display area or by clicking on the User Windows symbol in the menu – area right of the display.
The current windowing function is applied to the signal prior to the calculation of the FFT or  smooth – FFT.
[bookmark: __RefHeading___Toc31383_2264685919]Display the windowing function
[image: ]The sub – menu Layout in the popup menu of the trace – display area contains the entry Display Window Function. Use this entry to control the display of the windowing – function in the upper display – area.
[bookmark: __RefHeading___Toc32683_2264685919]Visualization of the windowed impulse – response
[image: ]Use the entry Windowing Modifies Impulse Response’s Display in the sub – menu Layout in the popup menu of the trace – display ares to choose whether the selected windowing – function should affect the display of the impulse – response.

[bookmark: __RefHeading___Toc36241_3162919021]The window User Windows
[image: ]This window contains the settings of the windowing function (see page 36) used in the IR – module.
[image: ]You can invoke it using either the button User Windows in the right menu – area or the entry User Windows in the popup menu assigned to the display area.
On the left you’ll see the twelve presets available. Just click on an item in the list to recall it’s settings. The changes will show immediately in the display.
Use the area on the right to configure the window. To apply this setting click on the Apply Window button.
Note: If you’ve enabled the entry Close After Recall in the menu Tools, the window will close after a window has been applied, either via the Apply Window button or by clicking on a preset, the window will close automatically.

[bookmark: __RefHeading___Toc36243_3162919021]Parameter to edit
[image: ]In the right area of the user – windows editor you can configure the window to fit your demands.
Use the selection at the top of this area to choose the windowing function.
The second entry defines the reference in time used for the window:
· Absolute the window will start on a fixed time position (Left), and will have given size (Size).
· Related to Peak the impulse response's peak is used as the time for the window to apply. This is a good choice for measurements with varying time delays. You can edit the window's left distance to the position of the peak (Pre) and the window's right distance from the position of the peak (Post). The total size of window will be the sum of Pre and Post. Choosing a negative value for Pre will leave the peak of the impulse – response outside the window.
· Related to first signal takes the position where the impulse response first meets the threshold level will server as reference for the window. The position of the window will be defined by the offset setting, while size determines the length of the window.
Use the menu Tools (see page 39) to copy your settings to or from a preset.
Use the button Apply Window to apply your settings to the impulse – response.
Hints:
· You can perform manual windowing using the cursor and the trace display's popup menu as well. See page 34 for details.
· The peak of the impulse – response contains most of energy and information. Except for some special tasks, like looking on the reverb only, the window should include the peak.
· SATlive supplies two default windows. You can access the two windows with 10ms and 20ms size, related to the peak, either using the shortcuts Ctrl + 1 and Ctrl + 2 or click on the [image: ] button or the [image: ] button.

[bookmark: __RefHeading___Toc37533_3162919021]The menu of the user – windows editor
You can find this menu in the editor window of the user – windows (see page 37).
· Windowing: this menu contains the entry Close. Close will hide the window and return to the impulse – response measurement.
· [image: ]Tools:
· Save as Preset: Use this entry to copy the current settings of the right area (see page 38) into one of the ten presets. Choose the target preset from the sub – menu. You can not assign to the fixed window presets FIX 10 and FIX 20.
· Copy from Preset: Copies the values of the preset selected into the edit area (see page 38) on the right. Choose the source preset from the sub – menu.
· Close after Recall: If you’ve activated this entry, then the window will close automatically each time you apply a window, either using the Apply Window button in the right area or recalling a preset from the list on the left.

[bookmark: __RefHeading___Toc41196_2823577171][bookmark: hs3160]Second impulse response trace
In the impulse-response module SATlive supports two impulse response traces, which can be displayed at the same time.
There are two ways to assign a trace to the second trace:
· Copy the current trace to the second trace using either the F5 key or click on the Assign button in the top menu bar.
· Load the second trace from a file using the [image: ] Load second IR function from the menu Tools.
[image: ]If a second trace is assigned then a trace display mode selection is shown above right above the trace display. See page 41 for details.
In that selection you can select the kind of display used for the second trace.
[bookmark: __RefHeading___Toc41198_2823577171]How to save the impulse response?
Use the Save function to write the current impulse response to a file. If enabled in Setup → Features, the info window is shown prior to saving where you can edit the trace's description prior to saving.
If you want to save the impulse response for the use with other software or for the use as complex compensation data, then you have to select the type of file from the save button's popup menu.
See page 66 for details about complex compensation.

[bookmark: __RefHeading___Toc24576_309896246][bookmark: hs3165][bookmark: Ref_irTraceDisplayKind]Trace display modes in the impulse – response module
[image: ]There are different ways to display the impulse – response.
You can select the kind of display you want to use using a selection box located above the trace display window.
The left selection affects the current impulse – response, the right selection the latched (second) impulse – response.
The x – axis shows the time, and the y – axis shows the amplitude value in different ways.
[bookmark: __RefHeading___Toc41200_2823577171]Impulse response
[image: ]This display shows the impulse – response over time using a linear values and a linear scaling. This is the most basic display.
The lower display always shows the full size of the impulse – response in the linear display mode.
You can use the layout setting (see page 45)to change the display of the trace.
[bookmark: __RefHeading___Toc41202_2823577171]Impulse – Response (log)
[image: ]This kind of display shows the amplitude – values on a logarithmic scale. The logarithmic scale, a scaling close to the human reception of levels, makes it easier to detect peaks in the low level part of the impulse – response, which would be nearly invisible on a linear scale. The highest amplitude value is taken as the zero dB reference.
You can vary the display using the Display all data setting (see page 45).

[bookmark: __RefHeading___Toc41204_2823577171]ETC – (Energy Time Curve)
[image: ]This display shows the energy content of the impulse – response. This display creates an envelope of the impulse – response, making it easier to detect global effects. The amplitude is shown using a logarithmic scale, with the highest amplitude value as reference.
You can vary the display using the Display all data setting (see page 45).
[bookmark: __RefHeading___Toc31226_113024776]Schroeder Plot
[image: ]The Schroeder Plot shows the backward integration of the squared impulse – response. The backward integration creates a very smooth trace, which is used as the basis for a lot of room – acoustic calculation.
A common problem with the calculation of the Schroeder Plot is noise, which will affect the result.
There are different approaches how to deal with this problem.
Use the Configure Schroeder Trace window, described on page 43 to adjust the calculation of the trace according to your needs.

[bookmark: __RefHeading___Toc27744_116929454]Configure Schroeder Trace
As mentioned above (see page 42), there are[image: ] some parameters which will affect the Schroeder – trace. Especial the noise floor might create problems.
There are different approaches to deal with this challenges.
SATlive offers you the possibility to affect the calculation by choosing the calculation method and the amount of averaging applied prior to the calculation of the Schroeder trace.
You can change the settings in a small window, the so called Configure Schroeder Trace window.
[bookmark: __RefHeading___Toc41206_2823577171]Invoke the Configure Schroeder Trace window
In the IR – module use the menu – entry Configure Schroeder Trace in the menu Tools.
In the Room – Acoustic window (see page 49) you can either use the Configure Schroeder Trace entry in the menu Room – Acoustic, or the entry with the same name in the popup menu of the upper display area. A mouse click onto the status area at the bottom of the window also shows the window.
The options at left of the window enable you to choose the desired algorithm used for the calculation of the Schroeder trace. See the page 44 for details.
The setting Averaging time on the lower left controls the amount of averaging applied to the data prior to the calculation. A longer averaging time will improve the detection of the RT60 values but it might affect the calculation of the EDT, especial when the impulse – response shows a fast decay at its beginning.
Please note that any change in this window will trigger a new calculation, which might take some time, especial in the Room – Acoustic window, where a lot of traces will be calculated.
The button Default Settings at the lower left will reset the settings to their suggested values.

[bookmark: __RefHeading___Toc32370_113024776]Algorithm used for Calculation
[image: ]The Configure Schroeder Trace window (see page 43) allows you to change the algorithm used for the optimization of the Schroeder trace.
1. Remove noise: The mean value of the last 10% of the full impulse – response are used to calculate the mean value of the noise – floor. Afterwards this value is subtracted from the impulse response to reduce the effect of the noise.
· Use ETC: Calculate the values based on the ETC (see page 42). Otherwise the calculation will use log logarithmic impulse response.
· Limit Interval: Estimate the noise – only part at the end the measurement and excludes it from the calculation.
· Expand Trace: Extends the trace below the noise – floor using the later part of the calculated trace.
· Correct Values: Estimates the amount of valid data removed by the noise – removal and adds it during the calculation.

The image below shows some traces based on the same impulse response but calculated different settings. See the upper right area of the image for details of each trace.

[image: ]

[bookmark: __RefHeading___Toc29554_1156921593]Layout of the trace display (Display all data)
[image: ]Depending on the current settings, the impulse – response trace might contain a lot of data. Therefore there are two ways to display the trace.
You can select the mode from the sub – menu Layout in the popup menu of the trace – display.
[image: ]If the entry Display all data is checked, then all values will be drawn. For the full display of a large impulse – responses this might take some time due to the large amount of values.
To reduce the time needed for painting the width of the trace – display is limited to one pixel.
You can enable this option for the main trace using the entry Display all data (main trace). The entry Display all data (latched trace) in the sub – menu affects the display of the second (latched) trace.
The entry Show all data in the popup menu of a Quick – trace (see page 272) allows the control of its display.
[image: ]If this option is deactivated, then only one point is drawn for each pixel of the x axis. The value drawn is the value with the highest amplitude value within the time interval assigned to this pixel. If a wide range is displayed, then this display is similar to an envelope of the trace. 
The display might change when you change the range displayed or if you change the size of the display.

[bookmark: __RefHeading__21678_189244930]The Delay-Matrix
The delay matrix shows up to thirteen time values and the difference in time between each of them. You can also add a fixed delay to the values, in order compensate for a change in the reference delay after the measurement of the delay values.
[bookmark: __RefHeading___Toc41208_2823577171]Values used
The delay matrix always contains the current position of the ten time-markers (see page 306 for further details).
In the measurement of the impulse – response in the MAT module the position of the cursor, and the peak – positions in the upper and in the lower (zoom) area will show in the matrix also.
[bookmark: __RefHeading___Toc41210_2823577171]How to invoke
The entry delay matrix locates in the menu Marker in the pop – up menu of the trace area.
Furthermore you can find it in the marker menu in the top menu area of the delay – finder (see page 135). In the MAT module you’ll find this entry in the pop – up menu of the delay section (see page 166) also.
You can use the web – interface (see page 340) to access the delay – matrix.

[bookmark: __RefHeading___Toc41212_2823577171]The Display
[bookmark: __RefHeading___Toc41214_2823577171]The upper Area
[image: ]The upper area of the window contains a matrix that shows the difference in time and the distance calculated from the difference in time, related to the values assigned to the column and row.
The values show the delay to add to the position assigned to the row selected to reach the value assigned to the selected column.
You can select a cell by a mouse click. The values related to the selection will show in the lower area. 
· [image: ]To modify the label of a time – marker just right – click on its current label. This will open up a small window where you can edit the label.
· The color bar at the left indicates the polarity at the position of the marker at the moment of its assignment. A green bar indicates a value above zero and a red bar a value below zero.


[bookmark: __RefHeading___Toc41216_2823577171]The lower area
[image: ]If a cell is selected, than the lower area shows more details about the entries assigned to the row and column.
If you select a cell in the left most column or in the topmost row, the lower area shows the information assigned to this entry. If you select an other cell, the information of both, column and row is shown in the lower area. The two upper lines contain:
· The polarity information at the moment of assignment. A green bar indicates a positive and a red bar a negative value.
· The label of the entry.
· The time value assigned to the entry
· The distance, calculated using the time value.
· The modified delay value, which is the sum of the time value and the offset value set by the time editor on the right.
The bottom line shows the difference, both in time and distance.
As long as the cursor is over the upper area the status – bar at the bottom of the window will show the row and the column of the cell at the current position of the cursor, which might differ from the cell selected.

[bookmark: __RefHeading___Toc31228_113024776][bookmark: hs3180]Room Acoustic Analysis
[bookmark: __RefHeading___Toc28384_170345104]Speech Transmission Index (STI)
The Speech Transmission Index (STI) is a value used to determine the intelligibility at the position of the measurement microphone.
The value considers the loss of modulation during the transmission of the sound, but not its frequency response. SATlive uses the impulse response to calculate the STI value.
[image: ]You can invoke the STI window from the Tools menu. If you’re using the menu mode complex then there will be a button STI in the upper menu bar. The loss of modulation is calculated for different frequencies used for modulation, and for different octave bands of the audio signal. There are 98 values which will be averaged using different weighting factors, based on the voice type setting, to get a single number as result.
[bookmark: __RefHeading___Toc41218_2823577171]The Window
[image: ]The top area shows the STI value calculated. Below the STI value you’ll find the values for CSI and ALcons, both calculated based on the STI value. Right to this values the classification of the STI value according to IEC 60268.
At the upper right you can select the type of voice used for the calculation. The setting Male voice is the commonly used.
Below of this selection the part of the impulse response used for the calculation is shown. This part always starts at the start of the impulse response. Please note that for the good result this part needs to be longer as the RT60 of the room examined. You can change this setting in the STI entry of the menu. See page 50 for further information.
The center of the window shows all 98 values. Use the entry Display of the menu (see page 50) to change the type of this display.
Use the button Close at lower right to return to the impulse response module.

[bookmark: __RefHeading___Toc34243_3857253969][bookmark: hs3185][image: ]The menu bar of the STI window
The menu bar of the STI calculation offers some options for the post-process and the display of the calculated result.
[image: ]On the left there is the menu STI which contains this options:
· [image: ]Save trace as picture use this function to save the current display of the STI values. Select the format of the picture in the save dialog.
· Part of IR used for Calculation this setting allows you to exclude some of the tail of the impulse response from the calculation of the STI value. For a good result the length of the remaining part should exceed the RT60 of the room examined.
The current setting will show at the display’s upper right area.
· [image: ]Print use this function to print the current display, information about the impulse response used as base for the calculation and a remark, which SATlive prompts for.
· [image: ]Setup Printer use this function to change the printer and its properties.
· [image: ]Close closes the window and returns to the Impulse Response module.
The next entry is the submenu Display
You can select how to display the results of the STI calculation.
· Show as Matrix shows all values as numbers in a table. If the option Results colored in the menu Setup is selected then the background color of each value displays according to the value.
· [image: ]Show M-Values related to Frequency Range draws the values as a function of the different audio bands used for calculation. For each frequency of modulation a single trace is drawn. You can enable the display of individual traces in the option's sub menu.

· [image: ]Show M-Values related to Modulation Frequency draws the values as a function of the different frequencies used for modulation. For each band of the audio signal a single trace is drawn. You can enable the display of individual traces in the option's sub menu.
· Smoothing in the function's sub-menu you can select how much smoothing is applied to the traces.

[image: ]The rightmost entry is the menu Setup.
· Results colored assign a background color to each value according to its value. This setting affects only the Show as Matrix display.
· Show grid shows a grid separating the individual values in the Show as Matrix display.
· Low Color Reference sets the threshold for the red color. Any values below this value is shown in full red in the Show as Matrix display. A value of 1.0 is shown in full green. This setting affects the layout only if the Results colored option is activated.
Hint:
· Below the display of the STI value in the top bar you can find two other values used for the judgment of intelligibility. Both are calculated based on the STI value.
· ALcons, an abbreviation for Articulation Loss of Consonants, a number that aims on the audibility of consonants. This value shows the loss a percentage – value.
· CIS, which means Common Intelligibility Scale, is a logarithmic conversation of the STI value. It shortens the wide range of ‘good’ STI values to allow a more exact judgment in the critical range of the intelligibility values.

[bookmark: __RefHeading___Toc28386_170345104][bookmark: hs3190]Room Acoustic Calculation
[image: ]SATlive offers a room acoustic tool to calculate room – acoustic values using an impulse response. The quality of the results relates to the quality of the impulse response used, so you should take care to create a good impulse response (use long impulse responses). The room-acoustic tool is invoked in the menu Tools (see page 86).
The traces for the reverberation times are shown at the top. Below the graphic there is a table containing the numerical values of the reverberation times and other room – acoustic parameters (see page 60 for details).
The room – data manger (see page 62) on the right side of the window allows you to easily average different measurements of the same room.
The tool starts using the last selected calculation settings. See page 43 for details.
You can modify the settings using the menu entry Configure Schroeder Trace in the menu entry Room Acoustic.

[bookmark: __RefHeading___Toc32946_227786404]The views of the acoustic window
The acoustic window supports two different modes.
· In the Single trace mode mode different acoustic values, all based on the same measurement (the so called master – trace), will show in the display and in the numeric display.
· Using the Multi trace mode you can display a certain room-acoustic value of more than one trace.
Use the entry Show multiple traces in the menu Display (see page 55) to toggle between the two views.
[bookmark: __RefHeading___Toc41220_2823577171]Managing Traces in Multi Trace Mode
Using the multi – trace mode you can display up to eleven different traces in the display.
[image: ]You can control the visibility of the main – trace, of the memory – trace and of the room – data trace in their menus.
The control of the eight trace latches is similar to the quick – trace handling (see page 270 for details) and can be done using the popup menu.
· To assign the main – trace to a trace – latch use the entry Copy to Trace – Memory in the menu Main – Trace.
· [image: ]Use the entry Load Acoustic Data to load stored acoustic data into the trace – memory.
· Show trace toggles the visibility of the trace. You can also click on the upper area of the icon to toggle the visibility of the trace.
· The entry Select this Trace brings the trace to the front and shows its values in the lower area. The name of the trace will show in the header. Click on the lower area of the icon to select the trace using the mouse.
· The entry Clear single trace will remove the acoustic data from this trace.


[bookmark: __RefHeading___Toc30103_744533287]The menu Room – Acoustic
This menu is located in the menu – bar of the Acoustic Window.
· [image: ]Loading will not affect Configuration select this entry to use the current settings of the Schroeder – trace. Otherwise the settings assigned to the file recalled will be used.
· Configure Schroeder Trace opens the configuration window for the calculation. See page 43 for details about this window. You can open this window also by a mouse click onto the status – bar at the bottom of the window. The status – bar shows the currently selected parameter of the calculation.
· [image: ]Print prints the room acoustic parameter and the reverberation graph.
· [image: ][image: ]Save Trace as Picture save the graphic to a file. You can select the kind of picture you want to save it to in the selection on the bottom of the save dialog.
· Close closes the window and returns to the impulse-response module.


[bookmark: __RefHeading___Toc24518_170345104]The menu Display
· [image: ]Use the entries at the top this menu to select the traces to show in the display area. In the single trace mode (see page 53) you can select any combination of traces for the display. Using the multi trace mode (see page 53) allows you to select only one type of acoustic data at a time. See page 60 for a close description of the different types of acoustic data.
· Value Display open the value – display menu to configure the value – display area located in the lower half of the window. 
See page 56 for a more detailed description of this menu.
· Show multiple Traces use this setting to toggle between the single trace and the multi trace mode of the acoustic window. See page 53 for more details.
· Display Filename shows the name of the file related to the acoustic values. Otherwise the description of the file is used.
· Schroeder Frequency
· The Schroeder Frequency is a threshold frequency based on the size of a room and on its reverberation time.
Below of that frequency you’ll need to calculate the acoustic using single frequency waves, above the broadband approach will fit.
· [image: ]Room size enter the room size used for the calculation of the Schroeder's frequency.  You can change the units used in the Setup → Features window. (see page 204 for details).
· Display Schroeder Frequency marks the area below the Schroeder Frequency in the display.

[bookmark: __RefHeading___Toc30271_1880682800]The menu Value – Display
[image: ]This menu configures the data – display in the lower half of the acoustic window.
You can access the menu either via the entry Value Display in the menu Display or by a clicking on the data – display area using the right mouse – button (popup menu).
Check the values you want to be displayed.
The height of the data – display will adapt to show all values selected.
See page 60 for a detailed description of the values available.
SATlive stores your selection.
[bookmark: __RefHeading___Toc24520_170345104]The menu Range
[image: ]Use the menu Range in the top menu bar to change the vertical range.
· You can choose the desired vertical display area by selecting one of the topmost entries in this menu.
· If you click on Full Range, then SATlive adjusts the display in way that all of the values are shown.
· If you enable the Autorange option, then the vertical range is adjusted to keep all of the traces displayed in the display area. This acts similar as the Full Range function, but this option adjusts the display range every time the values to display change. This setting is memorized and will be restored when you re-enter the room-acoustic tool.
· Use the Decimal Places sub-menu to adjust the display of the room-acoustic values in the lower half of the window according to your needs. Just select the desired amount of decimal places from the sub-menu. 
· No Decimal Place: The values show as whole numbers:		8 s
· One Decimal Place: One decimal place is shown:			7.9 s
· Two Decimal Places: Two decimal places are shown:		7.92 s
· Three Decimal Places: The highest amount available here:	7.921 s

[bookmark: __RefHeading___Toc41222_2823577171]The menu Main – Trace
[image: ]Use this menu to configure the display of the main trace.
· Show trace controls the visibility of the trace.
· Use Select this Trace to show the room acoustic values of this trace in the area below the display.
· Load Impulse Response loads an impulse – response from a file and converts it into acoustic data.
· Load Acoustic Data opens room – acoustic data stored in a file.
· Copy to Trace -memory will store a copy to one of the eight room data latches.
Select the target from the sub – menu of this entry.
· Add to room data will add the acoustic values of the main – trace to the current room – data project (see page 62).
· [image: ]Save Acoustic Data saves the results of the acoustic calculation based on the main – trace in a SATlive specific format. 
You can use the Memory Trace menu or the popup of the memory traces in multi trace mode (see page 53) to load and display a saved acoustic-data file.
· [image: ]Export (CSV, TXT) allows you export the results either as CSV (comma separated values), which is used for spreadsheets like Excel®, or as a plain text file. You can choose the desired type of file in the lower right area of the save – dialog window.

[bookmark: __RefHeading___Toc28388_170345104]The menu Memory Trace
[image: ]You can load a saved result of the acoustic calculation into a second trace, which is called memory trace.
You can use the memory – trace in both views (see page 53) of the acoustic – window.
· Show Memory Trace toggles the visibility of the memory trace. Hotkey F6.
· Select this Trace (available only in multi – trace mode) brings the memory – trace to the front and shows its values in the bottom area.
· Load Acoustic Data opens a dialog where you can select the set of acoustic data which you want to use as the memory trace data.
· Duplicate Main copies the data of the current display to the memory trace.
The shortcut for this function is F5.
· Clear empties the memory trace.
Hints:
· [image: ]In the single trace mode of the acoustic window (see page 53) the values of the memory trace show as thin lines and its values are displayed using default font, while the values of the main impulse response will show as thinker lines and the values will displayed using a bold font.
· If valid acoustic data has been loaded then the file name is shown in the lower left area of the acoustic-calculation window.

[bookmark: __RefHeading___Toc31618_1910671752]The menu room – data
[image: ]This menu controls the room – data manager. See page 62 for details about the room – data manager.
· Clear room data: Clear all data in the current room – data file. See page 62 for details for the room – data file.
· Show room data graphs: Select this entry to show the averaged values of the traces added to the current room – data set. The display will show the averaged values and their standard deviation is indicated by vertical bars.
· Check Quality: If checked SATlive will verify the quality of the values and will only add values with good quality to the room data file.
· Set description: This entry opens an editor window where you can edit the description of the current room – data set.
· Load room data: Use this entry to load a previously saved room – data set from a file.
· Save room data: This entry saves the current room – data set using the filename used during the previous loading or saving. It is enabled only if the current room – data set has either been saved or loaded before.
· Save room data as: Use this entry to save the current room – data set to a file. This entry opens a file – selection window where you can select the folder and name to store the data to.
· CSV Export: Use this entry to export the current room – data set as CSV data. You can import CSV data easily into spreadsheets, like Excel ©.
After the selection of the folder and name for saving the file to, a window will show up where you can edit the parameters and the values used for the export. Note your settings, because the spreadsheet – software might ask for it.
· Show Room Project Area: Use this entry to show or hide the Room – Project (see page 62) area. The area will show up automatically when you open a room – project.

[bookmark: __RefHeading___Toc25467_1027749648][bookmark: hs3195]Room – Acoustic Parameters
[image: ]The numeric results of the room acoustic calculation are shown in a table below the graphic display of the reverb – time values. The values are calculated for the whole  frequency range and for    octave-band filtered signals.
You can use the menu Value Display (see page 56) to hide the entries you’re not interested in. The height of the area will adapt to your selection.
· RT60 or reverberation time is the most common value used in room acoustics. 
It shows the calculated time that a sound would need to decay to 60dB below it's initial level. This time is calculated based on a certain range of the decay trace, depending on the signal to noise ratio available.
· RT60(30) is based on the slope between -5dB and -35dB.
· RT60(20) is based on the slope between -5dB and -25dB.
· RT60(10) is based on the slope between -5dB and -15dB.
· Optimum values for the RT60 depend on the size of the room. The literature suggests approx 2 seconds for music and approx 1 second for speech.
· The correlation of the result, is used to determine the quality of the calculation.
A value shown in italic font indicates a low correlation. You can display the correlation of each value by placing the cursor on an entry and holding the left mouse button down.
· EDT means Early Decay Time, which is another reverberation time. This time is calculated using the range from 0dB to -10dB. Under normal circumstances the EDT is the reverberation time that you 'feel' in a room, while the RT60 is a more technical value used for calculations. For music the EDT value should be approx 2.2 seconds.

· C50 and D50 are values which relate the energy arriving in the first 50 milliseconds compared to the whole energy (D50) or compared to the energy arriving after the first 50 milliseconds (C50). This values are useful hints for intelligibility. Values greater then 0dB (C50) or 50% (D50) indicate a good intelligibility.
· The calculation of the C80 and D80 values is similar to the calculation of the C50 and D50 values, with the difference that they relate to the energy arriving in the first 80 milliseconds. This values are used for judging the musical sound of a room. A good music reproduction is archived if the C80 value is between -3dB and +1dB, which is the same as a D80 value of around 50%.
· The center time marks the center of gravity of the energy-time area. It is a measure for position of the main energy in time. Its value should be below 80 milliseconds for speech and between 100 and 150 milliseconds for music reproduction.
1. [bookmark: tSchroe][image: ]The Schroeder's frequency depends on the room size, which can be set in the display menu (see page 55) of the room-acoustic window. You need to take care of discrete room – modes only at frequencies below the Schroeder's frequency.
The Schroeder's frequency is shown in the status – bar at the bottom of the room-acoustic window.
· The Bass – Ratio (BR) shows the relation of the sum of the RT60(20) values for the 125Hz and 250Hz band related to the sum of the values for 500Hz and 1kHz.
This value is an indicator how “boomy” the room will sound. Values above one will indicate intelligibility problems.
Hint:
· You can use the Decimal Places sub-menu in the range menu (see page 56) to adjust the display of the values.
· You can display the regression – lines for the full – range Schroeder – plot using the Configure Schroeder Trace window (see page 43).

[bookmark: __RefHeading___Toc30105_744533287]The room – data manager
This tool is attached to the room – acoustic window (see page 52).
It eases the averaging of different measurements of the same location. It supports saving and loading of room – data sets as well as export and display of the results.
The tool averages the four reverb – time values (RT6010, RT6020, RT6030 and ETC). 
The so called r – value, which is an indicator for the quality of the approximation used for the calculation of the values can be used as a threshold for the use of a specific value.
The visibility of this area is controlled by the Show Room Project Area setting in the menu Room Data Manager (see page 59). The area will show up automatically when you load a room – project.
[bookmark: __RefHeading___Toc41224_2823577171]Adding data
To add the values of a measurement to the room – data set, load the impulse – response into the room – acoustic window using the load command located in the menu room – acoustic (see page 54 for details about this menu). After that, add it to the room – data set using the entry Add to room data in the menu room – acoustic (see page 54).
[image: ]If the data you want to add match a data – set still in the room – data set then SATlive will show a confirmation window, otherwise the data will be added directly.

[bookmark: __RefHeading___Toc41226_2823577171]Display of the data
[image: ]The averaged values are shown at the top of the right area. SATlive shows the description of the impulse –  responses used for the averaging. Depending on the Check Quality setting in the menu Room – Data Manager (see page 59) values are shown only if the quality indicator (‘r – value’) of the values is over the quality – criteria.




[image: ][image: ]If the option Show room data graphs is enabled in the menu Room – Data manager (see page 59) then the calculated traces will show in the display area on the upper left, with the standard deviation shown as a vertical bar.
The CSV file or the text file generated by the room – data manager contains all numerical values.

[bookmark: __RefHeading___Toc41228_2823577171]Load impulse – response from a file
[image: ]The Load Timefile function opens a file selection window, where you can select the desired type of file from the selection box at the upper left.
· SAT Files new SATlive file type (*.SLD).
· SATlive Impulse response older version of time data files.
· PCM Wave Data impulse response saved as pcm wave file.
· Raw MLS imports a pcm file, that containing recorded audio from a MLS sequence.
Hints:
· The function's popup menu contains a list of the most recent used files.
· [image: ]When you open a pcm (‘wav’) file, a window containing details about the file will show up. If the wave file contains more than one channel, you can choose the channel to use in this window, too.

[bookmark: __RefHeading___Toc41230_2823577171]Set the parameters of the current measurement
The parameters of the measurements in the impulse – response module are set in an additional setup window.
There are different ways to open this setup window:
· [image: ]In the simple menu layout the setup is located in the popup menu of the start measurement button in the bottom menu bar. The setup is located in the sub menu [image: ] Setup.
· In the complex menu layout you find a dedicated bottom [image: ] for the setup right to the start measurement bottom in the top menu bar. The button's icon varies depending on the currently selected measurement. There is no setup button if the oscilloscope type measurement is selected.
· Use the button F9 to invoke the setup window of the current measurement.
· When you edit user macros, then the button Edit in the area Impulse Response invokes the setup.
· The menu Setup at the top contains the setup for the current measurement.
Hint:
A closer description of the measurements can be found starting at page 67 in this document.

[bookmark: __RefHeading__22407_1358155583][bookmark: Ref_Complex_Compensation]Complex Compensation
SATlive contains tools for examining the impulse response. 
Therefore a need for a calibration mechanism comparable to the calibration for the FFT arises for the impulse response only measurements.
[image: ]This is the reason for complex compensation, which is a compensation mechanism for the impulse response using a flat reference file with the same settings (size and samplerate) to compensate the influence of the measurement equipment like the preamp and the audio interface and, if needed, also to remove the filtering applied to the measurement signal.
· [image: ]To perform a complex compensation you must first create a complex compensation file. This is done by performing the same measurement with just a wire, i.e. with the output directly linked to the input.
· Then save the impulse response using the Save as Complex Compensation function.
· Now open the measurement's setup window, select the complex compensation file you saved in the last step, and activate the use of the complex compensation by checking the USE option. To check the complex compensation just repeat the measurement. It should result in a perfect impulse response.
Hints:
· You can use the complex compensation to compensate the influence of 'colored' measurement signals like the pink MLS signal.
· You can activate and assign complex compensation files in the macro setup.
· You can combine the complex compensation with the calibration of the FFT. But be careful not to overcompensate.
[bookmark: __RefHeading___Toc24578_309896246]Measurements in the Impulse – Response Module
[bookmark: __RefHeading___Toc27572_97599361]MIR Measurement
[image: ]The MIR Measurement is a measurement based on comparison of two channels, like the Dual Channel FFT. Opposite to the Dual Channel FFT, the MIR measurement will yield an impulse response.
Therefore there is no need to adjust the delay prior to measurement. In measurement's setup you can edit following settings:
· MIR Size select the length of the audio signal used to calculate the impulse response from. A higher number delivers a better result, but needs more time to perform.
· Window mode select the window applied to both input signals (measurement and reference) prior to the calculation. When the expected time delay between both signals is small related to MIR size, you should use the Flattop window. Otherwise rectangular window must be used, in order not to affect the impulse response.
· [bookmark: mirsync]Synchronize Generator links the start/stop of the signal generator with the start and end of the MIR measurement.
· Averages select the amount of measurements to be averaged before the calculation of the impulse response.
· Complex IR compensation select the file used for the complex compensation. Check use if you want to apply the selected compensation file. See page 66 for details about complex compensation.

Hints:
· In order to improve the quality of the result you should increase the MIR Size instead of increasing the amount of Averages. If your measurement is spoiled by unwanted external noise, you should increase the amount of averages.
· MIR measurement is located in the impulse – response module, but it's connections differ from those used for the MLS measurements.
· To get a high quality impulse response, the reference signal must contain all the frequencies of interest. Using pink noise will produce the best results. When you use music it should contain a wide frequency range.
· You can use the shortcut F3 to select the measurement, the shortcut F4 to start and the shortcut F9 for the setup of the selected measurement.
· If you want to measure only the frequency response, you should use the transfer function measurement in the MAT Module which contains possibilities to validate the result and a continuous display.


[bookmark: __RefHeading___Toc41232_2823577171][bookmark: hs1120]MLS white
[image: ]The MLS is a quick algorithm for the calculation of the impulse response.
It uses a special audio stimulation signal, called maximum length sequence, which has the same spectrum ('sound') as white noise.
The impulse response is calculated very quickly. One disadvantage of the MLS is the need for a special stimulation signal. 
In the measurement's setup you can edit these settings:
· MLS size select the length of the MLS stimulation signal used. The Impulse response calculated from this measurement will have the same length.
· Averages select the amount of measurements to be averaged prior to the calculation.
· Complex IR compensation select the file used for the complex compensation feature. Check use to apply the selected compensation. See page 66 for details.
Hints:
· To improve the quality of the result you should increase the MLS Size instead of the amount of Averages. If your measurement is spoiled by external noise, you should increase the amount of averages.
· For room measurements you should prefer MLS pink (see page 70), which will improve the quality of the impulse response at lower frequencies.
· For the MLS measurement to work properly, one MLS stimulus is played prior to the measurement.
· On reverberant conditions the impulse response's size (set by MLS Size) should be at least similar to the reverberation decay time (RT60).
· The MLS measurement's results can be affected by distortion and time variances of the measured system.
· You can use the shortcut F3 to select the measurement, the shortcut F4 to start and the shortcut F9 for the setup of the selected measurement.

[bookmark: __RefHeading___Toc25574_309896246][bookmark: hs1130]MLS Pink
[image: ]The MLS is a quick algorithm for calculation of the impulse response. It uses a special audio stimulation signal, called maximum length sequence, which has the same spectrum ('sound') as white noise.
White noise contains the same energy for the same frequency range (i.e. the same energy in the range from 50 Hz to 100 Hz as in the range from 5050 Hz to 5100 Hz), so you'll notice a lot of high frequencies when listening to a white noise signal.
To adapt this signal to human hearing, a so called 'pink' filter is applied, which leads to the same energy content for each octave. (now the range from 50 Hz to 100 Hz contains as much energy as the range from 5.000 Hz to 10.000 Hz).
This signal is much more suitable for acoustic measurements, like speaker or speaker – room measurements.
In a MLS Pink measurement, you have to remove the filtering after the measurement to get the correct result. Otherwise the result contains the frequency response of pink filter added to the measured impulse-response. You can use either the Complex Compensation (see page 66) or the calibration (see page 109) to remove the effect of the pink – filter.
The measurement setup allows you to edit these settings:
· MLS size select the length of the MLS stimulation signal used. The impulse response calculated from this measurement will have the same length.
· Averages select the amount of the measurements to be averaged prior to the calculation.
· Complex IR compensation select the file used for the complex compensation. Check use to apply the selected compensation to the impulse response. See page 66 for details about complex compensation.

Hints:
· To improve the quality of the result you should increase the MLS Size instead of increasing the amount of averages. If your measurement is spoiled by external noise, you should increase the amount of averages used.
· For the MLS measurement to work properly, one sequence has to be played prior to the measurement. Therefore a non averaged MLS measurement needs twice the time of the impulse response to perform.
· On reverberant condition the impulse response's size (set by MLS Size) should be larger or at least similar to the (expected) reverberation decay time (RT60).
· The MLS measurement's results can be affected by distortion and time variances of the measured system.
· You can use the shortcut F3 to select the measurement, the shortcut F4 to start and shortcut F9 for the setup of the selected measurement.

[bookmark: __RefHeading___Toc41234_2823577171][bookmark: hs1135]Sweep measurement (impulse response)
[image: ]The Sweep Measurement is a measurement based on the comparison of two channels, like the Dual Channel FFT, using a swept sine as the excitation signal.
The measurement will yield an impulse response.
Therefore there is no need to adjust the delay prior to the measurement.
In the measurement's setup you can edit the following settings:
· Size the length of the impulse response. A higher number delivers a better result, but needs more time to perform. The sweep-signal length is set to half the length of the impulse response, if Use short signal (Chirp) is not activated.
· Averages the amount of measurements to be averaged before calculation of the impulse response.
· From the starting frequency of sweep, i.e the lowest frequency played.
· To the ending frequency of sweep, i.e. the highest frequency played.
· Use short signal (Chirp) shortens the time used for the sweep signal, so that only a real short sound is audible. This setting does not affect the length of the impulse response calculated.
· High to Low use this setting to run the sweep from the high frequency down to the low frequency.
· Use STI – Filter for signal use this option to apply a digital filtering to the signal generator. This makes the energy contribution more similar to the contribution of energy in speech. You should use this filter only if you want to perform a STI --calculation (see page 49) using the impulse – response measured.
· Complex IR compensation select the file used for the complex compensation and enable it. Refer to page 66 for details about the complex compensation.

Hints:
· To improve the quality of the result you should increase the Size instead of increasing the amount of the averages. If your measurement is spoiled by unwanted external noise, you should increase the amount of averages used.
· The Sweep measurement is located in impulse response module, but its connections differ from those used for MLS measurements.
· You should use the STI – Filters only if you want to calculate the STI value, because the filter decreases the noise immunity of the measurement, especial at low and high frequencies. This is a wanted behavior for the measurement of the STI value, because intelligibility is affected by external noise also.
· You can use the shortcut F3 to select measurement, the shortcut F4 to start and the shortcut F9 to invoke the setup for the selected measurement.
· If you want to measure the frequency response, you should use the MAT Module, because of it's possibilities to validate the result. 
See page 124 for more details of the transfer – function measurement.

[bookmark: __RefHeading___Toc41236_2823577171][image: ]Oscilloscope
The oscilloscope measurement in the impulse – response module displays the signal on the inputs directly.
On the right side you’ll find the control section.
Use the Oscilloscope button to start or to freeze the display.
[bookmark: __RefHeading___Toc38815_209593912]The channel settings
[image: ]At the top you can see the current settings for the measurement input, and below you find the current settings for the reference input. The color on the left indicates the color of the trace in the display.
The upper line shows the current resolution, which can be changed in the settings window (see page 76).
The lower line contains three different areas.
· The area on the left shows the AC option. With the AC option enabled SATlive will try to remove the steady part of the input signal (its DC component). Click on the symbol to toggle the mode. The icon indicates the current mode. 
Please note, that most of the audio interfaces block DC signals at their inputs.
· At the center you can see the current vertical offset of the trace.
A click on this value will reset the offset to zero.
Use the settings window (see page 76) to set the vertical offset.
· Use the rectangle on the right to toggle the visibility of the trace. As long as the trace is visible the rectangle is filled with the color of the trace.

[bookmark: __RefHeading___Toc41639_209593912]The trigger settings
[image: ]The lower area contains the settings for the trigger and time – base.
The upper line shows the current time – base setting. The time – base  determines the horizontal range of the display.
Use the settings window (see page 78) to change the time – base.
The colored line at the left shows the current state of the trigger. A green line indicates that a trigger is available. Otherwise the line will show red color.
The lower area contains different settings:
· At the left you can choose whether triggering should occur when the signal rises above the threshold (rising edge) or when the signal drops below the threshold (falling edge). Click on the symbol to toggle the mode.
· At the center the current trigger – level will show. The trigger – level is the threshold used to trigger the display. The value shows in percentage of the height of the display. Click on this area to open the settings window (see page 76).
· The rectangle at the right indicates the trace selected as the source for the trigger. Click on the rectangle to toggle between both traces.
· The switch A activates auto – trigger. In this mode the display will redraw even if the input does not read the trigger threshold. This mode is also know as Free – Run.
· The switch S activates the single – shot mode. In this mode the display will redraw when the input first reaches threshold. Afterwards the display freezes until you click on a switch. Use this mode for impulsive signals like spikes or interference.


[bookmark: __RefHeading___Toc37405_209593912]The settings window
[image: ]To invoke this window just click onto the upper line of each area.
The upper area allows the selection of the vertical resolution for the selected trace. The entry GND will show the trace as a straight line at the current offset value.
The line at the left indicates the color of the trace assigned. To toggle between both traces you can click on the label above the selection. The popup menu of the vertical offset setting contains a trace selection where you can choose the trace you want to edit.
The slider allows you to move the trace in vertical direction.
To zero the vertical offset, either choose the entry Center from the popup menu or click on the display of the current offset value at the center of the bottom line of each channel setting (see page 74).
The lower part of the settings window contains the time – base selection.
· The trigger slider, which contains a popup menu, sets the threshold of the trigger.
· You can set the source of the trigger signal and the kind of the trigger in the trigger settings (see page 75) in the area right to the display.
· Using the X – offset slider you can move the traces in the horizontal direction. Like the other sliders this slider also contains a popup menu.
· The switch A activates auto – trigger. In this mode the display will redraw even if the input does not read the trigger threshold. This mode is also know as Free – Run.
· The switch S activates the single – shot mode. In this mode the display will redraw when the input first reaches threshold. Afterwards the display freezes until you click on a switch. Use this mode for impulsive signals like spikes or interference.
All changes you’ll do in this window will immediately affect the display.
Use the button Close to exit the settings window.


[bookmark: __RefHeading___Toc41238_2823577171]The menu tools
[image: ]The menu Tool contains some settings and functions for the oscilloscope (see page 74). The popup menu of the trace – display area will contain the same entries except of the Trace – Width setting.
· Trace Width use this setting to toggle different line - width values for the display. You can also use the key combination Ctrl + W for this function.
· Show Addition of both inputs. This entry adds an other trace to the display, calculated as the sum of both traces. You can select this options only if both traces use the same vertical scaling.
· Show Difference of both inputs. This entry subtracts the ref – signal from the mic – signal and shows the result.
· Show Trigger Threshold. This setting will draw a horizontal line at the current position of the trigger level.
· Use Vertical Offset. With this option set, the trigger line in the display will draw using the vertical offset currently used for the input selected as trigger – source. Otherwise the trigger line will relate to the zero line of the display regardless of the vertical offset used for the display of the trace.
· Save trace as picture. This entry will show a saver – dialog window where you can choose the type and the file – name used to save a screenshot of the current display.


[bookmark: __RefHeading___Toc41240_2823577171][bookmark: hs1140]Files and Traces (Impulse response complex menu layout)
[image: ]This menu is located in upper menu-bar.
· [image: ]Load time data loads a saved impulse response. The popup menu contains a list of the recently used files. Opening an impulse response will destroy the currently displayed impulse response.
· [image: ] Load time data into the second trace: load a saved impulse response into the second impulse response's trace.
· [image: ] Save Impulse response saves the current impulse response to a file. You can save impulse response in different types of file.
· [image: ] Trace width toggles the width of the trace. Shortcut Ctrl – W.
[bookmark: __RefHeading___Toc27590_309896246][bookmark: hs1145]Save the Impulse Response
[image: ]You can save the impulse response to different file types, which you find in the popup menu of the SAVE button.
· Save as SATlive data this is the default setting. The trace is saved containing all settings. If the show fileinfo when saving option in the Setup → Features window is enabled, the current settings are shown prior to saving the file. In this case you can edit the file's description. 
· [image: ] Save as Wave data saves the trace as a *.wav (windows pcm, mono) file.
· Save for praxis saves the impulse response readable for praxis (www.libinst.com) software. This great software allows a lot of post-processing, like waterfall display.
·  Save as complex compensation saves the current impulse response as complex compensation data. See page 66 for details about complex compensation.
·  Save trace as picture saves the upper display as a picture. You can select the picture's format from the file type selection box in the save menu.
Hints
· You can select the quality of the pictures at setup → features (See page 207 for details).
· Please note that SATlive will read only SATlive or PCM type files.

[bookmark: __RefHeading___Toc46274_1212603287]Automated Creation of the File – name
The IR module features automated creation of file – names and automated sequential saving, which speeds up the collection of measurements for acoustic analysis of a room.
This tool is also supported by the web – client (see page 333 for details).
Invoke the automation window in the pop – up menu of the trace display area (see page 83) by clicking the entry Automated File Name Creation.
[image: ]Use the button Directory to choose the directory where you want to place the files into.
Use the button Prefix to edit the first part of the filename.
The software will extent the prefix with a unique number.
The top area shows the directory chosen and the filename that will be used for the next saving.
The button Save allows you to manually save the current trace using the filename shown in the upper window. After saving the name will be updated.
Please note that you can save each trace just one time using this tool.
If the switch Save automatically is turned on (indicated by its green background), then SATlive will save the traces automatically directly after the end of the measurement. Afterwards the name will be updated.
The list at the bottom shows the path and name of the recently saved files, showing the time on the left and the most current file at the top.
Running this tool enables the remote control of the IR via the web – client (see page 339).

[bookmark: __RefHeading___Toc27588_309896246]Macros in impulse response module
[image: ]In SATlive a macro describes a measurement and it's post-processing performed in the impulse – response module.
SATlive features twelve different macros. The Macros one and two are directly assigned to the buttons Speaker/Room[image: ]and Direct / Equalizer [image: ]
· To edit a macro, go to Setup → User Macros (see page 191)
· You can start the first two macros with a mouse-click on the assigned buttons.
· The other ten macros can be accessed via the macro-list. The macro-list contains the first two macros as well.
· If you didn't run a macro before then a left mouse click on the button M shows the macro list.
· If you'd run a macro before then a left mouse click on the button M repeats the last used macro.
· You can open the macro-list using the popup menu of the button M.
· To run a macro from the list, just click on it's name or description with left mouse button.
· After the execution of a macro from the macro list, the macro's is assigned to the User Macro Button M. You can rerun the macro then by just clicking on the button. The other macros can be accessed via the button's popup menu.
· To get more information on a special macro, just click on it's name or description with right mouse button.

[bookmark: __RefHeading___Toc31295_3849671875][bookmark: hs1160]Perform a FFT using the current impulse response
· [image: ]In the simple menu layout this function is located in the lower menu-bar.


· [image: ]In the complex menu layout, this function is located in the top menu area.
· [image: ] FFT start the calculation of a FFT of the current impulse response's section which is shown in upper window, using the selected resolution. After performing the FFT SATlive changes to the FFT module. You can start the FFT using the shortcut F7, too. The resolution of the FFT can be selected from the popup menu of this button.
· [image: ] Smooth FFT start a Smooth FFT of the current impulse response's section displayed in upper trace window. You can also use the shortcut F8. The function Smooth Full, which you find in the button's popup menu, extends the right border of the upper display before performing the smooth FFT in order to get enough valid data for calculation.
[bookmark: __RefHeading___Toc41242_2823577171][bookmark: hs1170]Trace Display options in the Impulse — Response Module
This options are located in the right menu-bar.
· [image: ][image: ] Windowing toggles the application of the window selected prior to the FFT.
The window will always be a half window, i. e. it is only applied to the right half of the upper window, so avoiding spoiling of the peak, which should be in the left half. 
See page 36 for details about windowing in the IR module.
· [image: ] Lock the Window Avoids changing the selected region in the upper window when you run a macro. This could be helpful if you want to compare absolute phase values which always refer to the left window border.

[bookmark: __RefHeading___Toc41244_2823577171][bookmark: hs1180]Windowing in impulse response module
These options are located in the right menu area.
· [image: ][image: ] Window 10ms applies a 10ms window, starting at 400usec before the peak. Shortcut: CTRL – 1.
· [image: ] Window 20ms applies a 20ms window, starting at 400usec before the peak. Shortcut: CTRL – 2.
· User windows opens the User Window settings (see page 37), where you can either edit and apply preset windows or define the parameter of the window manually.
[bookmark: __RefHeading___Toc41246_2823577171][bookmark: hs1190]Cursor modes
[image: ]These options are located at right menu area (only in the complex menu-layout) and they are also present at trace display's popup menu.
These options select how SATlive reacts when you click on the impulse response's trace using the left mouse-button.
· [image: ] Set Cursor (Default) Set the cursor on the mouse click's position. You can also use the shortcut C to select this option.
· [image: ] Cut left of Click Set the left border of the upper window to the click's position.
· [image: ] Cut right of Click Set the right border of the upper window to the click's position
· [image: ]Set Cursor on Peak The cursor is moved to the point with the highest absolute value. This action is enabled only if the [image: ] Set Cursor mode is selected. You can also use the shortcut Shift + P to perform this action.
Hint:
· You can perform these options in both, the upper and the lower, trace displays.

[bookmark: __RefHeading___Toc27416_170345104][bookmark: hs1200]Impulse response trace's popup menu
[image: ]Click on the impulse response's display with the right mouse-button to open this popup menu.
· Show values of select the trace for cursor readout. You can select only traces currently showing in the display.
· [image: ] Set Cursor set the cursor on the position of the mouse-click. You can also use the shortcut C to select this option.
· [image: ] Cut left of Click set the left border of the upper window to the click's position.
· [image: ] Cut right of Click set the right border of the upper window to the click's position.
· [image: ] Left window Border see page 34 for details.
· [image: ] Right window Border see page 34 for details.
· Automated File Name Creation opens a window supporting automated file – name creation. See page 79 for details.
· [image: ] Full trace display see page 35 for details.
· [image: ] Cut left of Cursor the left border of the upper window is set to the cursor's current position. This action is enabled only if the option Set Cursor is selected.
· [image: ] Cut right of Cursor the right border of the upper window is set to the cursor's current position. This action is enabled only if the option Set Cursor is selected.
· [image: ]Set Cursor on Peak the cursor is moved to the point with the highest absolute value. This action is enabled only if the Set Cursor mode is selected. You can also use the shortcut Shift-P to perform this action.
· [image: ]Latch Cursor saves the cursor's current position as a reference. If a cursor is latched, the distance between the cursor's current position and the latched cursor's position will show above the display – area. This action is enabled only if the Set Cursor mode is selected. The shortcut for this function is D.

· [image: ] Marker place a marker on the current cursor position or show the delay – matrix. See the marker section at page 306 of this document for details.
· [image: ]Save current window save the current border positions of the upper window to a user defined window preset.
· [image: ]Information show information about the current trace. You can edit the trace's description in the information window.
· [image: ]User Windows open the editor for the user – windowing. See page 37 for further details.
· [image: ][image: ]Layout use the entries of this menu to control the display of the impulse – response.
· See page 45 for details about the Display all data options.
· [image: ]Horizontal grid shows a dashed horizontal line at the amplitude – value at the current position of the cursor.
· Display Windowing Function toggles the visibility of the currently selected windowing function. See page 36 for details.
· Windowing function modifies Impulse Response’s Display check this setting if you want to see the influence of the current windowing function on the impulse response. See page 36 for details.
· Hint: You can set the transparency of the quicktraces in the quicktrace main menu.
· Tools shows the tools menu (see page 86) containing more options and functions.

[bookmark: __RefHeading___Toc41248_2823577171]Impulse response Menu bar simple Layout
[image: ]If you’ve chosen the simple menu layout then a smaller amount of buttons is displayed. You can access many functions using a popup menu or the menu Tools.
· [image: ] Room/Speaker starts the macro Speaker in Room.
· [image: ] Direct/Equalizer start the macro Direct Electric.
· [image: ]User Macros show the user macro list to choose a macro from. After the execution of a macro the executed macro is assigned this button. See page 80 for details.
· Start selected measurement you can select the type of the measurement to perform in the button's popup menu. The button's popup menu allows you to invoke the setup window for the different types of measurement. You can use the shortcut F3 to select the type of the measurement, the shortcut F4 to start the selected measurement and the shortcut F9 to invoke the setup window assigned to the selected measurement.
· [image: ] Smooth FFT perform a Smooth FFT of the impulse response's selection shown in the upper window and then changes to the FFT module.
The button's popup menu contains the function Smooth Full, a smooth FFT with an automatic movement of the right border, and a 32kByte long FFT. You can use the shortcut F7 for the FFT and the shortcut F8 for the Smooth FFT.
· Tools more functions and options for the impulse — response module. See page 86 for details.
Hints
· You can edit the user macros at Setup → User Macros.
· Using the option Start measurement on selection at Setup → Measurement you can select if the measurement starts when you select another kind of measurement, or if you need to start the measurement with a click on the button or the shortcut F8.

[bookmark: __RefHeading___Toc28390_170345104][bookmark: hs1210]Menu Tools in the Impulse — Response Module
[image: ]You can invoke this menu either using by clicking on the Tools symbol in the main menu bar or via the trace display's popup menu.
· [image: ] FFT perform a FFT of the part of the impulse response in the upper window using the selected resolution. After performing the FFT SATlive changes to the FFT module. You can start the FFT using the shortcut F7, too. The resolution of the FFT can be selected in the popup menu of this option.
· [image: ] Trace width toggle the width of the current trace. You can use the shortcut Ctrl + W, too.
· [image: ]Save the impulse response save the current impulse response. You can save the impulse response to different types of file. See page 78 for details.
· [image: ]Load impulse response load an impulse response. The popup menu contains a list of recently used files. This overwrites the impulse – response currently shown.
· [image: ] Load second IR load an impulse response to be used as second trace.
· [image: ]Repeating Measurement if is option is selected the measurement and the post-process are repeated until the measurement is stopped by the user.
· [image: ]Intelligibility display the Speech Transmission Index (STI) calculated using the current impulse response. See page 49 for details.
· [image: ]Room-acoustic open the room acoustic parameters window using the current impulse response. See page 52 for details.
· Configure Schroeder Trace opens the Configure Schroeder Trace window (see page 43) to set the parameters used for the calculation of the Schroeder Trace.
Because the Room – Acoustic values (see page 60) are based on the Schroeder trace, this setting will also affect those values..
· [image: ]Lock window fixes the size and position of the selected part of the impulse response. The selected part is used for the calculation of the FFT. Use this setting if you want to compare time related values (like the phase – trace) in the FFT display.

[bookmark: __RefHeading___Toc45368_150880275][bookmark: hs1213]Right menu bar impulse response (simple menu layout)
[image: ]As you might guess this menu is located right of the trace display window.
· [image: ]Cursor on Peak the cursor is moved to the point with the highest absolute value. This action is enabled only if the Set Cursor mode is selected. You can also use the shortcut P to perform this action.
· [image: ]Latch Cursor Saves the cursor's current position as a reference. If a cursor is latched, the distance between the current cursor and the latched cursor is displayed. The latched cursor's position is displayed below the symbol. 
The shortcut for this function is D.
· [image: ] Full window Set the upper window to the FFT size (or to the size of the impulse response, if this is shorter then the FFT size). The shortcut is F.
· [image: ] Window 10ms Apply a 10ms wide window with its left border 400usec before the peak. You can use the shortcut Ctrl + 1 as well.
· [image: ] Window 20ms Apply a 20ms wide window with its left border 400usec before the peak. You can also use shortcut Ctrl + 2.
· [image: ] User Windows open the editor for the user – window. 
See page 37 for further details.
Hints
· The user – windows feature an editor window where you can modify and select the type and size of the window you want to apply to the impulse – response.
You’ll find the description of the editor at page 37.
· You can add the current window to the user window list using the Save Current Window option from the Trace display's popup menu.

[bookmark: __RefHeading___Toc41250_2823577171]Common menus for FFT module and MAT module
[bookmark: __RefHeading___Toc41252_2823577171][bookmark: Ref_Fq_Scale_Style]FQ Scale Style
[image: ]The [image: ]FQ Scale Style option is available in the FFT module and in the MAT module, were you can find it in the Menu Tools. 
It selects the vertical (frequency) scaling for the display area:
· [image: ][image: ] EQ 32: the scale shows the bands of a 32 band EQ.
· [image: ] Logarithmic style: the scale shows default frequency scaling.
[image: ]
The Setup → Display window (see page 197) contains the option I.S.O Frequency Grid, which shows vertical lines at the center frequency of the EQ-bands.
Otherwise the vertical lines mark the borders between the single EQ-bands.

[bookmark: __RefHeading__23533_987277056]Cursor Menu (FFT and MAT)
This menu is located right in the lower menu bar. 

[image: ](Simple menu layout)

[image: ](Complex menu layout)

· [image: ]Range open the range sub menu where you can select the displayed frequency range. See page 91 for details.
· [image: ] Cursor on Peak move the cursor to the current peak of amplitude response. The shortcut is Shift-P.
· [image: ] Lock on Peak perform the Cursor on Peak function every time a new trace is drawn. In order to reset this option click again on the button or perform an other cursor related operation (Cursor on Peak, mouse click on the trace to set the cursor, movement of the cursor using arrow keys on your keyboard). The function's shortcut is P.
Hint:
· You can use the shortcut C to hide/show the cursor.

[bookmark: __RefHeading___Toc29579_1237155952][bookmark: mt27][bookmark: Ref_Gain%252FOffset]Gain / Offset Setting
[image: ]This setting is located at right window. It is available in the MAT module and in the FFT module. Changing this value moves the selected trace up or down in the display window. You can use this setting to center the selected trace or to shift it in order to compare it to another trace. You can use the mouse to move the selected trace up or down, if the option Allow Gain-Setup using Mouse option is activated in the popup menu of the value display or in the Tools menu.
Hints:
· Use the shortcut Z or a double-click on the gain display to set the gain to zero.
· [image: ]Use Center Trace or the shortcut M to adjust the gain to center the live trace in the display area.
· The gain settings affects the amplitude read out. Therefore SATlive shows the current gain setting behind the amplitudes value, if the gain is differs from zero.
· The colors of the display are swapped to indicate an offset value different from zero.
· Use the shortcuts Page Up and Page Down to change the offset.
· [image: ]The area displays the label and the color of the selected trace.
To open the selection menu, click on the name or on the color. 
See page 286 for details about selected traces. Please note, that not all measurements will support selected traces.
· [image: ]The value-display area contains a popup menu where you can select some predefined offset settings and where you can enable the movement of the selected trace by moving the mouse vertically with the left mouse-button holded down using the Allow Gain – Setup using Mouse entry.
· When working with the Live – Add Trace or the Perfect – Addition Trace (see page 290) you can use the entries in the pop-up menu of the cursor-info area in the right-menu bar to determine whether the offset should affect the calculated trace(s) or not.

[bookmark: __RefHeading__21593_1402859807]Display range selection
[image: ]The Range selection is located in the lower menu bar.
Use it to select the visible frequency range for the display.
Beside the three ranges [image: ] Low, [image: ] Mid and [image: ] High you can select a fourth setting, which is called User.
You can change the border of the user setting either (like the borders of the three other settings) at Setup → Post Process or by assigning the currently used borders using the Assign current range option.
The [image: ] Full range function restores the full frequency range.
If a transfer measurement is performed in the MAT module then this menu contains the Linear Scaling (X-Axis) option, which activates a linear scaling of the frequency axis, opposite to the commonly used logarithmic scaling. The linear scaling might be helpful when you work with the phase trace.
	[image: ]
	[image: ]

	Logarithmic (default) frequency scale
	Linear frequency scale



You can also use the right mouse button to select the frequency range you want. Just move the cursor to one end of the desired range, click and hold down the right mouse button. Now you can select the frequency range by moving the mouse to the right or to the left. A dashed rectangle marks the current selection. The display changes to the new values as soon as you release the right mouse button.

[bookmark: __RefHeading___Toc41254_2823577171]Show Range at Cursor
[image: ]You'll find this setting in the popup menu of the trace display in the FFT and MAT module.
[image: ]This option shows two lines with the selected distance related to the amplitude value at the current cursor position.
[image: ]If you’ve enabled the Pink spectrum lines option in Setup → Display (see page 193) then the grid will contain lines showing the -3dB slope.
[image: ]The horizontal grid option shows a horizontal line at the cursor's intersection with the selected trace.
Hints:
· The cursor always shows the values of the currently selected trace.
· You can select the trace to analyze in the popup menu of the trace display using the Show Values of option.

[bookmark: __RefHeading__22806_189244930][image: ]The popup menu assigned to the trace display
Open this menu by clicking on the trace – display window with the right mouse button or by pressing the key J on your keyboard. The content of this menu varies dependent on the current status and the measurement selected.
· Show values of select the trace whose values are shown. See page 286 for details.
· Group-delay related to select the reference time used for the calculation of the group-delay. This option is available only in the impulse response's FFT module.
· [image: ] Invert live trace flip the live trace on the zero dB line. The shortcut is Shift + I.
· [image: ]Full trace display show the whole valid frequency range. The shortcut is F.
· [image: ]Information show information about the currently selected trace.
· [image: ] Show Range at Cursor draws horizontal guide lines related to the value at the cursor's current position.
· Delay = Cursor applies the delay value at the cursor's current position to the current delay. This option is enabled only in the impulse-response measurement. You can also use the shortcut F3 to invoke this function.
· [image: ] Marker open the Menu Marker. See page 307 for details.
· Tools invoke the Tools menu (see page 147).
· [image: ]Layout opens the layout-sub menu. See page 301 for details.
· [image: ]Open Delay Finder open the delay-finder window. Available in the MAT module only. See the delay-finder section on page 135 for details.
· [image: ]Low-Frequency Delay-Finder executes the Low-Frequency Delay calculation tool. See page 143 for details.
· [image: ]Addition of Signals open the menu for the addition of signals tool.
· [image: ]Show Virtual EQ show or hide the Virtual EQ’s trace. See page 258 for details.
· Target Amplitude shows/hides the Target Amplitude. See page 100 for details.

[bookmark: __RefHeading___Toc41256_2823577171]Smoothing
This selection is located on left side in the lower menu bar.
Select the amount of smoothing applied to the live trace.
The value of a point for the display is calculated as the mean value of the selected range.
If, for example a range of one octave is selected, then the mean value is calculated from the frequency of the current point minus half an octave to the frequency of the current point plus half an octave.
Using the unit octave is closer to human hearing as a fixed frequency range or a fixed amount of points.
The option Similar to Ear varies the width of the smoothing depending on the frequency. The higher the frequency, the smaller the window (in octaves).
Hint:
· Human hearing is very sensitive to peaks in frequency response so you should not apply too much smoothing.

[bookmark: __RefHeading___Toc41258_2823577171][bookmark: hs1221]Show Values of
· This selection is located at trace display's popup menu.
· Select the trace to read values from. You can select any trace which is visible.
· Just choose the trace you want from the sub-menu.
· The selected trace is indicated in front of the values.
· You can use the shortcut T to toggle the cursor readout.
[bookmark: __RefHeading__26695_1358155583][bookmark: hs1230][image: ]Value Editor Field 
This edit field is located right of the layout – parameter selection below the trace display in FFT and MAT module.
This field shows the current value of the selected layout parameter.
You can change this value by:
· The selection of a preset value from the field's popup menu.
· Clicking on the arrows on the right side of the field.
· A popup menu containing some preset values is available for all settings.
SATlive shows the name of the selected parameter left of the value edit field.
See the page 175 for a description of the parameters available.

[bookmark: __RefHeading__23083_850079172][bookmark: Ref_CursorRangeTool]Frequency Range Tool
[image: ]The frequency – range tool is available in the MAT module and in the FFT module.
This tool allows you to select a horizontal range and will display its properties. See page 98 for more information about the values shown. The menu (see page 99) allows the configuration of the value display and of the selection. You can use the range selected also in this functions:
· Bandpass – filtered – pink noise (see page 228).
· Delay – suggestion tool (see page 296).
· Low – frequency delay – finder (see page 142).
· Target – amp line (see page 101).
[bookmark: __RefHeading___Toc82131_1654956971]Operation
The frequency – range tool features three states. Use one of this option to proceed to the next state:
· Press the key D on your keyboard.
· [image: ]Hold down the left mouse button and click with the right mouse button.
· Click on the range – step icon at the left.
· Click on the top entry in the menu of the frequency – range tool (see page 99).
[bookmark: __RefHeading___Toc79564_1654956971]State 1: No range selected
[image: ]In this step there is no frequency range marked or available. Move the cursor to the desired position of the latched cursor. Please note that the function of the latched cursor depends on the currently selected mode. See page 99 for details.
Proceeding to state 2 will set the latched cursor to the current position of the cursor.


[bookmark: __RefHeading___Toc82129_1654956971]State 2: Mark the range
[image: ]In state 2 you can mark the range. This can be done by moving the cursor with the left mouse button down, by using the left and right arrow keys on your keyboard or by clicking on the desired position.
In state 2 you can, in addition to the options mentioned on page 96, use this options to proceed to step 3:
· Move the mouse outside the trace – display area.
· If you've activated the option Unlock Cursor on Button Release in the menu (see page 99) then the state will change to step 3 as soon as you release the left mouse button for the first time.
[bookmark: __RefHeading___Toc89863_1654956971]State 3: Range fixed
[image: ]In state three the range remains marked while moving the cursor will not change the range marked.
To clear the range just proceed as described on page 96. Doing so will reset to
state 1 (see page 96).
In any state the key – combination Shift – D will immediately reset to state 1.


[bookmark: __RefHeading__24363_1248855964]Information displayed
[image: ]The information of the cursor range tool is shown on the left of the information area above the trace display.
· Latched Cursor the position of the latched cursor. This is the position of the cursor at the moment when you proceed to state 2 of the frequency range tool. See page 96 for details.
· Center frequency of the range. The position is shown as a dashed line in the trace display. Depending on the settings in the menu (see page 99) this value might be the same as the selected cursor.
· Selected Range the third line shows both borders of the currently selected range. With the mode set to Latch Cursor is Border in the menu (see page 99), one border frequency is the same as the frequency of the latched cursor.
· The bottom line contains information related to the width of the selected range. Use the menu (see page 99) to select the value(s) you want to see:
· BW the range between both positions related to the center-frequency[footnoteRef:2]. [2: 	This is not the correct definition of the Bandwidth, but it's the Bandwidth definition used in many digital equipment.] 

· Q Quality, calculated by 1/BW.
· Octaves bandwidth in octaves.
If the option Show Values at Main Position is selected in the menu (see page 99), than the information related to the current cursor-position is shown here.
· An icon left to the bottom line indicates the selection – mode currently set in the menu (see page 99):
· Latched Cursor is Center Frequency:[image: ]

· [image: ]Latched Cursor is Border:

[bookmark: __RefHeading__24365_1248855964]The menu of the frequency – range tool.
T[image: ]o invoke this menu just click on the arrow symbol in the upper left corner of the info area above the trace display.
· The topmost entry will proceed to the next step of the frequency – range tool. See page 96 for details.
· Select range of interaction: Selects the frequency – range with a level – difference below the second threshold of the interaction – area tool (see page 295), starting at the current position of the cursor. This entry will show a popup menu where you can choose the second trace. The next menu entry will invoke this function using the trace listed here.
· The next two entries define the use of the latched cursor in the calculation of the frequency – range. The key W on your keyboard will toggle both modes.
· [image: ]Latched Cursor is Center Frequency: the latched cursor will mark the center – frequency. The second border will be calculated based on the position of the cursor.
· [image: ]Latched Cursor is Border: the latched cursor marks one border of the frequency – range. The center – frequency will be calculated based on the position of the cursor.
· Use selected range for bandpass will assign the current range to the signal bandpass pink noise. See page 228 for details about this signal.
· The next three entries allow you to set the display the bandwidth. See the information –  display section on page 98 for details.
· The Show values at main position option flips the display position of the data of the current cursor and the information to the selected range.
· The Unlock Cursor on Release of Button with this entry checked the state of the frequency – range (see page 96) will changes from state 2 to state 3 as soon as you release the left mouse – button.
· Use the next three entries to limit the frequency range displayed.
· You'll find a list of previously used ranges at the bottom of the menu.

[bookmark: __RefHeading__21595_1402859807]Target Amplitude
[image: ]You can show a target amplitude line in the transfer-function measurement. 
This line serves as a guide line for EQ and level adjustments. This line is also used as border for the shadow – fill.
If the target – amplitude shows, all level readings relate to the position of the target – amplitude.
[bookmark: __RefHeading___Toc41260_2823577171]Controlling the Target Amplitude
[image: ]To set the target – amp line, just move the mouse onto the info area on top of the trace display, hold down the left mouse button and move the mouse downwards until you reach the desired position.
To move the target – amp line grab the handle on the left and move it with the left mouse button pressed.


[image: ]Use the entry Target Amplitude in the popup menu assigned to the display area or the shortcut U to hide/show the target–amp line, and the menu Target Amplitude (see page 101) to control the target amp line.

[bookmark: __RefHeading__28661_204716178]The Menu Target Amplitude
[image: ]The menu is located in the upper menu area.
· [image: ]Target Amplitude 0 dB: Shows the target amplitude line and sets it on the 0 dB line. 
· Use Average as Target Amplitude: Shows the target amplitude line and calculates the average amplitude value of the whole trace and uses the result for the position of the target amplitude line.
· Use Average of Range for Target Amplitude: Shows the target amplitude line and calculates the average of the amplitude values inside the selected frequency range and uses the result for the position of the target amplitude line.
· Target Amplitude: Toggles the visibility of the target amplitude trace.

[bookmark: __RefHeading___Toc41262_2823577171][bookmark: hs1260]Full Range
This function is located in the trace display's popup menu and in the range popup menu in the lower menu bar.
This function sets the upper and lower frequency of the display so that the whole range of valid frequency data is visible.
The lowest frequency is given by the lowest valid frequency of the current trace and the highest frequency is given by the Nyquist's frequency (= half the samplingrate). The function's shortcut is F or Ctrl + F.
[bookmark: __RefHeading___Toc41264_2823577171][bookmark: hs1265]Lowest valid frequency
Due to the windowing of the impulse response only a part of the impulse response is used for the calculation of the FFT. Therefore it is not possible to show frequencies below a certain frequency.
On the lowest frequency one whole cycle can be completed. This means that the period of the lowest valid frequency is equal to the length of the window applied prior to the calculation of the FFT.
For example let the length of the time window be 20 milliseconds. The lowest frequency is defined by f = 1/period, which yields 1/0.02s, resulting in 50 [1/s = Hz].
[bookmark: __RefHeading___Toc41266_2823577171]Nyquist Criteria
The Nyquist's criteria postulates that an analog signal which is used as an input into an analog-digital converter, must not contain signals with a frequency higher then half of the sampling frequency (samplerate). Otherwise the digital signal is spoiled with artificial signals.
This is the reason why a steep low pass filter is applied prior to any analog digital conversation.
Therefore the signal feed into the FFT does not contain any information about frequencies above half the samplerate. This is why SATlive does not display any frequencies above that value.

[bookmark: __RefHeading___Toc41268_2823577171][bookmark: Ref_Weighting_Filter][image: ]Weighting Filters
You can apply a weighting filter to the mic-signal input In the MAT Module.
The selection of the weighting filter can be found in the lower menu bar.
The frequency response of the human ears is not linear and changes, especial at lower frequencies, related to the sound-pressure level. The frequency response will become more flat when the level is increased. At lower frequency the sensitivity of the human ear is reduced at the low and at the high frequency area.
To match this behavior of the human hearing there are some so called weighting filters. These filters include a low-pass filter, which is the same for all three filters described below, and a high-pass filter whose parameter vary.
· A Weighting dB(A): A weighing performs the strongest cut at lower frequencies. Intended to be used for lower levels, this has become the most commonly used weighting filter. This filter correlates with the 'frequency response' of hearing damage and therefore it is used in the German DIN 15905-5 to weight the energetic averaging of sound pressure levels.
· B Weighting dB(B) this weighting, whose low cut is in the middle between A and C weighting was intended to be used at medium sound – pressure levels. Nowadays this weighting is not used often, so it is not present in SATlive.
· C Weighting dB(C) this weighting is intended for high levels and applies only a small amount of low cut filtering to the signal. It is mainly used to weight short signals (Peaks).
Hint:
· You can set the weighting filter used for the level display independent from the filter used in the MAT Module. Select the filter to be used for the level display in the related setup window, described on page 217.

[bookmark: __RefHeading___Toc41270_2823577171][bookmark: hs1340]The FFT Module
[image: ]This module displays the FFT of the impulse response currently shown in the IR module.
It contains functions for post process of the trace.
In the normal operation you’ll invoke this module is invoked directly from the impulse – response module when you perform a FFT or a smooth FFT, but you can access it directly using the button FFT in the top menu-bar.
[bookmark: __RefHeading___Toc41272_2823577171]FFT
The FFT is an algorithm (= description of a calculation) used to transform a signal in the time domain, like an impulse response into a signal in the frequency domain.
The new signal contains the same information as the original signal, but in another kind of values. The values of the frequency domain are amplitude and phase related to the frequency. We call this kind of display Frequency response. 
In the frequency response it is easy to the system's (in this case, system refers to the whole measured way of signal) peaks and dips.

[bookmark: __RefHeading___Toc41274_2823577171][image: ]Display functions
In the complex menu – layout this functions are located at the upper menu bar.
· [image: ] Toggle Display mode this button and it's popup menu toggle the frequency scaling used in the display. For details see page 88.
· [image: ]Show Amplitude toggle the display of the amplitude response. If the amplitude display is not active, then the phase display is activated in order to prevent an empty screen.
· [image: ] Show Phase toggles the display of the phase response. If the phase display is not active, then the amplitude display is enabled in order to prevent an empty screen. In the button's popup menu you can select different display modes for the phase (-180° to 180° or 0° to 360°), different ranges of the group-delay display and furthermore the reference used for the group-delay.
You can shift the phase-trace with the key-combination Ctrl + Prior or Ctrl + Next.
· [image: ] Hide Amplitude and Phase hide both the amplitude and the phase trace of the live trace. The shortcut is ^ (left of the number 1 key).
· [image: ]Layout opens the trace-layout editor for the live trace. The layout-editor window allows you to customize the display of a trace. See page 301 for more details about the layout editor.

[bookmark: __RefHeading___Toc41276_2823577171][image: ]FFT File Functions
· [image: ][image: ]Save saves the current trace. Set the file name and edit, if the info window shows up, the trace's description.
The function's popup menu contains more options:
· [image: ] Save as ASCII export the trace's data into a text file.
· [image: ] Save as calibration data save the current trace for calibration purpose. See page 109 for details about calibration in the FFT module.
· Save as choose filename and folder to save the trace as SATlive file to.
· [image: ] Save Trace as Picture saves the display as a picture.
· [image: ]Load opens a stored trace. If you open a new trace, then the current trace will be lost. The function's popup menu contains a list of the most recently used files.
· [image: ]Print Prints the trace window.
Hints:
· You can define the quality used for the Save Trace as Picture function in Setup → Features. See page 207 for details.
· You can add a fixed offset to the amplitude for the ASCII output. You can configure this option at Setup → Features
[bookmark: __RefHeading___Toc41278_2823577171][bookmark: hs1360][image: ]Additional Functions
· [image: ] Use Mic – correction activates the mic correction. If no valid mic correction is currently loaded, the function calls the Load Mic Correction function. See page 107 for details. This item contains a sub-menu, also described on page 107.
· [image: ] Tracemanager open or close the tracemanager. This function can also be accessed using shortcut Ctrl + T. See page 235 for details.
·  [image: ] Stop/Again stops a macro measurement when it runs in a loop, or repeats the last macro. You can use the shortcut R to invoke this function.
· [image: ] Assign snapshot to macro copy the current settings into a user macro.
· [image: ] Info opens the information window for the current trace. The trace's description can be edited in information window as well. The shortcut for the information window is shift + I (Uppercase 'i').

[bookmark: __RefHeading___Toc30732_1392751795][bookmark: Ref_Miccorrection]Mic correction
[image: ]In addition to the Calibration and the Complex Compensation, which are available in the Impulse-Response Module and the FFT Module only, SATlive features the possibility to correct the frequency response of the measurement microphone.
This feature is called Mic Correction and can be applied to the measurement (MIC) Signal both in the FFT and in the MAT module.
You can use any Smooth FFT trace, as long as its samplerate matches the current trace. You can create your own Mic correction file using the SATlive's mic-correction editor (available for download at: https://www.satlive.audio/download/miccaledit.zip).
[image: ]Furthermore SATlive will accept data in a text file[footnoteRef:3].
If you select a text file in the open-mic-correction window, you find details about the calibration in the info area at the lower left. [3: 	The import-filter has been tested using files from different manufacturers, but it might fail due to other file specification. If you'll face a problem related to a text based mic-correction file, please contact us.] 

[bookmark: __RefHeading___Toc41280_2823577171]The sub-menu of the mic-correction entry
[image: ]This sub-menu is assigned to the mic – correction function.
· [image: ]The top item shows the name of the current mic-correction data. Click on this entry to toggle the use of the mic-correction.
· [image: ]Load mic correction: Opens the file-load window, where you can select the mic-correction data you want to use.
· [image: ]Show frequency response of the correction: Shows the inverted mic-correction data, which is the frequency-response of the measurement mic.
· The names of the most recently used mic-correction data are listed on the bottom of this menu. To select on of these entries, just click on the entry you want to load.
· Clear File List removes all entries from the file list.

[bookmark: __RefHeading___Toc41282_2823577171]Group-delay related to
[image: ]You can find this menu in the trace display's popup menu and in the [image: ]phase-display type popup menu.
The group-delay is a value calculated by the derivation of the phase over the frequency. It can be interpreted as a frequency dependent delay, related to the begin of the current time window. Because the begin of the time window is known by SATlive, it can provide group-delay values related to different reference times.
· Time Zero the group-delay 0 is at time zero of the impulse response.
· Window the group-delay 0 is at the beginning of the current time window (no correction performed).
· [bookmark: hs1370]Peak The group-delay 0 is at the impulse response's peak.
· [image: ] Calibration activates the use of the current calibration file. 
If no valid calibration file is assigned, it executes the Load CAL function. The function's shortcut is C. The popup menu contains the [image: ] load calibration data and the [image: ] save as calibration data functions. See page 109 for details about calibration in the FFT module.

[bookmark: __RefHeading__22405_1358155583][bookmark: Ref_Calibration]Calibration
You can create a calibration file in the FFT module. This file can server as the reference for the measured trace. By doing so, the non linearity of the measurement setup is compensated and all dB values will relate to the calibration file.
[bookmark: __RefHeading___Toc41284_2823577171]Create a calibration file
[image: ]To create a calibration file, just connect the output direct to the input. Start a measurement, and save the result (in FFT module) using Save as calibration data. In the complex menu layout this option is located in the popup menu of the Cal button, in the simple mode it can be found at Tools → Calibration as well. In both layouts this function is also present in the Save button's popup menu.
If measurement was executed using a macro (which is recommended), you'll see a window likes this after saving calibration file.
If you click Yes then calibration file is automatically assigned to the macro.
You can edit this assignment in Setup → User Macros (see page 191).
[bookmark: __RefHeading___Toc41286_2823577171]Use of the calibration file
If you’ve assigned the calibration file to a macro, then the calibration will be applied every time you run the macro.
To load a calibration file use the function [image: ] Load Cal from the Cal button's popup menu. If a calibration file is loaded, you can toggle its use using the Cal button or the shortcut C.
Hints:
· If a calibration file is applied, then its name is displayed on left side of trace window.
· To calibrate the display of the impulse response in the impulse — response module use the Complex Compensation feature. See page 66 for details.
· A calibration file can only be used for measurements performed with the same settings (FFT size and type,  sample – rate).
· To check the calibration file just repeat the measurement. If your systems works fine and the calibration is correct, you’ll see a flat line at zero dB.

[bookmark: __RefHeading___Toc41288_2823577171]Calibration menu
[image: ]In the FFT module this menu will open up when you perform a right mouse click on the button CAL [image: ] which locates in the upper menu – bar n the complex menu-mode and in the menu Tools in the simple menu mode.
· [image: ]Load Calibration Data opens a calibration file.
· Save as Calibration Data stores the current trace as a calibration file.
· List of files the list of the most recently used files. To load a file from the list, just click on the file's name.
Hints:
· You’ll need different calibration files for FFT and Smooth FFT.
· If you want to compensate the display of the impulse response then use the complex compensation feature in the IR Module. See page 66 for details.
· To compare different results, you can use any file as calibration file, as long as the settings used to create it are the same as for the current trace. To activate or deactivate a calibration file, just click with the left mouse-button on the button CAL [image: ] or toggle the state using the key C on your keyboard.
· If a calibration file is activated, then the label "Cal:" and the name of the cal-file is displayed at the left side of the trace display. You can change the way the file name is displayed at Setup → Features → Fileinfo.

[bookmark: __RefHeading___Toc41290_2823577171][bookmark: hs1380][image: ]FFT Menu bar (simple menu layout)
In the simple menu layout there are only a few buttons in the FFT module's menu bar.
You can access the other functions via the menu Tools.
· [image: ]Save saves the live trace. Set the file name and edit, if the info window shows up, the trace's description. The button's popup menu contains also the functions Save Traces as Picture (Save the display directly as picture) and the Save as ASCII (Saves the live trace's data into a text file). The function [image: ] Save as Calibration Data, allowing you to save the live trace as a calibration file, is also in this menu.
· [image: ] Show Phase toggle the display of the phase response trace. If the phase response is not shown, the amplitude display is enabled to prevent an empty screen. In the button's popup menu you can select different display-modes for the phase (-180° to 180° or 0° to 360°), different ranges of the group-delay display and furthermore the selection of the reference for the group-delay.
· [image: ]Stop/Again stop the execution of a macro measurement when it runs in a loop or repeat the last macro. You can use the shortcut R to invoke this function, too.
· Tools contains a lot more functions and settings. For details see page 112.

[bookmark: __RefHeading___Toc41292_2823577171][bookmark: hs1385][bookmark: Ref_FFTTools]FFT menu Tools
[image: ]There is a lot of functions and settings in the menu tools. In the simple menu layout the menu tools can be accessed directly using the Tools button in the menu bar. In both menu layouts the menu Tools can also be accessed via the trace display's popup menu.
· [image: ] Tracemanager open or close the tracemanager. This function can also be accessed using the shortcut Ctrl + T. See the tracemanger section at page 235 for details.
· [image: ] FQ Scale Style set the style of the frequency scale. See page 88 for details.
· [image: ] Hide current Trace hide both the amplitude and the phase display.
· [image: ] Calibration activate the current calibration file. If no valid calibration file is loaded then the Load CAL function is executed. The function's shortcut is C. More functions can be found in the function's sub menu. See page 109 for details.
· [image: ] Mic Correction activate the use of the mic correction. If no valid mic-correction data is loaded then the function Load Miccorrection will execute. The shortcut for the mic correction is the key M. See page 107 for details about the mic – correction and about the menu assigned to this entry. This entry is available only if the current trace was created using a smooth FFT.
· [image: ] Phase compensation select the phase-compensation mode. Visible only if the trace was created using smooth FFT. For details see page 115.
· [image: ]Information show the information window for current trace. The trace's description can be edited in the information window as well.
· [image: ] Load Trace opens a file. In the function's sub menu you find a list of the most recent used files, from which you can pick a file with a double click.
· [image: ] Print prints the current trace display. The shortcut is Ctrl + P.
· [image: ]Edit Target Trace opens the editor for the target-trace. See page 254 for details.
· [image: ]Trace Layout invokes the editor for the configuration of the trace display. See page 301 for further information.

[bookmark: __RefHeading___Toc41294_2823577171]Trace Layout FFT Module, simple menu layout
[image: ]In the FFT module you find this settings below the trace display window in simple menu layout.
Select the layout parameter you want to change:
· [image: ] Low dB moves the trace display's lower border. The visible area will range from Low dB to Low dB + Range Y.
· [image: ] Range Y set the trace display's vertical range.
· [image: ]Line Gap set the distance between two vertical grids.
· [image: ]Trace Layout invokes the editor for the layout of the live trace. See page 301 for details.
Hints:
· To select a parameter simply click on the parameter field left of the value editor field. This will show a popup menu, where you can choose the parameter to edit.
· After a parameter is selected the value editor field shows the parameter's current value. The current parameter's name is displayed left of the value editor field.
· The parameter's value can be changed using the value editor field.
· The value editor field contains a popup menu with some presets for the currently selected parameter.
· You can change appearance of the traces displayed using the trace-layout window. See Page 301 for details.

[bookmark: __RefHeading___Toc41296_2823577171][bookmark: hs2366]Trace Layout FFT module, complex menu layout
[image: ]In the FFT module you'll find this settings below the trace display window, when the complex menu layout is selected.
Select a parameter of the trace display's layout, either by clicking on a field or by selecting it from the current parameter display's popup menu.
· [image: ] Low dB move the trace display's lower border. The visible area ranges from Low dB to Low dB + Range Y.
· [image: ] Range Y set the trace display's vertical range.
· [image: ] Lines Gap set distance between two vertical grids.
· [image: ] Range Y set the trace display's vertical range.

Hints:
· After the selection of a parameter, the value editor field shows the parameter's current value. The current parameter's name is displayed left of the value editor field.
· The parameter's value can be changed using the value editor field.
· Every parameter's field features a popup menu with some preset values.
· You can change appearance of the traces displayed using the trace-layout window. See Page 301 for details.

[bookmark: __RefHeading___Toc41298_2823577171][bookmark: hs4040][bookmark: Ref_Phase_compensation]Phase compensation
The Phase Compensation, available in the FFT module, removes the phase-shift introduced by the delay.
After running the speaker in room macro in the impulse- response module with just a link between the input and the output you hopefully get a near flat amplitude response graph. But when you activate the phase display, you might be surprised, because you will not a flat phase graph, but a falling one.
[image: ]To explain what happens here, we first take a look at the left side of the impulse response's display in the upper window.
You might notice some space between the left border of the window and the impulse's peak, even if the peak is at 0.0ms.
This space is generated by the window selected in the macro setup. For the speaker in room macro a peak related window with a pre setting of 400usec is used. This means that the part of the impulse response which is used for the calculation of the FFT starts 0.4 ms before the highest point of the impulse response.
This pre time is used to 'catch' the settling time of the loudspeaker, because the highest point of an impulse response is not necessarily the first valid point of it.
[image: ]To go back to our example, we can say that the peak has a delay of approx 0.4 ms related to the starting time of the FFT window (which is the left border's position).
This picture shows a comparison of two FFT traces created from the same impulse response, one using the default 0.4ms pre time (green phase trace), the other with a pre time shortened to approx 0.2 ms (violet phase trace).
As expected the amplitude traces match perfectly, but the phase traces are different, because delay information is present in the slope of the phase traces. The higher the delay as steeper the phase trace. The negative value of the slope is called group – delay and can be displayed in SATlive as well.

[image: ]The group-delay traces of both measurements are flat, which indicates that the delay is constant over time, and as you might guess, the green trace shows a groupdelay of approx 0.4ms and the violet one a groupdelay of approx 0.2 ms.
SATlive can try to remove this delay from the phase display when you look at the smooth FFT result. Because of the cyclic nature of phase this might not work perfectly in some situations.
There are two phase-compensation modes available, which you can use in macros, too.
[image: ]They differ in the detection of the delay. 
· In the mode [image: ] (left button) the location of impulse response's peak is used as the time reference.
· In the mode [image: ] (middle button, marked with 1k) SATlive assumes that the phase value at 1kHz in the FFT is at zero degree phase.
· The third option[image: ]disables the phase compensation feature.

[bookmark: __RefHeading___Toc27574_97599361][bookmark: hs1600]The MAT module
[image: ]MAT is the powerful Dual Channel FFT measurement part of the SATlive audio – measurement software.
[bookmark: __RefHeading__23772_1819804763]The measurements in the MAT module
[bookmark: __RefHeading___Toc27284_1641174950]RTA Measurement
[image: ]An RTA (Real Time Analyzer) displays the input's energy content, averaged in frequency bands. A RTA shows a flat response on a flat system when feed the system with pink noise.
In SATlive you'll find the RTA measurement MAT module.
SATlive uses the resolution of a 30 band RTA, which has a frequency bandwidth of one third of an octave.
You can select the input(s) to display using the labels below the VU meter.
Use the cursor to read out values.
The RTA stores and shows the maximum values of each band (the so called ‘peaks’). 
Use the button Reset in the right menu area (see page 155) or the key R to reset both, the peaks and the current display.
See the page 155 for the parameters for the RTA display.
The RTA supports the Auto-Freeze feature, which is described on page 119.

[bookmark: __RefHeading___Toc41300_2823577171][image: ]Display
You can select the input(s) to display using the buttons below the VU – meter at the right side.
[image: ]If you’ve selected both inputs, then the display will split into two areas, where the upper one shows the RTA of the measurement / microphone signal and the lower one shows the reference (ref) signal (see the picture on page 117).
To show both inputs side by side select the RTA Classic Style entry in the layout menu (see page 159 for further information).
By default SATlive uses green color to draw the bottom part of each RTA bar.
[image: ]If you’ve activated the option RTA Classic Color in the layout menu (see page 159), then the lower part will show in the color assigned to the input shown. The buttons below the vu – meter show this colors also.




[bookmark: __RefHeading__22535_2001208651]Peak display (RTA)
[image: ]The center frequency of the selected RTA band is shown on the left of the display area on top of the trace display. If the Lock Cursor On Peak option (see page 119) is enabled, this value indicates the frequency band with the highest energy.
If you use the Auto Freeze functionality (see page 119) then symbol on the upper left indicates the current state of the peak – display.

[bookmark: __RefHeading__23313_2001208651]Freeze Control
[image: ]The freeze control menu is assigned to the area right to the display, and it's available for the RTA and FFT measurement.
[bookmark: __RefHeading__24328_1250033209]Auto Freeze
If you enable Auto Freeze, then the display will freeze if the level of the peak rises over a threshold value. 
The threshold value is indicated by a red line in the display and it can be moved using the handle visible in the area right to the display.
[bookmark: __RefHeading___Toc41302_2823577171]Display follows peak
Enable this entry if the locked peak – display (see page 118) should always indicate the frequency of the peak. Otherwise the peak – display will show the frequency of the current position of the cursor. This entry works only if the Freeze Peak Display option is enabled. 
[bookmark: __RefHeading___Toc41304_2823577171]Freeze Peak Display
[image: ]Use this option to avoid that the peak – display changes when the display is not frozen. 
This will lock the peak display (see page 118) to the frequency of the last peak that triggers the auto freeze, until the next time a new peak exceeds the threshold value. That enables you to read the frequency of the last feedback, even when it's gone.
A locked display is indicated by closed – lock symbol shown left to
the peak – display. 
[bookmark: __RefHeading___Toc41306_2823577171]Auto Re-Start
[image: ]Reactivates the display if the input level falls down below the restart threshold. 
The restart threshold, which is indicated by a green line in the display, is related to the freeze threshold – setting. 
The hysteresis value determines the gap between both values.

[bookmark: __RefHeading___Toc41308_2823577171][bookmark: hs4010]FFT measurement
[image: ]The MAT module's FFT the display shows the spectral contents of the selected input signal(s). On a flat system it shows a horizontal line if the system is feed with white noise.
· Select the input(s) to display using the labels below the VU meter. See page 176.
· If pink noise is used as signal, then the result falls with a slope of -3dB per octave. To check the linearity you can use the Pink Spectrum Lines feature in the Setup → Display window.
· You can also use the Compensate FFT feature in Setup →  Measurement to remove the influence of the pink filter. You can find more details on page 121.
· A selected delay is applied to the REF input. See page 144 for details about how to set the delay.
· Use the cursor to read out values.
· The measurement is performed as a Smooth FFT (see page 242)
· The FFT measurement is intended to show the energy content of signals.
· The values shown are absolute levels only if you performed and activated the level calibration.
· You can set the amount of averages in the trace – layout menu in the bottom area. See the page 314 for details.
· The amplitude threshold set for the transfer function is indicated using a different background color. See page 162 for information about the amplitude-threshold.
· The FFT measurement supports the Auto-Freeze feature, which is described on page 119.

[bookmark: __RefHeading__26602_7977939][bookmark: hs4015]Compensate FFT (MAT)
You can select a compensation for the FFT measurement in the MAT module at  Setup → Measurement. See page 200 for more details about the setup.
The selection is used for the display in the FFT measurement and in the FFT + Spectrograph measurement, but has no effect to the calculation and the display of the transfer function.
You can select one of the three compensation patterns available:
· Flat on white noise this is the default display of a FFT measurement. You'll get a flat line, if you feed the FFT measurement with white noise.
· Flat on pink noise filter the result of the FFT measurement using a +3dB/octave filter. This compensates the influence of the filter used to create the pink noise. With this setting you'll get a flat line, if you feed the FFT measurement with pink noise. With this setting the FFT measurement acts like a RTA measurement with small frequency bands.
· Sawtooth with pink noise with this setting you can see the nine different bands used for the calculation of the result. This setting is mainly intended for compatibility to other software.

[bookmark: __RefHeading___Toc41310_2823577171][bookmark: Ref_THD][bookmark: Ref_THD]THD (Total Harmonic Distortion)
[bookmark: __RefHeading___Toc41312_2823577171]Basics
[image: ]Beside the wanted amplification any active device changes the shape of the signal a little bit. When we send a sine wave signal through an electronic (or an electroacoustic) device we can easily detect the changes by looking at the frequency response of the device's output.
There we can see peaks on integer multiples of the basic frequency. If we add the levels of this so called harmonics and relate this sum to the basic frequency's level, we get the THD.
In the early days of electronics THD was the main criteria for the quality of amplifiers and a low THD was the goal of mostly all developments in audio electronics.
When the industry managed to gain real low THD values, the people realized that, even with very low THD values, amplifier may not sound good. Today we know that THD is not always bad, and that a speaker will produce a lot more THD than the electronic driving it.
Another interesting fact is that tube amps have a real high THD compared to solid state amps, and that we sometimes use an exciter to create additional harmonics, which means we're rising the THD value.

[bookmark: __RefHeading___Toc41314_2823577171]THD measurement in SATlive
The THD measurement is performed in the MAT module as an option for the FFT measurement. You can start it in the menu Tools.
SATlive assumes that the frequency set for the Sin Var signal of the signal-generator is the basic frequency. See page 223 for more details about the signal-generator.
Therefore you have to set the frequency value to the sine wave signal's frequency even if you're using an external sine wave generator. The THD value is displayed on top of the trace display for both inputs separately. Normally THD measurements use a basic – frequency of 1 kHz.
[bookmark: __RefHeading___Toc41316_2823577171]Settings
You can set the order of the highest harmonic which is to be examined in the Setup → post process window (See page 208).
You can also select the input(s) to be examined using the buttons below the VU – meter in the right menu-bar. See page 176 for more information about the input selection.

[bookmark: __RefHeading__20555_189244930][bookmark: hs4060][bookmark: Ref_Transferfunction]Transfer function measurement
You'll find the transfer function measurement in the MAT module.
The transfer function means how the system, which covers all influences between input and output of the measurement, transfers a signal from the input to the output.
This covers the influence in the frequency response, how good each frequency is transferred, and the signal's timing, for example delays.
In live PA situations the system to measure consists of an addition of different transfer functions. Any part in the signal chain has it's own transfer function, but the most problematic part is the speaker to listener transfer function.
[image: ]The transfer function is calculated by comparing the measured output-signal of the system with the input signal feed into it.
During a measurement of a PA system, the signal is feed into the console and measured by a measurement microphone located in the room.
Both signals are transformed into their frequency responses, and then transfer function is calculated by a simple division of the frequency spectra.

[bookmark: __RefHeading__26541_1358155583]Amplitude Threshold
In order to minimize the external interference to the measurement, there are some options to improve the quality of the result.
Because the division makes only sense on frequencies where the source signal contains enough energy, an amplitude threshold value,  acts as a threshold for the execution of the calculation. See the page 162 for details about how to set the amplitude-threshold value. 
If the amplitude value of the reference signal is below the threshold, there is no update of the display.
[bookmark: __RefHeading___Toc41318_2823577171]Coherence Threshold
[image: ]To minimize the influence of external signals, you can use a coherence threshold. The coherence is a value that indicates how good the measured signal relates to the input signal.
If you select the dynamic coherence threshold, then the coherence threshold depends on the count of valid measurements taken for a certain frequency value, otherwise the fixed value is used.
If the coherence value of a certain frequency is above the threshold, then the value is shown as trace. This is done for every single frequency, so the value might be shown as part of the trace or as dot.
The Show Last – Good Trace functionality (see page 126) fills the gaps caused by low coherence with prior stored valid values.

Hints:
· The current values for both thresholds are shown in the right menu area.
· A click on the threshold display opens the setup menu for the selected threshold.
· You can set the colors used for the dots and the correlation in the Setup → Display window. See page 194 for details.

[bookmark: __RefHeading__28773_669576538]Last – Good Trace
The visibility of a point in the display of the transfer – function is determined by the amplitude – threshold and the coherence – threshold (See page 125 for details).
Therefore there might be some areas in the spectrum which contain valid data at some times, but there are also times where the coherence drops below the threshold of the coherence – limit setting.
[image: ]The Last – Good Trace records the current output as long as it is valid, so that it contains the last valid value of each frequency. If the coherence drops below the threshold, the value of the Last – Good Trace is displayed in a transparent color, so that you can distinguish which values are created by the current measurement (solid line) and which values are recalled from the Last – Good Trace.
[image: ]You can disable this feature using the entry Show Last – Good Values in the layout – menu. You'll find this menu either as the popup menu of the layout area on the bottom, or as a submenu in the popup menu assigned to the trace – display area.

[bookmark: __RefHeading___Toc41320_2823577171][bookmark: hs4063]FFT + Spectrograph
[image: ]In the FFT + Spectrograph measurement in the MAT module the measurement (MIC) signal is displayed in two ways at the same time.
The upper window shows the FFT of the measurement (MIC) signal and the lower window shows the spectral distribution of the energy over time. In the lower window the level at each frequency is displayed using different colors. The scale used is shown right of the display.
The vertical axis is the frequency and the horizontal axis is the time.
The settings for the [image: ] Y-Range and for the [image: ] Top level are the same in both displays, the  Averages setting and the Range setting is used only for the FFT display in the upper window.

Hints:
· You can select the display range in time of the spectrograph display in the menu Tools.
· The cursor movement is synchronized in both windows. In the upper window the cursor is a vertical line, in the lower window a horizontal line.

[bookmark: __RefHeading___Toc44474_209593912][bookmark: hs4066]Impedance measurement
[image: ]You can use the impedance measurement in the MAT module for speaker development or to check speakers. The impedance is the frequency dependent resistance.
To measure the impedance you need an external reference resistor capable of enough power. You must set the value of the resistor used at Setup → Measurement.
Use the tracemanager (see page 235) to display amplitude traces in the background. Use the layout menu (see page 129) to configure the display.
Impedance measurement will need a wiring different to all other measurements.
[image: ]Wrong usage or wiring could destroy your audio interface, your computer and/or your power amp.
Read and obey the following hints:
· For the sake of safety you must use the two resistors (10k/0.5W) marked red.
· Start measurement with no ground connection on the power side. Use this connection only if necessary.
· Use only power amps with the negative speaker output connected to ground.
· Never use power amps in bridge mode!
· Make sure you're using the right connections before you switch the poweramp on.
· There is no liability for any damage!
· The reference resistor's value should be about twice the value of the nominal impedance of the speaker. A 15 ohms resistor is a good choice for common 8Ω or 4Ω speakers.

[bookmark: __RefHeading___Toc58415_2823577171]The Layout Menu
During the measurement of the impedance (see page 128) you can access this menu either using the entry Layout in the pop – up menu of the trace display (see page 93) or in the layout area below the display area (see page 175).
[image: ]The upper entries contain the settings common to all kind of measurement. See page 175 for details about that settings.
The four entries at the bottom are specific to the impedance measurement.
· [image: ]Join Display will show both the phase and the amplitude in one window. You can also toggle this behavior by a double – click onto the display area.
If both traces will show in the same window then the phase – scale will show right of the display area, as long the Show dB Scale option is not selected.
· [image: ]dB Value Top select the upper range limit for the display of the amplitude – response of the traces of the tracemanager (see page 235).
· [image: ]dB Value Bottom select the upper range limit for the display of the amplitude – response of the traces of the tracemanager (see page 235). The display – range for the amplitude traces will be the difference between the values for the top and the button.
· [image: ]Show dB Scale will show the scale for the amplitude – response display right to the display. Furthermore a 0 dB line will show in the display.

[bookmark: __RefHeading__23612_997180846][bookmark: hs4068]Impulse response measurement (MAT)
[image: ]The measurement of the impulse response in the MAT module is done using the Dual – FFT algorithm.
The upper window shows the whole range selected in the right menu bar or at the menu Tools, the lower window shows a zoomed part, scaled by the zoom factor selected. The zoom factor is shown in the upper right corner and you can change the zoom in the Tools menu (see page 149) or by using the popup menu located at the upper right of the display.
Refer to page 132 for details about the delay – zoom view.
The reference (REF) signal is delayed prior to the calculation of the impulse response. Therefore the time scale does not show absolute time values, but the offset from the current delay.
You can use the Show True – Zero Marker entry in the menu Marker (see page 307 for details) to indicate the real zero time value in the display.
The cursor – readout in the info area above the display shows the values related to the current delay. If you press the left key while the mouse is over the readout then the display shows the absolute value until you release the button.

[bookmark: __RefHeading___Toc41322_2823577171]Using the Impulse Response
· Use the button D = C or the shortcut F3 to assign the cursor's current position to the current delay, so making the current cursor's position the new time zero of the display.
· Use the key P to set the cursor to the peak of the impulse – response.
· Use the key – combination Ctrl + D to assign the position of the peak to the current delay. This will make the peak the new reference – time value.
· You can use the Quick – traces described starting on page 270 to store copies of the impulse response currently shown or to compare different impulse – response traces.
· Use the shortcut F5 to make a copy of the current impulse response trace. The shortcut F6 will toggle the visibility of that trace.
· During this measurement you can apply markers (see the page 306) and use the delay matrix, which is explained in this document starting at page 46.
· To change the display and the measurement use either the menu Tools (see page 149) or the right – menu area described on page 158.
· To magnify one of the display areas, just double-click on the area you want to zoom.
· To switch back to the display of both traces, just double-click again on the display.
· You change the vertical split either move the separating area while holding the left mouse – button down or select a predefined value from the popup menu of the splitting area.
· You can apply a high-cut and a low-cut filter prior to the calculation of the impulse – response. This can be done either in the menu Tools (see page 149) or in the right – menu area, described on page 158.


[bookmark: __RefHeading___Toc61207_1212603287]Using the Delay Zoom Window
The delay zoom window is the lower window in the IR – measurement of the MAT module.
By default the delay zoom window centers at the time zero of the impulse – response display, which equals the currently set delay for the measurement.
· [image: ]Using the entry Center at the cursor’s position from the popup menu of the trace – display area or the hotkey Shift – C on your keyboard, the delay zoom window will center at the current position of the cursor.
· Use the entry Center at time zero in the same menu to center the delay zoom window again at the time zero.
· The third entry, Set cursor on zoom – peak, enables you to select the peak in the display range of the delay – zoom window. You can also use the hotkey Shift + P.
· Use the hotkey Shift + A to set the Y-Range according to the data in the delay zoom window.
[bookmark: __RefHeading___Toc41324_2823577171]Information related to the peak
Both, the position of the overall peak and the position of the peak in the currently selected range of the delay – zoom window, will show at the upper right of the information area above the trace display.
Furthermore this information is also available in the delay – matrix (see page 46).
· [image: ]The upper line shows the position of the peak in the delay – zoom window
· The middle line shows the distance between both peaks, and their difference in level.
· The lower line shows the difference in time between the current location of the cursor and the position of the overall peak.

[bookmark: __RefHeading___Toc41326_2823577171]Using Delay in the MAT module
Because the Dual – FFT measurement compares two signals it is important to compensate the delay between both signals properly. 
In most cases the reference signal connects via a direct path while the measurement signal travels a long way via controller, amp, speaker and through the air. Therefore the measurement signal will arrive later related to the reference signal.
In order to get the comparison of both signals to work properly, we need to add a delay to the reference signal.
The delay will affect the readings of the phase – trace. Therefore you must not alter the delay after the initial setting of the delay when you're comparing the phase values of different traces.
Normally you determine the delay based on the location of the peak in the impulse – response. SATlive offers different possibilities to measure the delay. See page 134 for further information on that subject.
[bookmark: __RefHeading___Toc41328_2823577171]The interval of the delay detection
The range of detectable delay values varies depended of the method used for its detection.
· The impulse – response shows the delay symmetrical to the current delay value. Using the impulse – response with a high value selected for the measurement size (see page 87) will deliver the most reliable results, especial for long delays.
· The delayfinder (see page 135) covers an interval from minus 20 milliseconds up to one second related to the absolute time values.
· The detection interval of the auto – delay functionality (see page 136) and of the delay – state display (see page 142) varies according to the setting auto – delay mode in setup → measurement (see page 200).
· Auto delay fast: -10 ms to +40 ms.
· Auto delay default: - 10 ms to + 199 ms
· Auto delay slow: - 10 ms to + 400 ms


[bookmark: __RefHeading___Toc39549_150880275]Setting the delay
You can determine the value of the delay in different ways:
· Use the delayfinder. See page 135 for description of the delayfinder.
· For the manual tuning of the delay use the arrows left and right to the delay – display. The arrows on the left will add or subtract one millisecond of delay, the arrows on the right will add or subtract one sample of delay.
· You can recall the delay from a time – marker (see page 306). You can assign a time value to a time marker in the IR – module, during a measurement of the impulse – response in the MAT module and using the delay – finder.
· During the measurement of the transfer – function you can copy the delay used during the measurement of a quick – trace using the entry Copy Delay from Trace in the menu delay (see page 166).
· Use the entry Direct [image: ] in the delay – menu (see page 168) to reset the current delay to zero.
· [image: ]Perform an impulse – response measurement in MAT module, set the cursor on peak, and use the Cursor → Delay  function at trace window's popup menu or in the delay menu in the lower menu area.
· In the measurement of the transfer – function, you can also use the Auto – Delay functionality described on page 144.
· [image: ]In the transfer – function measurement the delay – state display (see page 142) on the upper right will indicate the polarity and the relative position of the peak.. Click onto the delay – state display to apply the current delay value.
The current delay applies to the reference channel in all measurements in the MAT module, even in RTA and FFT.
If you changed the current delay, then you can save it to a delay preset using [image: ]Save Delay in the lower menu area.
The Low-frequency Delay-finder will calculate the delay based on the phase – response of the trace. See page 143 for further information.

[bookmark: __RefHeading__22960_516930338][bookmark: hs21][bookmark: hs16]Delayfinder (MAT)
[image: ]Use the delay finder to measure the time delay between both input channels.
The delay finder, which is available in the MAT-module only, calculates the impulse – response using both inputs and suggests the point with the largest absolute amplitude value as the delay-value.
This will work for most situations, but there are some things you should know:
· In the impulse – response the largest amplitude is caused by high frequencies, so the delay – finder will adjust to the delay of your high – frequency device.
· Lower frequencies do not rise or fall as sharp as high frequencies, so the delay finder performs best when a high frequency content is available.
· Therefore you should start time adjustment between different frequency ranges with measuring the delay of the device reproducing the highest frequency range.
· The delay-finder might not work for sub-woofers. In this case you might try the low-frequency delay-finder for more accurate results (see page 142).
· The delay – finder is optimized to measure positive delay values, so it might fail when you’ve flipped the inputs.

[bookmark: __RefHeading___Toc46828_150880275]How to invoke the Delay Finder
There are different ways to invoke the delay finder
· Use the key F7 on your keyboard.
· Double – click on the display of the current delay value.
· Use the Open Delay Finder entry in the popup menu of the trace-display area.
· Use the Open Delay Finder entry in the popup menu of the delay display.
See page 166 for details.
[bookmark: __RefHeading___Toc41330_2823577171]How to operate the Delay Finder
[bookmark: __RefHeading___Toc30057_1645873506]Display the result
After the measurement is performed, the area around the largest absolute amplitude value is shown in the center of the window, allowing for a visual check of the result.
[image: ]In the left area the result will show as values.
· The upper area shows the delay value in milliseconds.
· The middle area shows the distance based on the delay value. Edit both the temperature value and the units used for the calculation at Setup → Features (see page 204).
· The lower area will show POS if the largest amplitude value is positive, and it will show NEG and a red indicator if it is a negative one.
Use the three buttons in the lower right of the window to operate the delay – finder.
[bookmark: __RefHeading___Toc41332_2823577171]Basic operation
· Use Get It to start a measurement. If not saved to one of the delay presets, the previous measured delay will be lost as soon as you’ll start the measurement.
· Use the button Cancel or the entry Cancel in the menu Delay Finder to close this window leaving the delay of the MAT module unchanged.
· Use the button Apply to assign the delay to the MAT module.
You can also use the F3 key or the Apply entry in the menu Delay Finder.
Depending on the setting Keep Alive in the menu Delay Finder (see page 138), hitting Apply will close the window also.

[bookmark: __RefHeading___Toc41334_2823577171]Advanced functionality
There are some more possibilities in the delay finder:
· If you want an other position to be used as delay, you can move the cursor in the display using either the left or right key on your keyboard or using the mouse (click to set, hold left button down and move) or the both arrow buttons below the display to move the cursor.
· Use the selection Displayed Range above the display to change the interval of the impulse – response you want to see in the window.
· Use either the button Cursor on Peak or double-click onto the display area to reset the cursor to the peak at the center of the display.
· Use the buttons on the top – right area to assign the delay to one of the time markers. See page 306 for details. During the assignment, you can edit the label of the time – marker.
Please note, that the delay is assigned to the time – marker only if you click OK in the name-edit window. You do not need to edit the name, just click OK.
· The area at the lower left of the window contains functions to manage the delay for the direct – reference feature. See page 330 for details about direct – reference and page 152 for details about this area.
[bookmark: __RefHeading___Toc41336_2823577171]Hints
· You can use the option Delayfinder before Transfer Measurement located in the Setup → Measurement section (see page 200) to open the delay finder every time you enter the transfer – function measurement.
· Use the Low – Cut and the High – Cut entry in the menu – bar to remove unwanted frequencies prior to the calculation. See page 138 for details.
· The status – bar on the bottom of the window shows the current state.
· To run the delay – finder with all new data, hold the shift – key down while you click on Get It.
· The web – client also supports the delay – finder.

[bookmark: __RefHeading__27454_1304818041]The menu bar of the Delay – Finder
[image: ]The menu bar is located on top of the Delay – Finder window.
[bookmark: __RefHeading___Toc35579_3674554100]The entry Delay Finder
[image: ]This entry contains the same functions as the three buttons on the lower right area.
· Get It starts a new calculation of the impulse – response.
· Layout opens a sub – menu where you can configure the display of the trace.
· Keep Alive use this entry to toggle the functionality of the Apply function.
· Checked: Hitting Apply or pressing F3 will assign the current delay value only, but will not close the window. To close the window either use Cancel or keep the mouse – button or the F3 key pressed for at least one second.
· Unchecked: Hitting Apply or F3 will apply the delay value and will close the window.
· Cancel closes the delay – finder without changing the current delay – time setting.
[bookmark: __RefHeading__24890_325124142]The entry Low – Cut
This entry shows a list of the frequencies available for the low – cut. The low – cut is applied during the calculation of the impulse – response. You can use the low – cut to remove unwanted low frequency signals from the impulse – response. The current setting will show on the left of the status – bar at the bottom of the window.
[bookmark: __RefHeading___Toc41338_2823577171]The entry High – Cut
This entry shows a list of the frequencies available for the high – cut. The high – cut is applied during the calculation of the impulse – response. Use the high – cut to exclude noise and high – frequency interference from calculation of the impulse – response. The current setting will show on the right of the status – bar at the bottom of the window.

[bookmark: __RefHeading__24892_325124142]The entry Trace Copy
[image: ]Use this entry to make and manage an instant copy of the calculated impulse – response. The copy will remain available until you exit SATlive. See page 141 for further details on the trace – copy in the delay – finder window.
· Copy Trace creates a copy of the currently shown impulse – response.
You can use the key F5 on your keyboard to invoke this function.
· Show Trace Copy use this entry to toggle the visibility of the copy trace.
You can use the key F6 on your keyboard to invoke this function.
· Bring to front makes the copy – trace the top – most trace in the display.
When this option is enabled the vertical scaling of the display will be based on the peak value of the copy – trace, otherwise on the peak value of the current measurement.
Please note that the position in time, which always relates to the position of the peak value in the current measurement, is not affected by this setting.
· Lock Position this option determines the horizontal position of the copy – trace in the display
· Lock Position enabled: The copy – trace is displayed using its time position, so the peak of the copy – trace is not necessarily at the center of the display, it might even be not visible at all. Use this setting to compare the position in time of both traces. Because the display – range of the delay – finder is limited, we suggest that you use the impulse – response display (see page 130) to adjust delay settings.
· Lock Position disabled: The copy – trace is moved in a way that the positions of the peaks in both traces will show at the center of the display. Use this setting to compare the form of both impulse – responses. This is helpful to compare polarity or to detect failures in the performance of a speaker.
· [image: ]Clear Trace Copy discards the content of the copy – trace. The content of the copy – trace will be lost. If you just want to hide the trace use the Show Trace – Copy entry instead.

[bookmark: __RefHeading__29271_1304818041]The entry Marker
[image: ]This entry manages the time – markers using the time – marker menu (see page 308).
You can invoke the delay – matrix (see page 46) in this menu also.
Click onto one of the ten marker labels in this menu to open a sub – menu which will offer individual settings for the marker. (see page 309).
Below of the ten labels menu you’ll find some global functions to show, hide, reset or clear all ten markers at once.
The two entries at the bottom allow you to store and recall the markers from a file.
[bookmark: __RefHeading__27452_1304818041]The entry Direct – Reference
[image: ]This entry contains two functions for the management of the delay used by the Direct – Reference feature. See page 354 for a close description of the Direct – Reference feature.
· Reset triggers the Set Direct-Reference Delay to Default function, which sets the delay of the Direct – Reference feature to a default value.
· Assign triggers the Apply current delay to Direct-Reference function using the delay-value in the delay – finder, closes the delay – finder, returns to the main window and sets the current delay to zero.
This entry is visible only if a valid delay has been measured by the delay – finder.

[bookmark: __RefHeading___Toc42390_1651769397]Trace – Copy
[image: ]This page refers to the trace – copy available in the delay – finder window (see page 135).
All functions related to the trace – copy can be found in the menu entry Trace Copy (see page 139). You can execute the basic tasks Assign and Show/Hide for the trace – copy using the keys F5 (Assign) and F6 (Toggle visibility) also.
As long as the trace copy shows its parameter will show in the upper right area of the display.
If filters had been used for the calculation of the trace – copy, then the upper two lines will show the parameters of the filters.
The next line shows the polarity of the peak. The state of the Lock Position setting (see page 139) in the menu will show in this line also. If Lock Position shows up, the trace – copy shows at the correct position in time. Otherwise its peak will show at the center of the display.
Should the position of the peaks differ for the current trace and the trace – copy, then the difference in time will show in the next line.
Hints:
· The current trace – copy will save when you close the delay – finder display. It will be available until you exit SATlive.
· Use the entry Bring to Front in the menu to draw the trace – copy in front of the current trace. This setting will scale the vertical axis to fit the peak of the trace – copy. Otherwise the vertical axis will scale to fit the peak of the current trace.
· The center of the display is always based on the peak’s position in the current trace. Only if not current trace will be available and a trace – copy still exists, the center of the display will be adjusted according to the peak of the trace – copy.

[bookmark: __RefHeading__25193_1248855964][bookmark: Ref_LDF]Delay – State Display
[image: ]The delay – state display, which is visible only during the measurement of the transfer – function, indicates the current state of the impulse – response calculated in the background.
This impulse – response, which you can configure in the popup menu assigned to the delay display (see page 165 for details), is calculated in the background of the calculation of the transfer – function.
The display is located on the upper right area. It shows the polarity of the impulse – response in the upper section and it’s lower section indicates the difference between the position of the peak in the impulse – response and the delay value currently used.
[image: ]An empty delay – state display indicates that no valid information could be obtained from the impulse – response.
[bookmark: __RefHeading___Toc41340_2823577171]Polarity information
[image: ]If the peak of the impulse – response is positive, then the upper section shows a peak pointing upwards on a green colored background.
[image: ]If the peak of the impulse – response is negative, which might indicate a reversal of polarity, then a peak pointing downwards shows up on a red colored background.
[bookmark: __RefHeading___Toc41342_2823577171]Delay information
[image: ]If the position of the peak in the impulse – response matches the currently used delay, then the lower section will show a green rectangle at the center.
[image: ]A red rectangle at the right indicates that the value of the current delay is lower than the value indicated by the impulse – response.
[image: ]A red rectangle at the left indicates that the value of the current delay is above the value indicated by the impulse – response.
[bookmark: __RefHeading___Toc41344_2823577171]Apply the calculated delay
Click onto the delay – state display to set the delay calculated from the impulse – response as the delay used for the current calculation. You can also use the key – combination Ctrl + D for this task.

[bookmark: __RefHeading___Toc29291_936463611]The low-frequency delay-finder
The low-frequency delay-finder calculates the delay needed for the transfer-function measurement using the averaged phase values in a given range of frequency.
The target of this calculation is to get the phase response trace as flat as possible.
You should not use this value for alignment purpose, because it's an averaged value.
The calculation referrers to a phase trace, so it is only available during the measurement of the transfer-function. See page 124 for details about the measurement of the transfer-function.
[bookmark: __RefHeading___Toc41346_2823577171]Using the low-frequency delay-finder
· Select the range of interest using the cursor-range tool. See page 96 for details about how to use the cursor-range tool.
· [image: ]Invoke the Low-Frequency Delay-Finder by clicking on the entry in the delay’s popup menu or in the popup of the trace-display labeled Low-Frequency Delay-Finder.
· Now a small window pops up, which shows the results.
[bookmark: __RefHeading___Toc41348_2823577171]The display window
[image: ]This window pops up after you started the Low-Frequency Delay-Finder and shows the result of the calculation.
· Related to current delay: The difference between the values of the calculated and the current delay.
· Related to time zero: The absolute value calculated for the delay.
· Apply: Assign the calculated delay to the current measurement and close the window. It also shifts the display of the phase-trace to center the phase-trace vertically.
· Close: Close the window and discard the calculated delay.

[bookmark: __RefHeading__24990_1360952585][bookmark: Ref_Set_Delay_for_MAT][bookmark: Ref_AutoDelay]Auto-Delay Functionality
During the measurement of the transfer-function, SATlive calculates and monitors an impulse – impulse in the background. This enables the software to keep track with changing values of the delay, which for instance occur when you move the measurement mic to an other location.
If you're performing a measurement in order to check relation in time, you must disable the automatic change of the delay, because the automatic change of the delay value would spoil your measurement by voiding your reference in time.
Therefore you should use the automatic change only if you're interested in amplitude information only.
You can disable or configure the precision of the calculation used by this functionality in the Setup → Measurement section. See page 200 for more information about this setup section.
[bookmark: __RefHeading___Toc41350_2823577171]Settings
[image: ]The settings are located in the popup menu of the delay-display in the lower menu bar.
· Adjust Delay: This function changes the current delay to the last delay measured. 
You can use the shortcut Ctrl + D to invoke this function without the need to popup this menu.
· Autoadjust Delay: If you activate this option, the current delay is changed any time the delay measured changes. This option will be helpful when you're measuring amplitude-response traces, but you must not use it when you want to measure information about relations in time, as needed for time-align or for creating a certain coverage pattern.
· Show Warning when Delay changes: If you activate this option, SATlive compares the currently used delay to the measured delay. If the values differ, then it swaps the colors in the display to indicate the difference.

· [image: ]Allow Jitter: The calculated delay might slightly vary due to the movement of the air, change of temperature or other reasons, even if the position of the mic does not change. The entries in the Allow Jitter sub-menu will add some tolerance to the Autoadjust Delay function, so that small changes will not change the delay and not reset the current measurement. Select the tolerance from the entries in the sub-menu.
You can disable the Auto – Delay feature in the Setup → Measurement window (see page 200). This window also features the possibility to select the desired length of the impulse response. In most cases the default value will work fine, but you have the choice to change the value in both directions, either to a shorter impulse – response with a higher refresh – rate and lower quality or to a longer impulse – response with increased quality but lower refresh rate. See page 200 for details about this setup window.
[bookmark: __RefHeading__25890_516930338]Visual indication in the delay-time display
[image: ]If the Autoadjust Delay option is selected, a red square is shown at the left in the delay-time display.
[image: ]When you've activated the Show Difference in Time option at the same time, the yellow triangle, which indicates that the display shows a difference in time, is drawn on top of the square. More details about using a reference in time for the delay-time display can be found on page 166 of this document.
[image: ]A difference in time between the currently set delay and the delay measured is indicated by an inversion of the colors in the delay-time display, if the Show Warning when Delay changes option had been selected.
Hint:
· The calculation of the delay is not as precise as done for the delay-finder or for the impulse-response display.

[bookmark: __RefHeading___Toc41352_2823577171]Menus in complex menu mode
[bookmark: __RefHeading___Toc41354_2823577171][bookmark: hs1610][image: ]Trace display (MAT)
· [image: ] Phase opens a popup menu where you can select different display modes for the phase (-180° to 180° or 0° to 360°) and different ranges of the group-delay display. You can shift the phase display using the shortcuts Ctrl + Next and Ctrl + Prior in steps of 45°.
· [image: ] Invert live trace mirrors the live trace on the zero dB line. The shortcut is Shift-I.
· [image: ] Hide current trace hides both the amplitude and phase display. The shortcut is ^ (Top left of number 1).
Hint:
· The options displayed depend on the measurement selected.
[bookmark: __RefHeading___Toc41356_2823577171][bookmark: hs1620][image: ]Mic-correction, Tools and Info (MAT)
· [image: ] Mic Correction activate the mic correction for the live trace. If no valid mic correction is loaded, then the Load Mic-correction function, which can accessed via the button's popup menu also, is invoked. The shortcut is M. On page 107 you can find more information related to the mic-correction and the popup menu assigned to this button.
· Tools open a sub menu containing more settings and functions. See page 147 for more information about the menu Tools
· [image: ]Info show information about the selected trace. You can also use this function to edit the trace's description.
· [image: ]Trace Layout opens the Trace – Layout window for the live trace. You'll find more information about the Trace – Layout window starting on page 301.

[bookmark: __RefHeading___Toc29210_1659891755][bookmark: Ref_Tools_menu]Menu Tools
The options displayed depend on the measurement selected.
[bookmark: __RefHeading__22756_1307676328][image: ]RTA Mode
· [image: ] Calibrate current RTA calibrates the RTA display. For calibration use a loop-back from the output to the REF input, select averages ultra and start pink noise.
After a few seconds with pink-noise running, this entry is enabled. 
The calibration compensates the errors of the frequency – response caused by the audio converters and other equipment used for the measurement.
[bookmark: __RefHeading__26296_1270454357]FFT
· [image: ][image: ] Limit: FFT Level a point is only added to the averaging latch, if the ref signal's level exceeds this threshold value. Therefore the transfer function is calculated only on frequencies with enough power in the reference signal. The values shown are absolute levels only if a level adjustment has been performed. See page 162 for details.
· Windowing select the window applied prior to the calculation of the FFT.
· [image: ] FQ Scale Style set the style of the frequency scale. See page 88 for details.
· [image: ] THD+N start the total-harmonic distortion measurement. See page 122 for details.
[bookmark: __RefHeading___Toc41358_2823577171]FFT and Spectrograph
· [image: ]The three settings at the top of the menu are the same as described in the FFT section on this page.
· Time Range Spectrograph select the desired time for the spectrograph display from the sub menu. The time selected is needed to fill the spectrograph.
· Run only once if this option is selected, the spectrograph (but not the FFT display) freezes after it is filled completely.

[bookmark: __RefHeading__23535_987277056]Transfer Function
· [image: ]Loaded Trace use this entry to replace the current measurement by a stored trace. This will enable you to use the calculations (See page 288). See page 288 for details about the Loaded Trace feature.
· [image: ]Limit: FFT Level a point is only added to the averaging latch, if the level of the reference signal exceeds this threshold value. Therefore the transfer function is calculated only on frequencies with enough power in the reference signal. See page 162 for a closer description of the amplitude threshold feature.
· [image: ] Limit: Coherence a point is only displayed if its coherence exceeds this threshold value. The coherence indicates how good the mic signal is related to the ref signal. The coherence is, especial at high frequencies, affected by the delay setting.
· Noise Threshold shows the menu assigned to the Noise – Threshold tool. See page 163 for details of this tool.
· [image: ] Display range for Coherence select the vertical range for the coherence display. The coherence is show at the top of the upper window. The labels for the coherence range are on the left side.
· [image: ] FQ Scale Style set the style of the frequency scale. See page 88 for details.

[bookmark: __RefHeading__24932_2077752202][bookmark: Ref_toolsIR]Impulse Response
· [image: ]Windowing select the window applied prior to the calculation.
· Display size set the size of the calculated impulse response. Higher size has higher precision but takes more time to calculate. This value also determines the range of time that the impulse response covers. You can access the sub-menu in the right-menu area (see page 158) also.
· [image: ]Averages set the number of averages performed. The impulse response is calculated using a FiFo memory, except for the Average All Values option, which averages all measurements since the last reset. See page 314 for more information about averages.
· [image: ]Amplitude modification set the gain of impulse response, given as a linear factor, not as a dB value. The area Y-Factor in the right menu-area (see page 158) shows the value currently selected. To access the sub menu just click on this area.
· IR Zoom Value select the zoom factor for the delay – zoom window (see page 132). You can see the current zoom factor in the lower right corner of the display area. Click onto the value to open the sub menu.
· [image: ]High – Cut use this entry to remove higher frequencies prior to the calculation of the impulse – response. You can access this sub – menu in the right menu area (see page 158) also.
· [image: ]Low – Cut use this entry to remove lower frequencies prior to the calculation of the impulse – response. You can access this sub – menu in the right menu area (see page 158) also.
· [image: ]Direct – Reference use this entry to configure the delay used by the direct – reference feature. The description of the Direct – Reference feature starts on page 331 of this document.

[bookmark: __RefHeading___Toc41360_2823577171]Common Menu Entries
· [image: ]Hide current trace hides the display of the live trace. Please note, that the hidden live trace is still updated. To lock the live trace use the button Running in the right menu-area (see page 158).
· [image: ]Save write the live trace to a file.
· Load F5-Trace from File reads a file and puts it into the F5 – memory. Use the key F6 to toggle the visibility of this trace. This function is deprecated and you should use the load trace option of the Quick – traces (see page 270) instead.
· [image: ]Direct-Reference opens the menu related to the direct-reference feature. See page 330 for details. This menu is available only if Direct Reference is selected as the current REF input. See page 151 for a description of the entries of this menu.

[bookmark: __RefHeading__26160_1819804763]The menu Direct – Reference
[image: ]You can find this menu in the Tools menu (see page 147) and in the popup menu of the signal-generator (see page 224). Some functions are also located in other menus. Please see the description of each entry for details.
[bookmark: __RefHeading___Toc41362_2823577171]Autoset Direct – Reference
This entry performs both the Save as Direct-Reference Correction and the Apply current delay to direct-reference actions.
You can use this function for a quick setup of the direct-reference feature.
Please refer to the Adjust the direct-reference settings section on page 332 for more details.
[bookmark: __RefHeading___Toc41364_2823577171]Use Direct-Reference Correction
Applies the Direct-Reference Correction to the current transfer-function measurement.
This setting does not affect the internal delay used on the direct-reference input.
The Autoset Direct-Reference function and the Save as Direct-Reference Correction function enables this setting.
[bookmark: __RefHeading___Toc41366_2823577171]Save as Direct-Reference Correction
Creates the correction data and stores it to an internal latch. The correction data is automatically saved and restored. This function is available also in the Save sub-menu. See page 170 for more information about the Save sub-menu.
[bookmark: __RefHeading___Toc41368_2823577171]Apply current delay to Direct-Reference
Uses the currently set delay to calculate the delay needed for the direct-reference. 
This function is enabled only if the current delay differs from zero.
This function is available also in the popup menu of the delay setting area (see page 166) and in the delayfinder (see page 135).

[bookmark: __RefHeading___Toc41370_2823577171]Set Direct-Reference Delay to Default
This function resets the delay to the value reported by the ASIO driver. It can be helpful if you set a wrong value and the delay-finder is not able to calculate the correct value. This function is available also in the delayfinder (see page 135).
[bookmark: __RefHeading__27208_40126426]Direct – Reference in the Delayfinder
[image: ]The menu-entries Apply current delay to Direct-Reference and Set Direct-Reference Delay to Default are also available in the window of the delay-finder. 
See page 135 for details about the delayfinder.
[image: ]The area which contains both entries is located on lower left of the window. 
You can access both entries using the Direct – Reference entry (see page 140) in the menu – bar of the delayfinder (see page 138 for details).
Please note that due to the lack of space the icons are missing and the labels differ from the labels used in the Direct – Reference menu.
· Reset triggers the Set Direct-Reference Delay to Default function. This will set the delay value of the Direct – Reference feature to a default value, which is calculated based on the current ASIO buffer settings.
· Assign triggers the Apply current delay to Direct-Reference using the delay-value in the delay – finder, closes the delay – finder, returns to the main window and sets the current delay to zero.
This entry is visible only if a valid delay has been measured by the delay-finder.

[bookmark: __RefHeading___Toc41372_2823577171][bookmark: hs1640]MAT Kind of Measurement and Tracemanager
· [image: ]Select kind of measurement opens a popup menu from which you can select the measurement. Further Information about the measurements available is available in this document, starting on page 117.
· [image: ] Tracemanager hide or show the tracemanager. The shortcut is Ctrl + T. See page 235 for details about the tracemanager.
[bookmark: __RefHeading___Toc41374_2823577171][bookmark: hs1650]Additional functions MAT
· [image: ][image: ] Reset Averages clear all data in memory and start again with new samples. The shortcut is R. This function is also available in the right menu area. See page 156 for a closer description of the right – menu area in the transfer – function measurement.

[bookmark: __RefHeading___Toc41376_2823577171][bookmark: hs1660]The Right Menu – bar in the MAT – Module
The right menu-bar contains different functions and information, depending on the kind of measurement selected.
[bookmark: __RefHeading___Toc41378_2823577171][bookmark: hs1663]Right menu Impedance Measurement
· [image: ]Amp – Limit set the threshold for the calculation. The impedance is calculated only for frequencies where the level of the reference signal exceeds this limit. See page 162 for details.
· Cursor details: This area shows information calculated based on the current position of the cursor. For more details see the Cursor details  section on page 177 of this document.
· RESET cleans the display and the averaging memory. You can use the key R on your keyboard to trigger this function.
· [image: ]The button RUNNING starts/stop the update of the live trace's display. The shortcut is the space-bar. If the update is stopped, the button will show a vertical red line and is label will read FROZEN.

Hint:
· Most of the settings are available in the tools menu as well.

[bookmark: __RefHeading__26054_7977939]Right Menu bar RTA Measurement
· [image: ]Release use this setting to select how long it takes for the display to return after the end of the signal. A longer release time smooths the display and makes it easier to read.
1. Display the display setting allows you to select how fast the RTA responses to loud signals ('Peaks'). The setting Peak reacts very quickly to any peak, making the display look jumpy on a dynamic signal. 
The average setting smooths the response and makes the display more stable.
· Resolution because of the limited amount of display points the resolution of an analogue RTA is limited, in most cases to steps of one or two dB, depending on the dB range covered by the analyzer.
This setting allows you to simulate this behavior.
· Reset cleans the display, the latched peak – values and the averaging memory. You can use the key R on your keyboard to trigger this function.
When the signal – generator (see page 223) is not running, then the short – cut Shift – G will start the sound and reset the averages.
· RUNNING / FROZEN starts or stops the measurement. When the measurement stops, the display will freeze the last state and the label will change to FROZEN. You can use the Trigger-Freeze feature (see page 119 for details) to automate this function. You can also use the space-bar on your keyboard for this function.
[bookmark: __RefHeading___Toc41380_2823577171]Which settings should I use?
For the feedback detection use peak response and a long release time in order to be able to catch the frequency of the peak. For this purpose we recommend that you use the settings Freeze Peak Display and Display follows Peak in the triggered – freeze section (see page 119), which allows you to read the frequency after stopping the feedback.
If you want to see the spectrum of an instrument use the average display setting and a medium release time. If you like to try to flatten a frequency response using the RTA and pink noise, use Average and Ultra.

[bookmark: __RefHeading__22737_1082827234]Right menu bar in transfer function measurement
· [image: ]Offset move the selected trace up or down. See page 90 also.
· AMP Limit a point is only added to the averages latch, if the ref signal's level exceeds this value. Therefore the transfer function is calculated only on frequencies with enough power in the reference signal. See page 162 for details about the setup window of the amplitude-threshold value.
· COH Limit a point is displayed in the transfer function only if its coherence exceeds the coherence limit. The coherence indicates how good the mic signal is related to the ref signal. The coherence is, especial at high frequencies, affected by the delay setting. If the dynamic setting is selected, then the coherence limit is calculated depending on the amount of valid points in the averaging memory for each frequency.
· Noise Threshold opens the sub – menu assigned to the Noise Threshold setting.
See the page 163 for details. You can use the setting Noise Threshold in the Setup → Measurement section (see page 200) to toggle the visibility of this entry.
· RESET cleans the display and the averaging memory. You can use the key R on your keyboard to trigger this function.
When the signal – generator (see page 223) is not running, then the short – cut Shift – G will start the sound and reset the averages.
· [image: ]RUNNING start/stop the update of the live trace's display. The shortcut is the space-bar. If the update of the display is stopped, then the color of the vertical line will change to red and the label will read FROZEN.
· Cursor details: See the Cursor details (on page 177) section for details.

Hint:
· You can find most of this settings in the menu Tools (described on page 148) as well.

[bookmark: __RefHeading___Toc41382_2823577171][bookmark: hs1667]Right menu bar in MAT – FFT and in Spectrograph
· [image: ]Offset move the selected trace up or down. More details can be found on page 90.
· AMP Limit in the Transfer function a point is only added to the averages latch only if the ref signal's level exceeds this value. Therefore the transfer function is calculated only on frequencies with enough power in the reference signal. You can use the FFT display to check if the signal is above the limit. A setup window shows up when you click on the value display. See page 162 for details about setting the amplitude-threshold value.
· The Cursor Details, described on page 177 show more information related to the current position of the cursor.
· RESET cleans the display and the averaging memory. You can use the key R on your keyboard to trigger this function. When the signal – generator (see page 223) is not running, then the short – cut Shift – G will start the sound and reset the averages.
· RUNNING start/stop the update of the live trace's display.
The shortcut is the space – bar. If the update is stopped, then the color of the vertical line will change to red and the label will read FROZEN.

Hint:
· Most of the settings can be found in the menu Tools (see page 147) as well.

[bookmark: __RefHeading__24930_2077752202][bookmark: Ref_rightIR]Right menu bar impulse response (MAT)
This menu bar is available during the measurement of the impulse – response trace (see page 130 for details). To change a setting, click on the display area assigned to it. This opens a popup list, where you can pick the desired setting.
· [image: ]Size size of the impulse response to be calculated. A higher size has higher precision, but takes more time.
· Averages number of measurements to averages for the result. See the page 314 for more details about averaging.
· Y-Factor gain of the impulse response, given as a linear factor, not as a dB value. You can use the key A on your keyboard to set this value according to the current measured impulse – response.
· High – Cut use this setting if you want to remove the higher frequencies of both input signals prior to the calculation of the impulse response.
· Low – Cut use this setting to remove low – frequency content prior to the calculation of the impulse – response.
· Reset cleans the display and the averaging memory. You can use the key R on your keyboard to trigger this function.
When the signal – generator (see page 223) is not running, then the short – cut Shift – G will start the sound and reset the averages
· [image: ]RUNNING button start/stop the update of the live trace's display. The shortcut is the space – bar. If the update is stopped, then the color of the vertical line will change to red and the label will read FROZEN.
Hint:
· You'll find most of the settings in the menu Tools as well. You'll find the description of this menu at page 149.

[bookmark: __RefHeading___Toc27286_1641174950][bookmark: hs1670]Trace Layout
Select a parameter of the trace display's layout. Not all parameters are available for every measurement.
[image: ]To open this menu, you can either click on the button left to the value display in the lower menu bar or you you can navigate to it in the popup menu of the trace display.
· [image: ][image: ] Upper limit move the trace display's top border. The visible dB range ranges from the [image: ] upper limit minus the [image: ] Y-range to the upper limit. This setting is not enabled in the transfer function measurement.
· Vertical Shift available during the measurement of the Transfer – Function. This setting moves the display vertically, without affecting vertical range currently set.
· [image: ] Range Y set the trace display's vertical range.
· [image: ]Line Gap set the scale's vertical distribution.
· [image: ]Averages invoke the averages menu (see page 315) containing different options for the averaging. See page 314 for more details.
· [image: ]Display Range for Coherence: select the range for the coherence display from this sub-menu. This setting is available only in the transfer-function measurement.
· Configuration stores or loads layout-settings from this sub-menu. See page 311 for details of the configuration handling.
· [image: ]Trace Layout opens the Layout Editor for the live-trace. See page 301 for details.
· Show Last – Good Values enables the display of previously calculated values if the current values do not fit the quality – criteria. See  the page 126 for details about the Last – Good Values feature.

· [image: ]The next two options are available only during the RTA measurement (see page 117).
· RTA Classic Style: With this option selected the RTA will show two bars side by side when both inputs are selected for display.
Furthermore this setting implies the RTA Classic – Color option, so the RTA Classic – Color option will not be visible with RTA Classic Style selected.
· [image: ]RTA Classic Colors: When you’ve selected this option then the lower part of the bars of the RTA display will show in the color assigned to the traces, otherwise they will show in green.
RTA Classic Colors will enable automatically when you select the RTA Classic Style option.

Hints:
· [image: ]When you select a parameter the value editor field shows the parameter's current value. The current parameter's name is displayed left to the value editor field.
· In the transfer-function measurement you can change to the full views by double-clicking on the related area in the display. A double-click on the full-view changes back to the split view.
· The parameter's value can be changed at the value editor field.
· Each parameter features a popup menu containing some preset values.
· The values for the parameters Upper limit, Range Y and Averages can differ for each kind of measurement.
· In the RTA and the FFT measurement you can select the input to display below the VU – meter. See page 176 for more information about selecting an input for the current measurement.
· The trace layout section is not enabled in the impulse – response measurement.
In the impulse-response measurement the settings are available in the right menu bar (see page 158) and in the menu Tools (see page 149).
· In measurements which use a split screen, you can change the position of the split. There are two ways to do this:
· [image: ]Use the popup menu of the split area to select one of the three predefined positions.
· Put the mouse onto the split area, click and hold down the left mouse-button and move the split area up or down by moving the mouse. If the desired split position is reached, just release the mouse-button.

[bookmark: __RefHeading__25892_516930338][bookmark: Ref_Amplitude_Theshold_Setup]The Amplitude-Threshold setup window
[image: ]The amplitude – threshold setup window shows up when you click on the value of the current amplitude – threshold in the right menu area.
The setup of the amplitude – threshold value is supported in the FFT measurement, in the impedance-measurement and the measurement of the transfer – function.
On the left of the setup window there is a slider which allows a fine adjustment of the amplitude – threshold value in steps of 1 dB.
You can use the arrows above the sliders to fine – adjust the value in steps of 1 dB.
On the right there are some preset buttons for a quick and coarse setup of the amplitude – threshold value.
The button OFF disables the use of the amplitude – threshold feature in the calculation of the transfer – function and in the calculation of the impedance-trace.
To enable the amplitude – threshold feature again just click again on the OFF button, move the slider or select one of the preset values using the buttons on the left.
The currently selected amplitude – threshold value is shown in the right menu area.
[bookmark: __RefHeading__24712_516930338]Set the Amplitude – Threshold value in the FFT measurement
[image: ]Beside of using the amplitude – setup window as described above, you can set the amplitude – threshold value by moving the small handle on right to the trace – display area in the FFT measurement in the MAT module.
To do so, just move the mouse to the handle, hold down the left mouse button and move the mouse up or down.
If you move the handle below -100dB, then the amplitude – threshold value will change to OFF. To enable the amplitude – threshold feature again, just move the handle up until it is over the -100dB border.

[bookmark: __RefHeading__22017_1082827234]Noise Threshold
[image: ]In a default Dual – FFT measurement, the Amplitude Threshold is used to calculate the frequency-response only at frequencies with enough power in the source signal, thus avoiding calculation at frequencies with bad S/N values. This approach works well, especial with source signals with varying spectral content (like music), but it does not take the spectral content of the noise present at the venue into account.
So the Noise Threshold has been added, which takes care of the noise level reaching the measurement microphone.
With Noise Threshold enabled, SATlive compares the current spectrum of the measurement signal to the stored threshold trace. A calculation of the frequency response is performed only if the level of the microphone signal is above the threshold-trace. The threshold-trace can be shifted by a fixed value.

[bookmark: __RefHeading___Toc41384_2823577171]Using Noise Threshold
[image: ]The Noise Threshold features a button in the right menu bar. 
A click with the left mouse-button onto the button opens the menu for the Noise Threshold feature.
· [image: ]Deactivated: The top entry in the menu disables the Noise Threshold feature. 
· [image: ]Set Noise Threshold: Start the sampling of the threshold trace. The sampling runs until you stop it by selecting a shift value from the menu, by setting the Noise Threshold to Deactivated or by starting the signal generator.
Starting the sampling clears the previous threshold trace.
The threshold trace samples the highest value at each frequency that occurs during the sampling period.
Starting the sampling process stops the noise generator to avoid capturing of the measurement signal. Vice versa starting the noise generator will stop the sampling process.
The threshold trace is captured using the measurement mic.
· Offset values (-5dB … + 10dB) selection of one of these entries enables the Noise Threshold with the current threshold trace. The selected offset value adds to the value of the threshold trace. For example if the value in the threshold trace is -76 dB, then an offset value of +6dB sets the final threshold to -70dB. In this case the calculation is performed only if the level of the mic signal exceeds -70dB at this certain frequency.
These selections are enabled only if a valid threshold trace is available.
Hint
· You can use the setting Noise Threshold in Setup → Measurement (see page 200) to toggle the visibility of the Noise Threshold button in the right menu bar of the transfer – function measurement (see page 156).

[bookmark: __RefHeading__24294_174066489][bookmark: hs1680]Menu Delay in the MAT module
· [image: ][image: ]Delay-finder invokes the delay-finder. See page 135 for details about the delay-finder.
· [image: ] Cursor to delay use the current position of the cursor as the new delay time. This option is available only in the impulse – response measurement. You can use the key F3 to trigger this function.
· [image: ]Recall Delay recalls the delay from one of the time – markers (see page 306).
· [image: ] Direct (Zero Delay) reset the current delay to 0 ms.
· Custom delay setting (coarse) use the arrows at the left of the delay display to change delay in steps of one millisecond. Hold down the Shift key to change in steps of 10ms or the Ctrl key to change in steps of 50 ms
· [image: ]Delay display shows the current delay.
To start the delay finder just click on this area. This area contains a popup menu, which is described in the popup menu of the delay display section on the page 166.
If the delay display shows the time difference between the reference-time and the current delay setting, a yellow triangle is shown left of the value. The value of the reference-time is shown in the hint.
If the Autoadjust – Delay option is activated in the popup menu, a red square is drawn in the left area. See page 144 for details about the auto-delay functionality.
· Custom delay setting (fine) use the arrows on the right of the delay display to change the current delay in steps of one sample (approx. 21 us).
Hold down the Shift key to change the delay in steps of 250 us.
· [image: ]Menu this entry will show the delay popup menu (see page 166).
Hints:
· Any change of the current delay voids all data and restarts the measurement.
· The delay is used on the REF input in all measurements.

[bookmark: __RefHeading__21420_1819804763][bookmark: Ref_delayMenuPopUP]The menu of the delay display area
[image: ]This popup menu is assigned to the delay-display area. It contains some settings, which are also contained in the delay menu, and two additional entries at the bottom of the menu.
· [image: ]Recall delay use the delay assigned to a time – marker (see page 306) as the current delay. Choose the time trace from the sub – menu.
· [image: ] Direct reset the current delay to 0 ms.
· Copy Delay from Trace use this entry to set the delay used during the measurement of a stored trace as the current delay.
· Use Reference Time as new Delay this function applies the reference – delay setting as current delay.
· Delay Matrix use this entry to invoke the delay – matrix (see page 46 for details).
· [image: ]Store current Delay use this entry to assign the current delay value to a time – marker (see page 306). The sub – menu contains some global settings and functions for the management of the time – markers.
· [image: ] Delay Finder invokes the Delay – Finder. See page 135 for details.
· [image: ]Low-Frequency Delay-Finder invokes the Low-Frequency Delay-Finder (See page 142).

· Adjust Delay, Autoadjust Delay, Show Warning when Delay changes, Allow Jitter: This entries refer to the auto – delay functionality. More information can be found in the Auto – Delay section of this document, starting on page 144. You can access these entries only if the Auto – Delay feature is enabled in Setup → Measurement (see page 200)
· Save as Direct – Reference Correction use this entry to assign the current delay-value to the direct-reference feature (see page 330). This function is available only if the current delay value differs from zero. You can find this function in the direct – reference menu (see page 151) and in the delay-finder (see page 135), too.
· [image: ]Set Reference, current value assigns the current delay as time reference. The reference time will be used to calculate the difference in time when the Show Difference in Time option is activated.
· Show Difference in Time when this option is activated, the delay – time display will show the difference in time between the current delay – time value and the reference – time set using the Set Reference entry of this menu.
This option is indicated by a yellow triangle left to the time value, and the hint of the delay – display will show the value of the reference-time memory.
To show the hint, just move the mouse onto the delay – display area.
Otherwise, the delay – time display will show the absolute value of the currently set delay.
· At the bottom of the menu you’ll find a list containing the last used delay times. To recall a delay time just click on the entry you want to recall.

[bookmark: __RefHeading___Toc41386_2823577171]Menus in the simple menu layout
[bookmark: __RefHeading___Toc33738_150880275][bookmark: hs1690]The menu Delay in the MAT module
· [image: ][image: ] Delay Finder invokes the delay – finder(see page 135).
· D = C use the cursor's current position as the current delay. Available only in the impulse – response measurement. The shortcut is F3.
· [image: ]Recall Delay use this entry to use the delay assigned to one of the time – markers (see page 306). Choose the time – marker from the sub – menu.
· Custom delay setting (coarse) use the two arrows at the left of the delay display to increment and to decrement the current delay in steps of one millisecond.
· [image: ]Delay display shows the current delay. A click on this area starts the delay – finder. See page 135 for details about the delay-finder.
This area contains a popup menu, which is described in the popup menu of the delay display section on page 166 of this document.
If the delay display shows the time difference between the reference-time and the current delay setting, a yellow triangle is shown left of the value. The value of the reference-time is shown in the hint. To display the hint, just move the cursor onto the delay-display area.
· Custom delay setting (fine) use the two arrows at the right of the delay display to increment and to decrement the current delay in steps of one sample.
· [image: ]Menu opens the delay popup menu, described at page 166.
Hints:
· Any change of the current delay will void all data and restart the measurement.
· The delay will apply to the reference (REF) input in all the measurements taken in MAT module. See page 144 for details about the different ways to to set the delay.
· You can use the shortcut F7 to invoke the delay – finder. See page 135 for details.

[bookmark: __RefHeading___Toc41388_2823577171][bookmark: hs1700]Upper Menu (MAT simple menu layout)
· [image: ][image: ]Save store the live trace into a file. The button contains a popup menu where you can select the type of file you want to save the trace to.
· [image: ] Phase open a popup menu which contains the selection of different display modes for the phase (-180° to 180° or 0° to 360°) and different ranges of the group-delay display. Use the shortcuts Ctrl + Next and Ctrl + Prior to shift the phase display vertically in steps of 45°.
· Tools additional functions and settings. See page 147 for details.
· Mode opens a popup menu from which the measurement can be selected. The button shows the current measurement's symbol. See page 117 for details about the different measurements available in the MAT module.

[bookmark: __RefHeading__25202_1819804763]The popup menu of the SAVE button (MAT Module)
[image: ]This popup menu is assigned to the button SAVE in the MAT Module.
You can save the trace into different types of file. Depending on the measurement selected, some type of file will be not available.
· [image: ]Save as SATlive Data save the live trace using the default SATlive file type. This type contains many additional information, so you should use it, if you want to load the file into SATlive.
· [image: ]Save Trace as Picture save the current display as a picture. You can select the kind of picture you want to save to, in the file type selection in the save file name selection dialog. The quality of the picture (and it's file size) can be changed using the Quality of JPEG conversion setting at setup → features window (see page 207 for further details).
· [image: ] Save F5-Trace to file save the trace which is assigned to the internal memory using the F5 key into a default SATlive file type file.
· [image: ] Save as Wave Data save the trace of the impulse – response measurement into a default windows® audio file. This file can be accessed by many audio related software.
· [image: ] Save as ASCII export the data of the transfer function into a text file. This enables you to import the data into other software.
· Save as Direct – Reference Correction save the current trace as reference trace for the Direct – Reference Tool. See page 330 for details.

[bookmark: __RefHeading___Toc30153_2560284633][bookmark: hs1710]The Menu Tools in the MAT Module (simple menu layout)
[image: ]This menu features many functions and options. Please note that it's content varies with the measurement selected.
· [image: ] Tracemanager open or close the tracemanager.  This function can also be accessed using the shortcut Ctrl +T. See page 235 for details.
· [image: ] FQ Scale Style set the style of the frequency scale. See page 88 for details.
· [image: ]Limit: FFT Level in the transfer function measurement a point is only added to the averaging latch, if the level of its reference signal exceeds this value. Therefore the transfer function is calculated only for frequencies with enough power contained in the reference signal. See page 162 for details about how to set the amplitude-threshold value.
· [image: ] Limit: Coherence a point is only displayed in the transfer function if it's coherence exceeds this threshold value. The coherence indicates how good the mic signal is related to the reference signal. The coherence is affected by proper delay setting. You can edit this value in the right menu-bar as well.
· Noise Threshold opens the sub-menu of the Noise Threshold tool, described on page 163.
· [image: ][image: ] Display range for Coherence select the vertical range for the coherence display. The coherence is shown at the top of the upper window. The labels for the coherence range are on the right side. The sub-menu contains the Show Handle option, which allows you to change the coherence-threshold value using the mouse.
· [image: ] Mic correction activates the mic correction for the live trace. If no valid mic correction is loaded, the Load Mic correction function is executed. This entry contains a sub-menu. See the page 107 for details.

· [image: ]Trace Layout invoke the layout – editor for the live trace. See page 301 for details about how to use the layout – editor.
· [image: ] Hide current trace hides both the amplitude and phase display. The shortcut is ^ (Left to the number 1 key on your keyboard).
· [image: ] Show Instant Values as Dots show the non averaged result of the current FFT calculation as dots. In the transfer-function measurement the result of the last calculation is shown as a dot. SATlive supports different settings for FFT and transfer-function calculation. You can change the color of the dots in the color section of the Setup → Display window. See page 193 for details.
· [image: ][image: ]Save this entry contains a popup menu where you can save different traces. 
· [image: ]Save as SATlive data saves the live trace into a file.
· [image: ]Save Trace as Picture saves the display as a picture.
· The Save F5-Trace to File, which is enabled only if a memory trace is assigned, saves the memory trace to a file.
· Save as Wave Data saves the impulse response as default windows® wave format. You can import this format in various other audio related software.
· [image: ] Load F5-Trace from File open a saved trace as the F5 memory trace.
· Apply Window add a window to the signal prior to the calculation of the transfer-function. A window excludes later reverb and longer delays from the measurement.
· Direct Reference opens the direct-reference menu. See page 151 for details. This entry is available during an impulse-response measurement.
· Edit Target Trace opens the editor for the Target Trace. See page 253 for details about the Target-Trace functionality.
· Allow Gain-Setup using Mouse allows you to move the currently selected trace by moving the mouse vertically while you hold the left mouse button down.

[bookmark: __RefHeading___Toc41390_2823577171]Additional Setting for the RTA measurement
· [image: ][image: ] Calibrate current EQ calibrates the RTA display of the currently selected RTA. To do so, use a loopback from output to the reference (REF) input, select Ultra for the release time and Average for the display. Select the REF input and start the pink noise.
After a few seconds the entry will be enabled.
[bookmark: __RefHeading___Toc41392_2823577171]Additional settings for the FFT measurements
· Windowing select the window applied prior to the calculation of the FFT from the sub menu.
· [image: ] THD+N Start a total harmonic distortion measurement. See page 122 for details.
[bookmark: __RefHeading___Toc41394_2823577171][bookmark: setKombi]Additional settings for the FFT + Spectrograph measurement
· [image: ]Time Range Spectrograph select the desired time for the spectrograph display from the sub menu. The time selected is needed to fill the spectrograph.
· Run only once if this option is selected, the spectro – graph display (but not the FFT -  Display) will freeze when it is completely filled.

[bookmark: __RefHeading___Toc41396_2823577171][bookmark: setMatIR]Additional for the measurement of the Impulse Response 
· [image: ]Windowing select the window applied prior to the calculation.
· Display size set the size of the calculated impulse response. Higher size has higher precision but takes more time to calculate. This value also determines the range of time that the impulse response covers. You can access the sub-menu in the right-menu area (see page 158) also.
· [image: ]Averages set the number of averages performed. The the Average All Values option averages all measurements since the last reset. See page 314 for details about averaging.
· Amplitude modification set the gain of impulse response, given as a linear factor, not as a dB value. The area Y-Factor in the right menu-area (see page 158) shows the value currently selected. To access the sub menu just click on this area.
· [image: ][image: ]IR Zoom Value select the zoom factor for the display of the lower trace. The area is always centered around the time value of zero. 
You can see the current zoom factor in the lower right corner of the display area. Click onto the value to open the sub menu.
· [image: ]High – Cut choose the desired high – cut frequency from the sub – menu. Use this option to remove interfering high frequencies from the calculation of the impulse – response.
· [image: ]Low – Cut choose the desired low – cut frequency from the sub – menu.
Use this option to remove interfering low frequencies from the calculation of the impulse – response.

[bookmark: __RefHeading__23831_1358155583][bookmark: hs1720]Trace layout MAT (simple menu layout)
[image: ]To select the parameter to edit, click on the symbol left to the value edit field with the left mouse button and select the parameter from the popup menu showing up.
· [image: ] Amplitude only this option is visible in the transfer function measurement only. It shows the amplitude window in full size.
· [image: ] Phase only this option is visible in the transfer function measurement only.
It shows the phase – display window in full size.
· [image: ] Upper limit move the trace display's top border. The visible range ranges from [image: ] upper limit minus [image: ] Y-range to upper limit. This setting is not active in the transfer function measurement.
· [image: ] Range Y set the trace display's vertical range.
· [image: ] Line Gap set the scale's vertical distribution.
· [image: ]Averages set the number of averages to perform. See page 314 for more information about averaging.
· [image: ]Display Range for Coherence: select the range for the coherence display from this sub-menu. This setting is available only in the transfer-function measurement.
· [image: ]Configuration stores or loads layout-settings from this sub-menu. See page 311 for details of the configuration handling.
· Trace Layout opens the Layout Editor for the live-trace. See page 301 for details.
· Show Last – Good Values enables the display of previously calculated values if the current values do not fit the quality – criteria. This entry is available only during the measurement of the transfer – function. See page 126 for details about the Last – Good Values feature

Hints:
· After the parameter is selected the value editor field shows the parameter's current value. The current parameter's name is displayed left of the value editor field.
· The parameter's value can be changed at the value editor field.
· Every parameter features a popup menu containing some preset values.
· The values for the parameters Low DB, Range Y and Averages may differ for each measurement.
· You can select the input(s) to display below the VU meter when you perform a RTA or a FFT measurement.
· Set the layout parameter in the impulse –  response measurement either in the menu Tools menu or in the right menu area.
· In measurements which use a split screen, it is possible to change the position of the split. There are two ways to do this:
· [image: ]Use the popup menu of the split area to select one of the three predefined positions.
· Put the mouse onto the split area, click and hold down the left mouse-button and move the split area up or down by moving the mouse.
[bookmark: __RefHeading__26600_7977939][bookmark: hs1730]Select the Input for RTA and FFT measurement
[image: ]You can select the input(s) to display in the MAT → FFT (see page 147) or in the MAT → RTA (see page 117) measurements.
Either perform a mouse click on the labels below the VU meter or you use the shortcuts F8 (REF) and F9 (MIC) to toggle the display of each trace.
Hints:
· You can display the REF input, the MIC input or both inputs.
· A fully colored background indicates that the trace assigned to this button currently shows in the display.
· The current delay will be applied to the REF input.
· The mic correction (see page 107) will affect the MIC input only.
· You can change the assign of the physical input to the functions in Setup → I/O Devices (see page 180).

[bookmark: __RefHeading__25512_7977939][bookmark: hs1740]Cursor details (MAT)
[image: ]The cursor details display is located in the right menu bar. 
It shows details related to the current position of the cursor.
The following values are shown (top down):
· [image: ]The frequency at the position of the cursor is shown at the top.
· The first line shows the Wave length assigned to the frequency. To show a list containing more wavelength related info place the mouse on this value and hold down the left – mouse button.
· The second line shows the Period of the frequency at the cursor's position.
· The next line contains the Phase angle of the live trace at the cursor's position (Displayed only if a transfer function measurement is performed). See page 178 for more details about the calculation of this value. The little square at the right indicates the color of the live – trace.
· The next line shows the Phase angle of the selected trace at the cursor's position (Displayed only if a transfer function measurement is performed and the live trace is not selected as the selected trace). See page 178 for more details about the calculation of this value. The little square at the right shows the display color assigned to the selected trace used for this calculation.
· The next line indicates the difference between the phase angles of the live trace and the selected trace. (Displayed only if a transfer function measurement is performed and the live trace is not selected as the selected trace). See page 178 for more details about the calculation of this value.
· Finally the delay between the selected trace and the live trace calculated using the difference of the phase angles and the frequency of the cursors current position is shown. Which is displayed only if a transfer function measurement is performed and the live trace is not selected as the selected trace. See page 178 for more details about the calculation of this value.

[bookmark: __RefHeading__22283_209662181]Calculation of the Phase Values
Due to the cyclic nature of the phase, it's range is limited to a range of 360°.
The phase trace might be shifted by some full cycles, so the phase value might not be the value shown, but in the range between + 360° or +720° and so on. The pure phase value does not contain an information which would enable us to calculate which cycle we're looking at.
The only way to get the 'real' phase is to look on the slope of the phase-trace. This slope contains the so called group-delay, which indicates the delay of a certain frequency.
SATlive uses this slope to estimate the 'true' value of the phase. Furthermore you can use the group-delay to check if a polarity-inversion is present at this frequency.
The cursor-information area (see page 177) in the right menu-area uses this information.
[image: ]You can use the setting 'Time using unwrapped phase' in the Setup → Post Process window (see page 208) to select which value to show.
[bookmark: __RefHeading___Toc41398_2823577171]Display when the entry Time using unwrapped phase is checked
· Both phase values are shown as estimated 'true' values. In this case values above 180° and below -180° are possible. If SATlive detects a constant phase-shift, then INV is shown right to the phase value.
· If a constant phase shift is detected for one (and only one) of the two traces, then the value for the difference of the phase values is reduced by 180° to remove the effect of the constant phase shift, which is indicated by the string INV right to the value. The difference in time is also adjusted. In this case you need to apply the time-value and you need to invert the polarity of one of the two signals checked.
[bookmark: __RefHeading___Toc41400_2823577171]Display when the entry Time using unwrapped phase is not checked
· Both phase values are clipped to the range from -180° to +180°. If SATlive detects a constant phase – shift, then INV is shown right to the phase value.
· The value of the difference in phase and the value of the difference in time calculated from this difference phase will not be corrected.

[bookmark: __RefHeading___Toc41402_2823577171][bookmark: hs1750][image: ]Bottom Menu Bar MAT
The bottom menu bar is located at the lower right area. It is available in the MAT Module. Not all options are available for all kind of measurements.
· [image: ]Range open the sub menu Range. See page 91 for details.
· [image: ]Cursor on Peak moves the cursor to the peak of the live trace. This action unlocks the Lock on Peak setting.
· [image: ]Lock on Peak if this option is activated then the cursor is moved to the live trace's peak each time the live trace is drawn. To unlock the cursor you can either click on this button again or you can perform another cursor related action like:
· Click on the trace's display to set the cursor.
· Move the cursor using your keyboard.
· Invoke the cursor on peak action.
· [bookmark: weightingFilterMAT][image: ]Weighting Filter opens a sub menu, where you can choose a weighting filter for the mic input. See the weighting filter section on page 103 of this document for further details.

[bookmark: __RefHeading__23276_1148411210]Setup
[bookmark: __RefHeading__22409_1358155583][bookmark: hs1800]Setup → I/O devices
The setup I/O devices contains different areas.
[bookmark: __RefHeading___Toc41404_2823577171][bookmark: Ref_audioMode]Audio-mode selection
[image: ]Select the kind of audio driver you want to use from the selection in the upper area.
·  Windows wave driver this are the generic drivers supplied by windows® OS for the access to the audio hardware. See page 182 for details.
·  Directsound driver this are windows directsound® drivers for the audio I/0. Directsound® is part of DirectX®. See page 183 for details.
· [image: ]ASIO driver: Use the ASIO interface to access audio device.
If you select the ASIO driver you have to select the device you want to use before entering the setup. See page 184 for details. In the ASIO mode you can use the Direct-Reference Tool (see page 320).

Hints:
· To edit the audio I/O parameters click on the button Edit Settings.
· Use the  SAVE button in top menu bar to store your selection.
· ASIO is a trademark and software of Steinberg Media Technologies GmbH.
· Because SATlive can only check drivers and not devices, an ASIO device might appear in the list even if it is currently not connected. The selection of a device that is not present will result in empty fields in the ASIO setup or in an error message.
· Use the shortcut Ctrl + Alt + D to show information about the current driver.

[bookmark: __RefHeading___Toc41406_2823577171][bookmark: fbsampling]Audio debug section
· [image: ]Number of Buffers to ignore the MLS measurement used in the impulse – response measurement needs some time to reach a  stable state. Therefore at least one MLS – sequence needs to be played prior to the measurement. In some cases one sequence might be not enough, in this case you can increase this value if needed.
· Settling time when SATlive starts pink noise or white noise a fade-in of 500ms is performed. This time must also be excluded from the measurement to get stable results. Some drivers need more time to establish a stable audio performance.
· Flip Driver Start flip the start sequence of the audio I/O drivers. This might help some drivers to shorten their settling time.
· Input routing assign the physical inputs to the reference (REF) and measurement (MIC) function. With an ASIO driver use the settings of the ConnectionManager, described on page 187, to assign a certain input to a function.
· Flip Meter's Assign flips the position of the VU – meter's bars, so that the left meter shows the measurement (MIC) level and the right meter shows the reference (REF) level. This is independent from the physical routing which is set using the input routing selection.
· Enable / Disable Driver select the driver types you want to use. See page 354 for details.

[bookmark: __RefHeading___Toc41408_2823577171][bookmark: hs1805][bookmark: Ref_audioWave]Wave I/O setup
[image: ]The setup is divided into two sections, which contain the same settings, the upper one for the audio input and the lower one for the audio output.
At the bottom there is the samplerate selection. This is a global setting.
· Soundcard select the soundcard you want to use for this function. It is possible to use different soundcards for input and for output.
· 16Bit – 24Bit – 32 Bit resolution of one sample, indicates how exact the analog signal is converted into digital signal.
· Use extended format use the new type of microsofts®'s wave format description for the access to the input driver. You might need to activate this setting to be able to select higher resolution values.
· Latency (ms) specify the size of the data blocks used for transferring the audio data from and to the soundcard. Lower values mean faster response but the data are more likely to be affected by performance issues.
Hints:
· After every change of the settings SATlive rebuilds the list of supported samplerates. This may take same seconds.
· To get the best quality use the highest samplerate available.
· Different settings may produce different output levels. So please be very careful with the volume setting when changing any settings.
· In the extended format windows expands audio data to the selected resolution, even if the hardware does not support that resolution. A selection of a resolution not supported by the hardware creates more data and processor load then necessary.
· The Apply button saves the current settings of the wave I/O and closes the window, but does not select Wave I/O as the current audio driver. The input driver selection must be confirmed using the Save button in the top menu bar.

[bookmark: __RefHeading___Toc41410_2823577171][bookmark: hs1807][bookmark: Ref_audioDirect]Directsound(R) I/O setup
This setup is divided into two sections, which contain the same settings, the upper one for the audio input and the lower one for the audio output.
At the bottom there is the samplerate selection. This is a global setting.
· [image: ]Soundcard selection select the soundcard you want to use for this function. It is possible to use different soundcards for input and for output.
· 16Bit / 24Bit / 32 Bit resolution of one sample, describes how precise the analog signal is converted.
· Use extended format use new type of the wave-format description.
· Latency (ms) specify the size of the data blocks used for transferring audio data from and to the soundcard. A lower value means faster response but the data is more likely affected by performance issues. You should not change the default value of unless you're facing audio I/O related problems.
Hints:
· After every change of the settings SATlive rebuilds the list of supported samplerates. This may take same seconds.
· To get the best quality you should use the highest samplerate available.
· Different settings may produce different output levels. So please be very careful with volume setting when changing any settings.
· If the extended format is used, then windows expands the audio data to the selected resolution. Therefore selection of a resolution not supported by the hardware just creates more data and processor load as necessary.
· The Apply button saves the current settings of the directSound I/O and closes the window, but does not select the directsound driver as the current audio driver. The audio-driver selection must be confirmed using the Save button in top menu bar.

[bookmark: __RefHeading___Toc33612_536823330]Asio I/O setup
[image: ][image: ]To open the ASIO setup window, in the Setup → I/O Devices section select ASIO in the driver-selection area and then click on the Edit ASIO Settings button.
The header shows the name of the currently selected ASIO device.
ASIO drivers are designed for high performance audio handling, so we suggest that you use the ASIO driver – type.

You can find the parameters common to all connections on the left side of the window.
· [image: ]ConnectionManager Delay Mode choose how the ConnectionManager will modify the current delay when you select another connection.
See page 190 for a closer description of this setting.

· [image: ]Audio Out Mode select how the ConnectionManager will route the output channel(s). The selection contains the following items:
· Single Output the output signal is routed to only one output of the I/O interface. You can select the output channel for every routing in the ConnectionManager. You can access any output of the I/O interface using this setting.
· Dual Channel Output the output signal is routed to a stereo pair of output channels, like AnalogOut1 and AnalogOut2. As suggested in the ASIO specification, you can only select output pairs, so not all outputs will be listed in the ConnectionManager setup. The list contains the name of the first output of the stereo pair, in the example above this would be AnalogOut1.
· Fixed Reference Channel this option combines the global selection of one output with the individual selection of another output. This enables you to use your I/O device as an output switcher to select different speakers using ConnectionManager without the need to think about how to route the reference signal. You can select the fixed reference output in the global ASIO I/O setting on the lower left.
· Reference Output select the output channel which SATlive uses if fixed reference channel is selected for the current Audio-Out Mode.
· Samplerate amount of samples per second taken from the audio input signal. For best results use the highest possible value. This setting might interact with samplerate setting in the device's ASIO setup.
· Clock Source if more than one clock source is available for your ASIO device, you might change it here. Change this setting only if you want to force the use of a special clock source.
· Driver open a driver specific setup menu, which is supplied by the manufacturer of the ASIO device. This might give you access to latency and buffer settings.
· On the right area of the ASIO setup window you can edit the connections.

Hints:
· To get the best quality use the highest samplerate available.
· ASIO does not support the use of different audio devices for the input and the output.
· Different settings may produce different levels. So please be very careful with volume setting when changing any settings.
· In order to show only ASIO devices which are currently available, SATlive tries to open the ASIO drivers before it puts it on the list. Therefore it might take a few seconds until the driver list is completed.
· [image: ]The Apply button saves the current settings of the ASIO I/O and closes the setup window, but does not select the ASIO driver as the current audio driver. The input driver selection must be confirmed using the Save button in the top menu bar.
[image: ]

[bookmark: __RefHeading__21449_1132721720]ConnectionManager
· [image: ]The ConnectionManager enables you to define different input/output routing for the selected ASIO device. You can create, edit and delete the routing in the ConnectionManager window.
· To show this window, go to the ASIO section in the Setup → I/O Devices section.
· The ConnectionManager is able to manage the delay in the MAT module.
· You can recall a routing in several ways.
[bookmark: __RefHeading___Toc25826_1347193971]Add, delete and modify the routing.
· Edit modify an existing preset. Select the preset to edit from the list before you click on the edit button.
· New open a window to set the routing and name for this preset.
· Delete removes the selected preset.
· [bookmark: AsioAssignRoutingSetup]The routing Default is recalled every time SATlive starts, or when you leave the Setup → I/O Devices window, therefore you cannot delete it.

[bookmark: __RefHeading___Toc41412_2823577171]Edit a routing
· [image: ]Name edit the name of the routing preset.
· Audio Input REF select the input used for the reference (REF) signal.
· Audio Input Mea select the input used for the measurement (MIC) signal.
· Latency use this value to compensate a latency related to this routing, like when using a digital wireless system for the measurement microphone.
· [image: ]Polarity Ф
use this button to invert the polarity of the measured signal. You can use this setting to compensate different polarities while using different measurement mics. A red background of the button indicates inverted polarity.
· [image: ]Mic correction allows you to choose different mic – correction data (see page 107) for each routing.
The buttons will show up when you move the mouse over the area, which by default shows the filename of the correction data currently assigned.
· Load will open the file – selection window where you can choose the calibration data file.
· Clear will remove the calibration data for this routing.
· Audio Output select the output used for the signal generator. The contents of this selection varies according to the selected mode of the audio output.
· If you’ve performed all settings, you save it using the OK button.
Use the button Cancel to discard your changes.
Hint:
· In order to use the direct – reference feature described on page 330, select the entry DIRECT – REFERENCE in the Audio Input Ref selection.

[bookmark: __RefHeading__29091_1819804763][bookmark: hs1960]Select a Connection
You can select a connection, which enables you to use an ASIO device as an Input selector and an Output selector.
So you can quickly change the audio inputs and outputs that SATlive will use.
There are two ways to select a connection:
· [image: ]Use one of the buttons in the signal – generator window. These buttons recall the connection assigned to them using the Assign buttons for ConnectionManager function located in the popup menu of the signal-generator area. Moving the cursor over a button shows the name of the connection assigned to this button.
· Use the [image: ] ConnectionManager entry in the popup menu of the signal-generator (see page 224) area to open the ConnectionManager.
· [image: ]In the upper half of the window contains details of the current connection.
· Use the selection box in the middle of the window to select the connection you want to activate.
· The details of the connection selected will show in the lower half of the window. This area also shows the delay time and the latency and the mic – correction file selected for this routing.
· Use the button OK to activate the selected routing and to close the window.
· The button Cancel closes the window and discards the changes.

Hint
· The ConnectionManager window is available only if more than one connection is defined for the current I/O device.

[bookmark: __RefHeading__23847_1132721720][bookmark: hs1970]Manage the delay-time in the ConnectionManager
· [image: ]The ConnectionManager can not only manage the routing of inputs and outputs, but it is also capable of managing the delay used in the MAT module.
· At the top left half of the ASIO Setup area you can select how the ConnectionManager will manage the delay when you select a different routing.
· The selection contains three items:
· [image: ]Ask Before Changing Delay when you change the routing, a message box shows up where you can select if you want to change the delay (YES) or not (NO). The header of the message box contains the name of the routing whose delay will be recalled.
· Always Apply Delay the delay assigned to the selected routing is set as the current delay.
· Do Not Apply Delay the current delay is not affected when you select another routing.
Hints:
· [image: ]The current delay is assigned to the current routing when you close the program or when you select an other connection.
· The delay assigned to a routing is shown in the selection of the routing to use.
· If you intend to manage only delays and no I/O routing, you should prefer using the delay presets in the lower menu area.
· The ConnectionManager will work only if you use an ASIO driver for the I/O device. If another kind of driver is selected, then you can use the time – markers (see page306) in order to manage up to ten delay – time settings.

[bookmark: __RefHeading___Toc26576_309896246][bookmark: hs1810]Setup → User Macros
[image: ]In the impulse – response module SATlive features a powerful macro system, which enables you to perform a complete measurement sequence (measurement, windowing, FFT) with just one click. There are twelve macros available, which are fully editable.
In order to edit a macro, you first need to select the macro to edit from the list on the right. Now the selected macro shows up, and you can edit it's properties.

· Name of Macro edit the macro's name.
· Short Name (Button) this label shows on the User Macro button where the last executed macro is assigned to the User Macro button.
· Impulse response select the measurement to create the impulse response. Click on Edit to edit the measurement properties. The current settings are shown below the selection box.
· Window set the parameter for the windowing of the impulse – response (see page 36) prior to the calculation of the FFT. Click on the EDIT button to access the settings for the windowing function. See page 37 for details about this window.
· FFT set the size and the type for the FFT (or Smooth FFT) to be applied to the windowed impulse response.
· Phase compensation Select the kind of phase compensation applied to the phase trace. See page 115 for details about phase compensation.
· Calibration click on the button [image: ] to assign a calibration file to the macro. Check the USE option to apply it to the frequency response.
· Mic Data click on the button [image: ]to assign a mic correction file. Check the USE option to apply the correction to the frequency response. The Mic Data setting is enabled if a Smooth FFT or a Smooth Full FFT is selected.
· [image: ]Repeating Measurement repeat the measurement until it is stopped by the user using the Stop/Again function in the FFT module. This setting is useful for setting up electronic gear, where the frequency response can be watched in 'realtime' using this setting.
· Keep Window the macro will not change the absolute position of the time window.

[bookmark: __RefHeading__30726_40126426][bookmark: hs1820][image: ]Setup → Display
This setup allows you to customize the look of SATlive according to your preferences.
The description of the setup's parameters is divided into some topics.
· A Preview: this area displays all changes immediately, but you still need to save your changes.
· B Preset Select: Select the preset you want to edit in the Choose Preset to Edit area on the upper left. Select the preset to use after you leave this setup in the Choose Preset to Use section on the right.
· C Color Assignment: use this area to set the colors used to draw certain items. See page 194 for details.
· D Font Size: in this area you can select the font size for different labels. See page 197 for details.
· E Options edit some options and the global transparency value here. See page 197 for details.
· F Cursor: customize the layout of the intersection between the cursor and the selected trace. Find more details about this section on page 199.
· G Reset: use the Reset Menu Bar button to rearrange the position of all menu bars. You can use this option to find lost menu bars. The Load Default Setting function resets the preset currently selected for editing, to the default values.
· H Menu – Layout: Customize the appearance of the menu areas. See page 198 for more information.

Hint: 
· [image: ]The changes displayed in the preview window will get lost if you do not exit using the SAVE button in the top menu bar.

[bookmark: __RefHeading__27610_1819804763][bookmark: hs1822]Assign Colors
The Color Assignment are can be found in Setup → Display.
· [image: ]In order to change the color of an item, first select the item from the list.
· After the selection of the item it's current color is shown in a small color area right to the selection box. You can invoke the color dialog by either by clicking on this color area, or by clicking on the button Change.
· [image: ]Now you can set the new color for the selected item. To apply the new color, close the color selection dialog with the OK button. The new color is immediately shown in the preview area at the top of the setup window.
· [bookmark: setupDisplayUserConfig][image: ]At the bottom of the color selection area there is the Full User Configurable Layout. The activation of this option enables you to edit the color of the items listed below. Otherwise the color of the items is set according to the current settings in the windows and the items are not listed in the item selection box.
· Window Background color used for the areas outside of the trace display.
· [image: ]Windows Font color used for strings and labels on the area outside of the trace display.
· Selection Background color used for the background of selections and of the edit fields.
· Selection Font color used for the strings shown in the selections and in the edit fields.

[bookmark: __RefHeading___Toc41414_2823577171]Items with configurable colors
· Background color of the background of the trace display area.
· Zone below AMP-Threshold (MAT-FFT) in the MAT Module the current Amplitude threshold is marked by this color in the background. See page 162 for details. 
· Amplitude the result of the current measurement. In the MAT → FFT this color is used to draw the trace related to the MIC input. This is used for the transparent overlay in the cursor – range tool (page 96) as well.
· Grid color used to draw the grid lines in the display background.
· Pink Noise Guide Lines used to draw the grid which falls with -3dB/octave. This grid is shown when the option Pink Spectrum Lines (located on the right in the Setup → Display section) is selected.
· Labels used for labeling the grid.
· Phase used for drawing the phase trace of the current measurement.
· Reference Signal used to draw the reference's input signal in the MAT-FFT.
· F5 Trace Amplitude used to draw the amplitude of the memory trace, which is assigned using the key F5. In the IR Module this color is used to draw the second impulse response's trace.
· F5 Trace Phase used to draw the phase of the memory trace, which is assigned using the key F5.
· Coherence used to draw the coherence values in the transfer function display in the MAT Module.
· Quick Trace 1..8 used to draw the Quick – traces 1 to 8. See page 270 for details.
· Sum Trace used to draw the Sum Trace
· Live – Add Trace used to draw the Live – Add Trace in the MAT transfer – function measurement.

· Perfect Addition Trace used to draw the Perfect – Addition Trace in the MAT transfer – function measurement.
· FFT Peak Trace used to draw the FFT Peak – Trace.
· Virtual EQ Trace this color is used to draw the response of the virtual Equalizer.
· Dots for invalid Amplitude Values used to show the amplitude values of the result of the last single measurement in the transfer function measurement.
· Dots for invalid Phase Values used to show the phase values of the result of the last single measurement in the transfer function measurement.
· Cursor used to draw the cursor.
· Cursor Information used to show the information text next to the cursor's intersection with the selected trace.
· Background for Cursor Information color used to fill the background area of the cursor-information text. Used only if the Transparent Label setting is not enabled for the cursor.
· Horizontal Cursor Grid used for the horizontal line(s) used to mark the range selected by the Show Range at Cursor setting.
· Latched Cursor used to draw the latched cursor.
· Target Trace used to draw the Target Trace.
· Range of Tolerance used to draw the range of tolerance assigned to the current Target Trace. Currently the range of tolerance is supported only for the X-Curve.
The items below are available only if the option Full User Configurable Layout is checked. Otherwise the computer's default settings are used for these items:
· Window Background used to draw the background of the areas outside of the trace display.
· Window Font used for labels outside of the trace display.
· Selection Background used to draw the background of selection fields and edit fields.
· Selection Font used to draw the strings in selection fields and edit fields.

Hint: You can use the Trace-Layout window to configure the display of each trace. See page 302 for details about the Trace-Layout tool.

[bookmark: __RefHeading__28098_1819804763][bookmark: hs1824]Font Size and Transparency
[image: ]The Font Size area is located in the display setup window.
You can edit the size of some fonts here.
· Labels size of the labels used for the trace display.
· File Names size of the font used to show information inside the trace display.
· Cursor set the size of the font used to show information at the Cursor's intersection with the selected trace.
· Transparency set the transparency used to fill the area between the trace and the center when you enable the Fill to Center option in the Trace-Layout window. See page 301 for details.
[bookmark: __RefHeading__28100_1819804763][bookmark: hs1826]Setup Display Options
[image: ]This area, which is located in the display setup window, contains three areas where you can set different options related to the display.
[bookmark: __RefHeading___Toc41416_2823577171]Options
· Pink Spectrum Lines shows grid lines falling with 3dB per octave in the FFT measurement. This is the same slope as the slope of pink noise. These lines might be helpful when you use the FFT as an RTA with pink noise signals.
· No horizontal Grid this setting is available only if the option Pink Spectrum lines is selected. It hides the horizontal lines, so that only the pink grid lines are displayed.
· I. S. O. Frequency Grid draw the vertical lines at the center frequencies of the RTA bands. Otherwise the lines are drawn at the borders between the RTA bands.

[bookmark: __RefHeading___Toc41418_2823577171]Transparent Labels
[image: ]select transparency of the label's background. 
[image: ]A transparent label does not cover the grid and the traces.
[image: ]A solid label improves the readability.
· Labels activate the transparent background for the labels and file names in the trace display.
· Cursor activate the transparent background for the label at the cursor's intersection with the selected trace.
[bookmark: __RefHeading___Toc41420_2823577171]Scale Quick – Trace Buttons
Use this setting to scale the eight buttons for the quick – traces (see page 270). At the leftmost position the buttons will show in the same size as the other buttons, while moving the slider to the right will increase their size.
[bookmark: __RefHeading__24017_1843524668]Menu Layout
[image: ]SATlive offers two different layouts for the menu bars, which you can select in the setup → display window.
· [image: ]Simple (live) is designed for the fast work on the road. Buttons are large, but there are not many functions directly assigned to them. A lot of functions can be found in the menu Tools.
· [image: ]Complex (lab) is designed for 'relaxed' working. A lot of functions can be accessed directly using smaller buttons.
By default you can move the menu bars in the menu areas or to other menu areas. 
You can fix the position of the menu bars using the option Lock Menu Positions in the main Setup menu. See page 218 for details.

[bookmark: __RefHeading__28102_1819804763][bookmark: hs1828]Layout of the cursor's intersection with the selected trace
[image: ]In this section you can configure the layout of the cursor.
· Size of Circle set the diameter of the circle drawn at the intersection of the cursor with the selected trace. To hide the circle set this value to zero.
· No label on cursor no information is shown on the intersection of the cursor and the selected trace.
Hints:
· You can set the color of the cursor in the color area in the Display Setup.
· You can change the font size of the label shown at the cursor's intersection with the selected trace, which is also located in the Display Setup.
· Set the transparency of the background of the label at the cursor's intersection with the selected trace in the area options in the Display Setup.

[bookmark: __RefHeading__26598_7977939][bookmark: hs1830]Setup → Measurement
· [image: ]MAT Display Repeat Rate set the minimum time between two redraws of the display in the MAT module. Lowering this value will refresh the display faster but will also increase the processor load.
· Calculation FFT and Spectro set the minimum time between two calculations in the FFT and the Spectrograph display of the MAT module.
· Peak Localization Using Inverse Pink Filter (MAT + FFT) use this option to remove the influence of the pink filter for the location of the peak – position. This adds a +3dB/Octave filter to the peak-detection routine. Use this option to compensate the Flat with Pink Noise setting of the Compensate FFT entry.
· Delay Finder prior to Transfer Measurement the delay-finder starts every time you invoke the transfer function measurement. See page 135 for details about the delay-finder.
· Activate 'Amplitude only' when Selecting RMS Averaging this option defines how SATlive reacts when you select the averaging mode RMS Averaging in the MAT module's transfer function measurement. If this option is active, then the display switches to the full amplitude display when you select RMS Averaging in the layout area.

· Restart Measurement on Selection this option defines whether or not the selection of a different measurement in the MAT module will restart a previous stopped measurement. If this option is activated then the selection of an other measurement restarts the measurement, independent from its former status.
· Transfer – function fast refresh activate this setting to speed up the display of the transfer – function at lower frequencies. It will reduce the amount of new audio samples used for each calculation which will result in a lower effect of averaging.
· Reference resistor edit the value of the reference resistor used for the impedance measurement. See page 128 for further information about how to measure impedance in SATlive.
· Compensate FFT select a correction that will be applied to the FFT display.
· Flat on white noise shows the unchanged result.
· Flat on pink noise adds a 3dB/octave high-pass filter, so that the live trace acts like a narrow band RTA. Consider using the Peak Localization Using Inverse Pink Filter (MAT + FFT) setting when you want to use the peak – location tools (see page 118).
· Sawtooth on pink noise is for compatibility with another measurement software.
· Start Measurement on Selection (Live Mode) in the simple menu layout a measurement in the impulse – response module will start immediately after you select it. Otherwise you have to start the measurement after the selection.
· Measurement location's weighting set the weighting used for the traces for the averaging in the tracemanager. See the tracemanager section at the page 235 of this document for further details.
· Weighting affects color use this entry to define which colors should be used to draw the traces of the tracemanager (see page 235). If this option is selected then one of the colors defined in the Measurement location’s weighting setting is used according to the weighting assigned to the trace.
Otherwise the trace will draw using its own color.
· Noise Threshold enables the display of the Noise Threshold (see page 163) button in the menu bar right to the display area (see page 156).

· [image: ]Auto – Delay Mode set the calculation for the calculation of the auto – delay. See page 144 for further details.
· This selection contains the entries listed below:
· Auto – Delay Off this setting disables the Auto – Delay Mode. This setting will reduce the CPU load.
· Auto – Delay Quick uses a short impulse – response with a high repeat – rate. This setting reacts quickly to delay changes, but due to the short impulse – response it might fail in critical situations, like rooms with a high reverberation time.
· Auto – Delay Default this setting, as used in the versions below 1.60.20, features a good detection of the delay – time and a repeat – rate which is sufficient for normal use.
· Auto – Delay Slow this setting features the longest impulse – response, which yields the best result but has a significant lower repeat rate than the other settings.
Hint: 
Please note that the maximum amount of delay that the Auto – Delay can locate depends on the Auto – Delay mode selected.
The default setting will work fine up to a delay value of approx 200ms, which should be sufficient for most of the applications.

[bookmark: __RefHeading__27703_2018938027][bookmark: hs1840]Setup → Features
[image: ]You can set a lot of options in this area.
To cover all the options, this setting is explained in four sections on the following pages:
· Warnings, Display, Units:	 	Page 204.
· Global Settings: 				Page 205
· File – Info and Update: 			Page 206
· Other options: 				Page 207

[bookmark: __RefHeading__22356_1819804763][bookmark: hs1850]Setup → Features, Section Warnings and Units
[image: ]Use the warnings section to define SATlive's reaction when a problem occurs.
· Cal File Misfit inform me, if the calibration file cannot be applied to the current data (not the same samplerate or fft size).
· Overwrite Prompt prompts for confirmation if I try to overwrite an existing file.
· Calfile differences inform me if the parameters for the calibration data are not the same as for the current trace, but the main parameters fit, so the calibration could be used but might give wrong results.

The Display section contains only one option.
· Static gap disables the automatic setting of the gap between two vertical grids.

In the Units section select the display units for distance and temperature.
· ISO ISO units will be used (Meter and degree centigrade).
· USA US units will be used (feet and degree Fahrenheit).

[bookmark: __RefHeading__23494_490587637][bookmark: hs1860]Setup → Features Global Settings
· [image: ]Quick delay finder link the impulse – response module Set Cursor On Peak function with the Latch Cursor function at the first execution and with the Show difference function on all the following executions of the Set Cursor On Peak function.
· Automatic averages reset reset the amount of averages to perform in the impulse – response module to one after a measurement has been performed.
· Auto Linegap readjust the grid line's gap in the FFT and MAT module's display when other parameters change. This option is also located at the Line Gap setting's popup menu.
· Show System Menu bar show the window header, allowing you to move and re-size the main window of SATlive. Otherwise the main window of SATlive runs in full screen mode and might cover the task bar.
· Fit FFT scale to trace execute the Full Trace Display function every time new data is displayed in the FFT display.
· Always show 0dB line always display the zero dB line if it is in the displayed range.
· [image: ]Show MLS Info display information about the peak's position in the current impulse response in the FFT display.
· Block Screensaver checking this option will block the start of the screensaver as long as SATlive is running.

[bookmark: __RefHeading__23496_490587637][bookmark: hs1870]Setup → Features Section File – Info and Updates
In the upper area you can select the kind of information that SATlive displays about the active overlay, calibration or mic – correction data.
· [image: ]Path and Filename the whole path including filename is shown. For example: C:\SATMessung\Musikvereinsaal\Front of stage left.sld.
· Filename only the filename is shown without its path. For example: Front of stage left.sld
· Remarks the file's description is shown. For example: Nine feet left of sidefill, on ear level.
· Show Name in Tracedisplay if a filename is assigned to the live trace, then it will be displayed in the trace display window.
· Show Fileinfo when saving open the file's description window prior to saving the trace. This allows you to edit trace's description before saving it to a file.

[image: ]Use the selection When to search for updates? In the Search for Updates area at the lower area to select the interval for the automated update – check. See page (357) for details about the update function of SATlive.
When the interval is reached, then SATlive checks for the availability of a new version on start up. It repeats this check during each start – up until it succeeded in checking the version. It resets the interval when it was able to complete the update – check.

Hint:
· You can edit the font size of the information's display in the Setup → Display window. See page 197 for details.

[bookmark: __RefHeading__21089_1402859807][bookmark: hs1880][image: ]Setup → Features ASCII, Jpeg Quality, Temperature, Language
· Temperature set the temperature value used to convert the delay time into distance and for the wavelength calculation.
· ASCII Save settings add an offset if a trace is saved as an ASCII file. You can edit the amount of offset to add. Activate the offset by checking the Apply User Offset option.
· Quality of JEPG conversation set the quality of the conversation used for the  Save trace as picture option. The maximum value is 100%. The higher the value, the better the quality of the picture will be. Increasing the quality also increases the size of the picture file.
1. Language file select a language file for SATlive. See page 20 for details.
· [image: ]Start of Program select the module which is invoked at the start of SATlive and every time you leave the setup section. 
· The setting Start with Logo does not invoke any module at start.
· Start Using DualFFT (MAT) the MAT module will start and the last measurement selected will show up.
· Start in IR Mode invokes the IR Module on startup.
· Measurement used on exit starts with the last used measurement.
· Enable other measurements if a module is selected at the Start of Program section, then you can disable the other modules by disabling this option.

[bookmark: __RefHeading__20269_195163762][bookmark: hs1890]Setup → Post Process
You can configure some options for the handling of Quick – traces (see page 270, the settings for the interaction – area tool and the frequency ranges for the range menu in this setup window.
[bookmark: __RefHeading___Toc41422_2823577171]The upper area
· [image: ]THD+N max Order set the highest order of harmonics used for the calculation of THD+N in MAT module's FFT measurement. The THD-N can only use frequencies below the Nyquist's frequency. See page 122 for details about THD measurement.
· Time Using Unwrapped phase show the calculated unwrapped phase values in the cursor detail window in the right menu bar. Otherwise the phase value will range from -180° to +180°. See page 177 for details.

[bookmark: __RefHeading___Toc41424_2823577171]The lower – right area
[bookmark: __RefHeading___Toc41426_2823577171]Settings for the Quick – trace
The Quick – trace section contains three settings for the Quick – trace display. See page 270 for further details about Quick – traces.
· [image: ]If the Show Edit Name Window on Assignment entry is selected, then the Rename function is called each time you assign a trace. Otherwise a default name is assigned to the trace, which you can edit in the popup menu later.
· Global Setting for Show Coherence of Quick Traces. If this option is selected then you can control the visibility of the coherence traces of the Quick – traces using the entry Show single Trace's coherence in the menu Quick – Trace → Global Settings (see page 273). Otherwise you can activate the visibility of the coherence for each particular trace in its popup menu.
· [image: ]Append delay-info to label if this option is selected then the delay used to create the particular Quick – trace is shown after its name. See page 270 for details about Quick –  traces.
[bookmark: __RefHeading___Toc41428_2823577171]Display of Transfer Function
· [image: ][image: ]Select Show Phase Wraps if you want SATlive to draw a vertical connection when the phase wraps.

[bookmark: __RefHeading___Toc28576_3840277593]Area of Interaction Setup
[image: ]Use this section to set the threshold values for the three ranges of difference in level used by the interaction – area visualization tool. See page 295 for details.
You can change the transparency of the color – overlay using the Opacity of Visualization setting.
[bookmark: __RefHeading___Toc41430_2823577171][image: ]Frequency – Range Definitions
· You can change the frequency ranges for the different range menu options.
· The user display range can have different values for the use in the MAT module and for the use in the FFT module.
· You can assign the current display range to the user display range using the Assign current Range function in the display-range menu in the FFT module or in the MAT module. See page 91 for details on the display-range menu.

[bookmark: __RefHeading___Toc41432_2823577171]Setup → Advanced Sampling
This setup can be accessed via the extended setup window only.
Use the shortcut Ctrl + Alt + S to open the extended setup window.
[bookmark: __RefHeading___Toc41434_2823577171]Time Synchronization
The settings affects the impulse-response module only. If you want to average some impulse response measurements for a better result, then it is very important that the measurements are exactly aligned in time. Even a very small difference in the peak's position will destruct the result, creating comb-filter (see page 320 for details of comb – filters) like results.
The Time Synchronization feature helps you to keep your measured impulse responses in perfectly synchronized.
SATlive will remember the peak's position of the previous measurement, and compares it to the current measurement peak's location.
If the positions match, then the averaging is performed.
Otherwise the procedure depends on the settings in the Advanced Sampling window.
· If the Ignore sample option is selected, then the current measurement is discarded.
· If the correct position option is selected, then the current measurement is shifted in time to align the peak's positions. This is done only if the offset between both peaks is smaller then the max readjust range value. If the offset is larger then the max readjust range then the current measurement is discarded.
· This function assumes that the first measurement is perfectly time aligned. To deal with that problem, you can enable the ReSync option.
If ReSync is enabled, then SATlive discards the first measurement if the same offset occurs for given times, set by the Number of Offsets setting.

· [image: ]On Sync Error do select how SATlive reacts, if the current measurement's peak position is not the same as prior measurement's peak position. 
· Ignore Sample discards the current measurement. 
· Correct Position shifts the current measurement in time, if the distance of the two peak positions is less or equal to value of the Max Readjust Range. Otherwise the current measurement is discarded.
· Time Range Optimization enable the checking of the peak's position during averaged measurements in the impulse - response module.
· Max Readjust Range set the maximum offset accepted for the Correct Position option of the On Sync Error Do setting.
· ReSync the Time Range Optimization checks for the synchronization compares the peak's position in the current trace to the peak's position in prior trace(s), assuming that the first measurement has a correct timing. If the Resync option is enabled and the same offset is detected for the selected times, then the new peak's position is taken as new reference and all the prior measurements are discarded.
· [image: ]Offset in time correct a time offset between the left and right input channel. Use this setting, if the peak of an impulse - response measurement is not at zero time when the output is linked to the input directly (cable measurement).
· No Overlapping Samples wait for all new data after completing a calculation. Otherwise a new calculation is started immediately.

[bookmark: __RefHeading___Toc29258_566584337][bookmark: hs1940]Setup → Internal Configuration
[image: ]This setup can be accessed via the extended setup window only.
Use the shortcut Ctrl + Alt + S to open the extended setup window.
· Priority changes the priority of the different tasks in SATlive. Windows assigns processor calculation power and time depending on priority. Changing these settings will influence the performance of your computer. Be careful when changing these settings. You must restart SATlive to activate the changed priority settings.
· Version Information about current versions on your PC.
· Version detailed file version of SATlive.
· Username SAT the name of the registered user of MLS module. Dongle indicates that a valid dongle was found.
· Username MAT the name of the registered user of MAT module. Dongle indicates that a valid dongle was found.
· DirectX shows the current version of DirectX® installed on your computer.
· Win operating system's description.
· Folder on the bottom you can see the path to the folder where the current settings will be stored. To explore the folder, just click on the path.
Hints:
· You can use the shortcut Ctrl + Alt + F browse the folder containing the current settings without the need to open this setup window.
· You can use the shortcut Ctrl + Alt + U to show the user information window without the need to enter this setup window.
· You can use the shortcut Ctrl + Alt + V to show a version information window without the need to enter this setup window.

[bookmark: __RefHeading___Toc26181_1443750138]Setup Net – Control
[image: ]You can use this setup widow to configure the IP settings used for the web – server embedded in SATlive. This web – server, described in this document starting on page 333, allows you to control and to monitor SATlive’s measurements in the MAT module.
[image: ]






On the top of the window SATlive lists the ip – addresses available on your computer.
To enable the net – control you must activate at least one of these addresses.
On the left bottom you can select the port used for the net – control. Use this setting to select an other port than the default HTML port 80 when needed.
Click on Apply to start the net – control using the selected parameters.
[image: ]A warning will show up after pressing Apply when the selected port is not available. In this case SATlive will reopen the setup window. 
To disable the web – control, just deselect all
ip – addresses shown.


Hints:
· Your browser will default to port 80. If you’re using a different port then you’ll need to append a colon followed by the port number to the ip – address in your browser (like 123.123.0.1:81) to direct your browser to the correct port.
· [image: ]The ip address(es) used will show at the lower right of the main window (below the signal – generator window). To invoke the ip – setup click on this display area.

[bookmark: __RefHeading__23278_1148411210]Clock Settings
[bookmark: __RefHeading___Toc41436_2823577171]Clock Mode:
· [image: ]System time only shows only the system's time (PC’s clock)
· Count Down start a countdown to the time set at Count Down Time. If the target time is reached, the mode is changed to count up from now with the target time as reference time.
· Count up from now set the time display to zero when you close the window, and starts counting up.
· No clock display hides the whole clock display.
[bookmark: __RefHeading___Toc41438_2823577171]Countdown Time
· Time set the countdown target time (count down mode) or the count up reference time (count up mode).
· Now assign the current time to the target time display.
[bookmark: __RefHeading___Toc41440_2823577171]On count down 0:00 do
· Play Sound if the target time is reached in the count down mode then a sound file is played. Use the function  to select the sound file to play. Please note that larger files may take some time to load and therefore a slight delay might occur until the playback starts after the count down reaches 0:00.
Hint:
· The background of the counter starts flashing during an interval of 120 seconds around the target time. The flash frequency is as higher as closer the current time is to the target time.

[bookmark: __RefHeading___Toc41442_2823577171]Color
· Use system colors for clock use the menu colors defined by windows. In this case the clock display uses the same colors as the other menu bars.
· Background allow the user to select the background color for the system clock display, which might be different from system's background setting. This setting is applied only if the Use system colors for clock option is not selected. The current selection of background and font color is applied to the Background and the Font Color button, independent of the Use system colors for clock setting.
· Font Color allow you to select the color of the font used by the system clock display, which is might be different from system's font color setting. This setting is applied only if the Use system colors for clock option is not selected. The current selection of the background and the font color is applied to the Background and Font Color buttons, independent of the Use system colors for clock setting.

Hint:
· These settings affect the system clock area only. The count up/down area uses fixed colors, which are green for the count down mode and yellow for the count up mode.
[bookmark: __RefHeading___Toc41444_2823577171]Global
· Cancel close the setup window and discard all changes.
· OK close the setup window and apply changes.

Hints:
· The settings for the Countdown Time and for the on countdown 0:00 do option are used only if the Count down mode is selected in the Clock Mode setting.
· You cannot set the system time using SATlive. Please use the windows ® functions to set the system time.

[bookmark: __RefHeading__29102_490587637][bookmark: hs1980]Setup → Level Display
[image: ]You can set the parameters of the level display, which is located at the top of the VU meter in this setup.
To open the setup window simply click on the level display area above the VU Meter.
· The top area contains the selection of the weighting filter to be used for the level display. You can select an A or C weighting – filter or disable weighting using the Flat setting. Furthermore you can set the mode of the level display to Crest Factor. In this case the level display shows the crest factor, which is the difference between the peak level and the rms level. The crest factor indicates the dynamic of the signal.
· The middle area contains the selection of the averaging time used for the display. A higher value results in a smoother display.
· The lower area contains the setting of the VU meter's fall time for the peak value.
· Use the button OK to close the window and to apply the changes. 
· The button CANCEL closes the window and discards the changes.
Hints:
· You need to perform a level calibration to get correct values in the display.
· The settings for the weighting filter and for the averaging time are used for the level display only. You can apply a weighting filter on the mic input in the MAT module using the weighting setting in the bottom menu bar. See the weighting filter section on page 103 for more details on weighting filters.

[bookmark: __RefHeading___Toc41446_2823577171][bookmark: Ref_lockMenuPositions]Lock Menu Positions
[image: ]This option, located in the main setup menu fixes the position of the menu bars.
The icon on the left indicates the current state.
· An open lock indicates that you can move the menu bars to different locations in the menu area.
· The closed lock shows that all menus are fixed at their current location. 
· To toggle between those two states, simply click on the menu entry.


[bookmark: __RefHeading__28542_823354303][bookmark: hs2500]Error-report window
[image: ][image: ]To open the error-report window use the Show all Errors function in the menu Help 
At the top to the error-report window you find some information about your system.
Below of this information you can find the error message(s), which contain a short description and the date and time the error occurred.
·  Print send the error report to your printer.
·  E-mail create an e-mail containing the error-report. Send this e-mail to Info@SATlive.audio
· [image: ] Delete removes all entries from the error list.
·  OK close the error – report window.
Hints:
· If there is a new entry in the error log then SATlive shows a remainder on next start of SATlive.
· Any error report sent to us may improve the next version of SATlive. So please support us by mailing the error report to us.
· SATlive features a second error reporting tool, which looks a little like the windows error report tool, which delivers a more detailed error-report. The error information is sent to us and helps us to improve SATlive.

[bookmark: __RefHeading__27848_490587637][bookmark: hs2505]The menu Registration
[image: ]The menu registration is a sub-menu of the menu Help.
· Demo version opens a sub menu which contains the Request Demokey and the Enable Demo entry.
· Full version will open the sub – menu Full Version.
Hints:
· The different options are enabled according to the current state of your registration.
· This menu is not enabled if SATlive detects a valid dongle.
[bookmark: __RefHeading__28538_823354303][bookmark: hs2507]The menu Full Version
[image: ]This menu is a sub --- menu of the menu Registration (see page 220).
It contains the steps needed to complete a registration of the full version
[bookmark: __RefHeading___Toc41448_2823577171][image: ] Register using internet
Takes you to the shareIt web-site and will open the order website for SATlive.
Hints:
· shareIt supports ordering via a fax and wire transfer if you don't trust the internet.
· There are two types of license available. 
For details about pricing and versions available, please check the SATlive website: https://www.satlive.audio/en/portfolio/order-satlive/

[bookmark: __RefHeading__28540_823354303]Install a keyfile
After purchasing a PC related license you'll get a key file. Save it to your computer and use the Install Keyfile function to activate it. Please keep the key files in a safe place. 
It will allow 10 days of unlimited access to SATlive even if you totally rebuild your system.
Use the install a key-file function to install a *.DKF file.
[bookmark: __RefHeading___Toc41450_2823577171]Request Full Key
This option opens the request registration key window. 
After installing the key files you get ten days to complete your registration.
[image: ]This will personalize the software to your computer. To do so, you need to request a full key by sending the full-version basic-key displayed in this window via e-mail to Registration@satlive.audio. You can either copy and paste the full – version basic – key in an e-mail or just click on the e-mail button and let SATlive create the mail for you.
You can also use the button Save to File to save the information into a text file, which could be easily transferred to another computer, if the current PC does not have the possibility to sent e-mails.
Hint: 
· If you choose the mail option, SATlive will invoke the mail client on your computer and create the mail there. You need to send the create mail by yourself.
[bookmark: __RefHeading___Toc41452_2823577171][image: ]Install full key
In return to your full key request you'll get a small key file. 
To complete the registration, just save that file to your hard disk and select it using this function.

[bookmark: __RefHeading___Toc41454_2823577171][image: ]Type in full version key
Use this function if you're facing a problem during the activation of the full version key. If you need to perform the installation by hand, you need to perform the following steps:
· Change the extension of the key file from RXR to TXT.
· Open the file using a text-editor software.
· Copy the string into the clipboard.
· Open the Type in Full Version Key window.
· Paste it into the input area in this window.
· Click on OK.
[bookmark: __RefHeading___Toc41456_2823577171]Remove SATlive Key from this computer
Use this option if you want to move your PC related license to another computer. After running this function SATlive will not longer run on this computer and the previous install-key will not work anymore! This function creates a code, which is needed for the license for the new computer. The code is saved to a file called SATLiz.txt in the folder My Documents. Keep this code in a safe place.

Hints:
· The full version key is valid only on the computer where the full version basic key was created.
· Please use the option e-mail or at least copy & paste to avoid typos.
· Please allow some time for handling your key requests and orders, especial if you're using wire transfer from abroad.
· You do not need to perform any of these functions if you're using a dongle type license.
· See the file readme.pdf which you'll receive with your basic-key for a detailed description about the registration and re – installation process.

[bookmark: __RefHeading__27152_7977939]Signal generator
[image: ]the signal generator is located at the lower right of the SATlive window.
It features different types of signals and access to the windows mixers and level control.
Furthermore it contains eight buttons, which can be assigned to different connections, to allow quick recall of predefined routing when a ASIO I/O device driver is used. The buttons are visible only if an ASIO – device driver is selected in the Setup → I/O Devices window.
See the page 187 for details about the Connection – Manager.
[bookmark: __RefHeading___Toc41458_2823577171]Set the output level
This setting is located in the signal generator area.
It controls the level of the output signal.
The values shown are attenuation values, i.e. the hottest output is reached at a setting of 0 and a value of -80 nearly mutes the output. The level settings popup menu contains some preset level values. In the web – client (see page 333) you can change the volume using the control buttons (see page 349).

Hints:
· Any change in the device I/O setup can cause large differences in the output level. Therefore reduce the output level when you change any audio related setting.
· [image: ]The output's value can be affected by the settings in the windows output mixer. You can access the windows output mixer using the Invoke windows output mixer function in the popup of the signal generator area.
See page 224 for details about the popup menu.
· [image: ]The volume setting features a popup menu containing some predefined level values.
· The attenuation shows in values of dB.
· On the first start the level is reduced to -60dB.


[bookmark: __RefHeading__23245_1132721720][bookmark: Ref_sigGenPopUp]The menu of the signal-generator
[image: ]This menu is assigned to the signal-generator at the lower right.
· SETUP opens the setup window assigned to the currently used signal. The signals swept sine (see page 227) and impulse (see page 229) feature a setup window.
· Output Waveform opens the selection menu to choose the waveform of the output signal (see page 226).
· Current I/O Setting shows the current settings for the audio I/O in a small window. You can also use the key-combination Ctrl – Alt – D to invoke this window.
·  Open Windows Mixer for Audio Input invokes the windows settings for audio input.
·  Open Windows Mixer for Audio Output opens the windows settings for audio-output.
·  [image: ] ConnectionManager opens the ConnectionManager window. For details refer to page 189.
· ASIO driver open the setup panel assigned to the currently selected ASIO driver. See the manual of the ASIO device for details.
· Reset ASIO Driver allows you to restart the current ASIO driver if you’re facing trouble related to the driver. This does not affect the settings of the driver.
· [image: ]I/O Devices opens the setup window of the I/O Audio (see page 180).
· Assign Buttons for ConnectionManager opens an editor window where you can assign a connection to one of the buttons in the signal-generator area.
Select the connection for each button from the area right to the button symbols. You can assign the same assignment to more than one button.
The assignment varies for each ASIO device.
· Use selected Range for Bandpass this function assigns the currently selected range to the bandpass – filtered pink – noise signal.
· Direct-Reference opens the direct – reference menu described on page 151.
· [image: ]Freeze mutes Output: This option links the button RUNNING / FROZEN in the right menu area to the sound – generator, so that freezing the display will stop the sound – generator as well.
· Mute freezes Display: This option is available in the impulse – response display only. It links the Freeze button to the mute button. The display will freeze when you mute the output and refresh will start as soon as you’ll start the signal again.
· Reset on Start of Sound: This option links the button Sound On/Off to the button RESET in the right menu area, so that starting the sound – generator will reset the current display.
· Wav-Player: Access the control window of the wav – player. See page 232 for details.
· At the bottom you’ll find up to five settings used for the bandpass – filtered pink noise signal. Click on an entry of the list to recall the range – setting. See page 228 for details about this kind of signal.
[bookmark: __RefHeading___Toc41460_2823577171][bookmark: hs2850]Frequency
[image: ]This setting is located in the signal generator area and will show only if the current output signal supports different frequencies. This is true for the wave forms Sin var, Rectangle, Triangle, Sawtooth + and Sawtooth – 
Set the frequency of the output signal. The arrows on the right increase/decrease the frequency in steps of 1 Hz, the left arrows in larger steps, depending on currently selected frequency. The popup menu contains some preset frequency values.

[bookmark: __RefHeading___Toc41462_2823577171][bookmark: hs2860]Output signal selection
[image: ]You can open this menu by clicking on the waveform label at the top of the signal – generator or via the entry Output Waveform of the menu signal – generator (see page 224.
Select the output signal from the list.
· Pink noise: MLS noise with a pink spectrum.
· Bandpass Pink Noise: Pink noise with a band – pass filter applied. See page 228 for details.
· Pink noise < 200 Hz pink noise with a high – cut at 200 Hz. Intended for measurement of subwoofers.
· Wav-File: As soon as valid audio data is present the name of the file will occur in the list. See page 232 for further details.
· White Noise: MLS noise with a white spectrum.
· 1kHz Sine wave: Sine wave with a fixed frequency of 1 kHz.
· Sin var: Sine wave with a variable frequency.
· Sweep Sine: Swept sine with variable parameters. Details on page 227.
· Sweep from High to low: Swept sine running from high to low.
· Rectangular wave: a rectangle shaped wave form with variable frequency.
· Triangular wave: a triangle shaped wave form with variable frequency.
· Sawtooth Rising: an increasing sawtooth shaped wave form with variable frequency.
· Sawtooth Falling a decreasing sawtooth shaped wave form with variable frequency.
· Impulse – creates different kinds of impulses with an adjustable repeat-rate.
Please refer to page 229 for details.
Hints:
· You could not change the type of output signal during a MLS measurement in the impulse – response module.
· Different wave forms contain a different amount of energy. Therefore reduce the volume setting before you select another wave form.

[bookmark: __RefHeading__25358_1307676328]Swept sine (Sweep) / Sweep (Inv)
[image: ]The swept sine is an output signal whose frequency increases or decrease continuously covering a given frequency range.
Select the swept sine signal in the signal generator's window from the output signal selection. The information area below the signal-type selection shows the parameters currently in use. To change the parameter, open the setup window by clicking on the information area. The sweep (Inv) signal will start at the highest frequency and run down to the lowest frequency.
[bookmark: __RefHeading___Toc41464_2823577171]The setup window
· [image: ]Presets assigns the current settings to a preset or recall settings from a preset
· From the frequency at the start of swept sine
· To the frequency at the end of swept sine
· Duration the time in milliseconds used for one complete sequence
· Apply saves the changes and close the window
· Cancel discards the changes and close the window
Hint:
These settings do not affect the signal used for the sweep measurements in the impulse-response module.
[bookmark: __RefHeading___Toc41466_2823577171]Sweep Presets
[image: ]In the swept sine setup window you can assign the current settings of the sweep signal to one of the four presets, or you can recall one of the presets. To invoke a preset just select it from the popup menu available in the Preset menu of the sweep setup window. To save the current settings into a preset, select the preset to store to in the sub menu Save as preset in the popup menu of the button Preset at the top of the sweep setup window.

[bookmark: __RefHeading___Toc28617_833138857][bookmark: Ref_bppn]Bandpass – filtered Pink-Noise
The bandpass – filtered pink-noise is a signal which contains energy only in a certain range. The energy in the output signal is concentrated on that range, which is helpful in situations with high noise levels.
[image: ]The red trace shows the default pink-noise signal, the blue trace a bandpass-filtered pink-noise with a range from 76Hz to 1.6kHz, with the same level setting.
[bookmark: __RefHeading__25189_1248855964]Setting the range for the filter
There are different ways to set the filter range for the bandpass – filter used:
· Select the frequency range using the frequency – range tool (see page 96) and use the Use selected Range for Bandpass entry in the popup menu of the signal – generator (see page 224).
· Select the frequency range using the frequency – range tool (see page 96) and double-click on the frequency-range display below the output-signal selection.
· Choose one of the most recently used filter settings shown on the bottom of the popup menu of the signal – generator (see page 224).

[bookmark: __RefHeading__20827_300033887]Signal Impulse
[image: ]This wave – form delivers single pulses of different kind with a repeat-rate defined by the user. This kind of signals can help you to adjust delays by ear. The repeat rate covers a wide range from 1 millisecond to 60 seconds.
Like all other signals, this signal is listed in the signal-kind selection in the signal-generator area on the lower right.
Note the information below the signal – kind selection. The upper line shows the kind of impulse used, the second line informs you about the current repeat-rate.
To change the settings, simply click on this information area to open the configuration window.
[bookmark: __RefHeading___Toc41468_2823577171]The configuration window
[image: ]This window contains two settings. The selection on the top contains the different kinds of impulse. Below you find the setting area for the repeat-rate.
There are different possibilities to change the repeat-rate
· Click on + to increase the rate by one millisecond.
· Click on – to decrease the rate by one millisecond.
· Hold down the Shift key and click on + to increase the rate by ten milliseconds.
· Hold down the Shift key and click on – to decrease the rate by ten milliseconds.
· Hold down the Ctrl key and click on + to increase the rate by 100 milliseconds.
· Hold down the Ctrl key and click on – to decrease the rate by 100 milliseconds.
· Click on the value with the left mouse-button or on the whole area with the right mouse-button to open a popup menu which contains some preset values.

[bookmark: __RefHeading___Toc41470_2823577171]Available Impulses
[image: ]There are different kinds of impulses available for this signal. The green line shows the unaffected signal and the blue line shows the signal looped back.


· [image: ]Single
Just a needle with a size of one sample, heading upwards.





· [image: ]Single (Sym)
A needle heading upwards immediately followed by a needle heading downwards.





· [image: ]Step
A needle heading upwards, followed by a zero and a needle heading downwards.


· [image: ]Sine
The positive half of a 6 kHz sine wave.






· [image: ]Sine (sym)
One full cycle of a 6kHz sine wave.






· [image: ]Sine (long)
The positive cycle of a 1kHz sine wave.
Please note that in the picture the scaling of the x - axis differs from the pictures above.



[image: ]
· [bookmark: hs2870]Sine (long, sym)
A full cycle of a 1kHz sine wave.
This impulse is the one that 'sounds' best, so you should prefer it.

[bookmark: __RefHeading___Toc36370_2823577171]The WAV – Player
SATlive features a simple wav – player. This player will play audiofiles which feature the wav (windows pcm audio) format.
It will always put out a mono signal.
The samplerate of both, the file and SATlive must match.
[bookmark: __RefHeading___Toc41472_2823577171]The control window of the Wav – Player
[image: ]Use the entry Wav-Player in the signal – generator’s menu (see page 224) to open this window.
If you’ve selected a valid audio – file then the full name and some properties of the file will show in the upper area of the window.
Use the selection Audio Track to choose the source for the mono signal.
Beside of using only one of the channels you can also use an average of both channels by selecting the entry Sum L and R.
The button Select File will open a file – selection dialog where you can choose the audio file you want to use.
The button OK will close the window.
As soon as a valid file is selected it’s name will occur in the signal – type selection.
Hints
· The length of the audio data is limited to 10 minutes. If the length of the data in the file exceeds that limit, then the audio data is truncated to the first 10 minutes.
· The audio data will loop.
· [image: ]A mismatch of the samplerate will cause a warning message in the upper area.

[bookmark: __RefHeading___Toc41474_2823577171]VU Meter
[image: ]The VU Meter is located in upper right area of the SATlive window.
It shows the levels of both inputs.
The bar – graph display shows the input levels related to digital full-scale.
The peak level is indicated by a single line, and the RMS value is shown as a solid bar.

Hints:
· You can use any signal, either external or from the internal signal generator to adjust the input level.
· The input level is adjusted in the windows recording mixer, which can be accessed using the Open Windows Mixer for Input function in the popup menu of the signal-generator area. See page 224 for more information about this popup menu.
· In the MAT module you can select the input for display by clicking on the labels below the bar – graph display. See page 176 for details.
· You can set the fall-back time of the peak display in the Setup Level Display window. See page 217 for details.
· Avoid clipping the input to assure good quality of the results. SATlive will stop the calculation if either clipping occurs or the input – level is too low.

[bookmark: __RefHeading___Toc41476_2823577171][bookmark: hs2880]Start the output signal
[image: ]This function is located in the signal generator area.
It is located right of the output level setting.
[image: ]The current state of the signal generator is indicated by the color of the vertical line left of the speaker – icon. Green indicates the signal – generator putting out a signal, while a red line indicates that the output is muted. 
Hints:
· You could not mute the output during a MLS measurement.
· You can also use the shortcut G to toggle the state of the output.
· When the signal – generator (see page 223) is stopped, then the short – cut Shift – G will start the sound and reset the averages.
· The option Freeze mutes Output in the menu links the control of the output with the control of the display so that freezing the display will mute the output also.
· All measurements in the impulse – response module control the output. You control this behavior for the MIR – measurement (see page 67) in its setup – window.
[bookmark: __RefHeading___Toc41478_2823577171][bookmark: hs2890]Level Display
[image: ]The level display is located at the top of the VU Meter.
It shows the average level (RMS) of the mic input. You can set the time used for averaging in the Level Display's setup window.
You can use a Weighting Filter for this display. The selection of the weighting filter is in the Level Display's setup window. The currently selected Weighting Filter is indicated by a letter in the label shown below the number. 
Furthermore the display can show the crest factor of the signal applied to the mic input. 
· dB(A) the Weighting Filter A is currently selected.
· dB(C) the Weighting Filter C is currently selected.
· dB(Crest) the result shows the crest factor, which is the difference between peak and rms level.
· dB no Weighting Filter is currently used.
To open the Level Display setup window, described on page 217, click on the level – display area.

[bookmark: __RefHeading___Toc30781_61384670][bookmark: hs3000][bookmark: Ref_TraceManager]The Tracemanager
You can use the tracemanager to display and average saved frequency responses.
To invoke the Tracemanager either click on the button Tracemanager [image: ] or use the shortcut Ctrl + T.
During the measurement of the impedance trace (see page 128) you can use the tracemanager to show amplitude responses in the background.
[bookmark: __RefHeading___Toc54473_209593912]Single traces
[image: ]The upper part of the tracemanager window contains eight similar areas. Each area can handle one trace. 
This function are available in any of the eight areas:
· [image: ]The upper line shows the name of the trace. The rectangle at the left will show the color used for drawing as long as the option Weighting affects Color had not been activated in Setup → Measurement (see page 200).
Otherwise the color used for drawing is controlled by the weighting assigned to the trace and the rectangle will show no color.
This area also contains a popup menu, described on page 236.
· [image: ]Load Trace open a saved frequency response. The popup menu of trace name display contains a list of the most recent used files where you can pick a file with a double click.
· [image: ] Show Trace displays the loaded trace. 
This option is enabled only if a valid trace is loaded.
· [image: ] Average Trace to result averages the loaded trace to the master trace using the weighting selected. This function is enabled only if a trace is loaded and the loaded trace has the same samplerate as the master trace.
· [image: ]Set Offset, Smoothing, Color open a window containing additional settings like offset or color. See page 239 for further information.

· Weighting the colored field right of file name display shows the currently selected weighting of the trace. Toggle the three different weightings with a mouse-click on this field. 
The trace width used for the display of the trace is changed according to the selected weighting and the trace width assigned to this setting (see page 241 for details). 
If you’ve activated the option Weighting affects Color in Setup → Measurement (see page 200) then the trace will draw using the color assigned to its current weighting. Otherwise the color assigned to the trace will be used.
See page 240 for further details about using different weightings.
[bookmark: __RefHeading___Toc54471_209593912]The popup menu of the trace – name display area
[image: ]This popup menu is assigned to each single – trace section (see page 235) of the tracemanager. To access this menu click on the trace – name section using the right mouse – button.
· [image: ]Set Offset, Smoothing, Color: open a window containing additional settings like offset or color. See page 239 for further information.
· [image: ]Clear single trace removes this trace from the tracemanager.
The trace itself is not affected.
· [image: ]File Info opens the File – Info window, described on page 24.
· [image: ]Load Trace: open a saved frequency response.
· Load from Project use this entry to import a trace contained in the current project.
· File list the file list shows the recently used files. To load a file from the list, just click on the name of the file in the menu.
If no trace is currently loaded, then only the entries Load trace, Load from Project and the file list will be available in this menu.

[bookmark: __RefHeading___Toc41480_2823577171]Master Trace
[image: ]In the tracemanager the Master Trace represents the result of the averaging of the traces selected for averaging.
The following functions are available for the master – trace:
· [image: ]Save the master – trace trace to a file.
· [image: ]Show the master – trace in the trace display window.
· [image: ]Invert the master trace mirror the master – trace's display on the 0 dB line to ease the adjustment of equalizers.
· [image: ]Color of the master trace.
· [image: ]Reset Averaging click on this button to reset the average to main-trace button of each trace to false.
· The list below the buttons shows the names of the traces currently averaged.
[bookmark: __RefHeading___Toc41482_2823577171]Global functions
· The button Delete will remove all traces from the tracemanger. To clear a single trace use the entry Clear Single Trace in the popup menu assigned to the display of the trace’s name.
· Use the menu [image: ]to import all eight traces at a time. See page 238 for further information about the import menu.


[bookmark: __RefHeading___Toc48847_2823577171]The menu Import
[image: ]Using this menu you can import up to eight traces simultaneously into the tracemanager (see page 235).
· Copy current QuickTraces will import the quick-traces currently used.
· [image: ]Copy from project will import the quick-traces assigned to a certain speaker in the current project. Therefore a window will show where you can choose the speaker whose traces you want to import.
In case that the project contains just one speaker a confirmation box will show instead of the selection window.
· Copy from an other project will open the file – selection dialog (see page 316) where you have to choose the project first. After that the import will continue as described above for the Copy from Project entry.
· Do not clear empty traces if this option is selected then a traces previously assigned will remain if there is no valid trace to replace it. Otherwise all previously assigned trace will be cleared before the start of the import.

Hint
· Each trace will keep its location during the import. 
This means that for example the Quicktrace 5 will always import to trace 5, no matter if there are other valid traces or not.

[bookmark: __RefHeading___Toc31113_2175484897][bookmark: hs3010]Offset, Color and Smoothing
[image: ]This window contains additional settings for the traces displayed using the tracemanger (see page 235).
· On the upper left you can find the control of the vertical position of the trace. It operates in the same way as the offset control in the main window, which is described on page 90 of this document.
· The colored rectangle on the upper right indicates the color currently assigned to this trace. Click on it to open the color – selection dialog where you can choose the desired color.
Please note that the option Weighting affects Color in Setup → Measurement (see page 200) will link the color of the display to the weighting of the trace, using the colors set in the Setup → Weighting (see page 241) section.
In this case the label left to the trace in the tracemanager name will stay blank, while otherwise it will show the color of the trace.
· Smoothing select the smoothing of the trace.
· Display Coherence this setting is enabled only if the trace contains coherence information. This is true only for traces saved in the Transfer Function measurement in the MAT module. This option determines if the coherence trace related to this trace is shown or not.
· Show trace enables you to control the visibility of the trace.

Hints:
· The changes are displayed in real-time.
· If you exit this window using the Cancel button then all changes will be lost, and the display switches back to the old settings. To keep the changes, exit this window using the OK button.

[bookmark: __RefHeading__29740_490587637][bookmark: hs3020]Weighting and averaging
The tracemanager enables you to average up to eight traces using different weightings.
There are three levels of weighting available. You can edit the parameter for the weighting at Setup → Measurement (see page 200)
If different traces are averaged in the tracemanager they are weighted according to their levels of weighting.
[bookmark: __RefHeading___Toc41484_2823577171]Example
Averaging of two traces using the following levels of weighting:
Primary location: 10
Secondary location: 4
Tertiary location: 1
[image: ]Both traces with the same level (primary).

[image: ]One trace primary, other secondary.

[image: ]One trace primary, other tertiary.

[bookmark: __RefHeading___Toc41486_2823577171]Using Averaging
The proper selection of the mic's locations for measurement has a great influence on the measurement's result.
You can take the following as a rule of thumb:
· One primary location for every speaker, located on axis in speaker's direct sound range.
· Additionally one or more secondary locations in direct sound range, but off axis.
· Tertiary locations are used to check for coverage or interaction with other speakers.
· The creation of the master trace for setting the EQ should be based mainly on the primary location. Secondary locations are used to check if a peak or dip is a result of the mic's location, or a common problem in the whole coverage area.
· Tertiary location are mainly used for special tasks like delay alignment or level adjustment, but normally not as a base for the adjustment of the equalizer.
[bookmark: __RefHeading___Toc50171_209593912][bookmark: hs3030]Setup Weighting
[image: ]These settings are located in the Setup → Measurement window. See page 200 for details.
Set the parameters for three levels of weighting for traces averaged in the tracemanager.
· The Names of the three levels are given by the software. Levels are labeled primary location, secondary location and tertiary location.
· Weighting set how much the trace influences the result. As higher the value, as higher the influence. See page 240 for details.
· Trace Width select the width used to display a trace with this weighting.
· Color set the color used for the weighting indicator in the tracemanager. See the tracemanager section starting at the page 235 for further details.
· If you activate the setting Weighting affects color then the traces of the tracemanger will draw using the color assigned to the current weighting of the trace.

[bookmark: __RefHeading__26596_7977939][bookmark: hs3060]Smooth FFT
The Smooth FFT is a special algorithm to calculate the frequency response from an impulse response whose result is closer to human hearing than the result of a default FFT.
[bookmark: __RefHeading___Toc41488_2823577171]Basic considerations
The human ear (or to be more exact, the human brain) analyzes the received sound using special criteria.
The part of sound received first is treated as utilizable and used to locate the sound's source. (Haas Effect, Rule of first wavefront).
The sound which is received later is treated as interference and masked.
A normal RTA based measurement treats all the energy reaching the measurement mic in the same way, therefore you can call it 'time blind'.
For the simple FFT calculation a certain range of the impulse response is selected (windowing) and analyzed, thus masking unwanted parts of the impulse response.
But in human hearing the border between 'good' and 'bad' sound is frequency depended and ranges from a few milliseconds at high frequencies up to more than half a second at low frequencies so that applying just one window for all frequencies will match ear's recognition of sound only in a small range of frequency.
[bookmark: __RefHeading___Toc41490_2823577171]Theory of the Smooth FFT
To be closer to the human hearing, the frequency range is divided into nine frequency bands. Each band features its own window size, FFT resolution and FFT. After performing those nine FFT – calculations, the results are combined to one single trace.
The windowing applied by the user sets the maximum window size used for the smooth FFT windows. This means that the shorter of both (user window and smooth FFT window) sizes is used for the windowing.

On a samplerate of 48 kSamples/sec the Smooth FFT will use the following parameters:

	Start
	End
	Size of window
	Resolution

	14.7 Hz
	70.3 Hz
	1.4 s
	0.73 Hz

	70.3 Hz
	141 Hz
	680 ms
	1.46 Hz

	141 Hz
	281 Hz
	340 ms
	2.93 Hz

	281 Hz
	562 Hz
	170 ms
	5.86 Hz

	563 Hz
	1.13 kHz
	85.3 ms
	11.7 Hz

	1.14 kHz
	 2.25 kHz
	42.7 ms
	23.4 Hz

	2.26 kHz
	4.5 kHz
	42.7 ms
	46.9 Hz

	4.6 kHz
	9.0 kHz
	42.7 ms
	93.8 Hz

	9.1 kHz
	18 kHz
	42.7 ms
	188 Hz

	18 kHz
	24 kHz
	42.7 ms
	375 Hz



As you can see the Smooth FFT combines a high resolution at low frequencies with a sufficient resolution at high frequencies.
In the field the Smooth FFT shows a good correlation between what you hear and what you measure.
[image: ]The Smooth FFT overlays the selected window with different windows during calculation. All windows are linked to the left border of the given window. Therefore a large setting left of the peak can exclude the peak from the internal window used at higher frequencies. This results in a spoiled frequency response trace at high frequencies.

[bookmark: __RefHeading___Toc29681_3605433025][bookmark: hs3080]Valid range tool
[image: ]In the FFT module you can invoke this tool in the popup menu of the trace display.
The valid range tool checks for the usable frequency range, shows border's frequencies and displays the border lines.
· Range set the maximum level difference related to the peak's level allowed for the usable frequency range.
· Range to check set the frequency range to check for the usable frequency range. If displayed Range is selected, then the valid range tool searches only the displayed part of the frequency display and the Range setting is related to highest level in the displayed range. If Full Range is selected then the whole frequency response is examined and the Range setting is related to the highest value found in the whole frequency response.
· Start Search 
· Start at Peak start searching for the borders at the frequency response's peak (or at the highest value in the displayed frequency range).
· Start at Borders starts the search at the borders of the frequency response (or the borders of the visible range).
· Options → Continuous Operation the borders of usable frequency range are displayed in the right menu area above the signal generator' area , and updated on every change of the selected trace.
· Range Borders customizes the display of the borderlines used for the display of the usable frequency response range.
Hints:
· You can select the trace to analyze in the popup menu of the trace display in the Show Values of selection.
· Use the hide range markers function from the popup menu of the trace display to hide the markers on the borders.

[bookmark: __RefHeading___Toc41492_2823577171][bookmark: hs3090]Absolute and relative Level
The unit dB is always used for a relation between two values.
If the level used as reference is an official defined reference SPL, then we talk about Absolute Level. To get an Absolute Level display, you have to adjust the internal reference SPL of SATlive.
We talk about Relative Level if the level is related to some not official defined reference value. As default SATlive uses only relative levels, with the following reference values:
· FFT uncalibrated, Smooth FFT uncalibrated: the reference level is the mean level of the whole frequency response trace.
· FFT calibrated, Smooth FFT calibrated: the reference level is the level of the calibration frequency trace. This means that the difference in level to the calibration trace is shown.
· MAT Transfer the reference level is reference (REF) input signal's level.
· VU Meter the reference level is the digital full-scale.

[bookmark: __RefHeading___Toc41494_2823577171]Calibration of the absolute Level
To enable SATlive to display absolute level values you have to set its internal reference level using either a calibrated SPL measurement unit or a calibrator device.
The calibration is performed in the Setup → Set dB Ref window.
· Please check if all internal levels are set properly before starting. Use the sin 1k signal for this purpose because it is used during the calibration process also.
· Any change of the gain will void your calibration data.
· If you use an SPL meter, then you need to set the external SPL meter's parameter to A weighting and Slow RMS display.
· If you want to use a calibration device then select the Use Calibrator for Level Setup option.
· Connect your mic to the mic input of SATlive. Use the VU meter to assure correct assignment.
· Use the option Use db Calibration for MAT (FFT and RTA only) to enable/disable the use of absolute levels in the trace display. If this option is not selected then the calibration values are used only for the Level Display.
· [image: ]The Level at digital Full Scale shows the SPL at digital full scale. 
· Click on Start dB Calibration to start the calibration process.
· SATlive will guide you through the calibration process. Use the button NEXT to go to the next step. The description of the current step is shown in the information area. The setup consist of the following steps:
· Ask you if all preparations are done.
· If an external SPL meter is used, then a 1kHz sine wave signal is played and you need read the meter's display after it gets stable. If the display does not get stable then check the settings of the meter again (A weighting and Slow RMS display).

· If you're using an external SPL meter, then type in the meter's display in the edit field below the information area. If you're using a calibration device, type the RMS level of the calibration device in the edit field below the information area.
· If you use an external SPL meter then replace the external dB meter with SATlive's measurement microphone. If you're using a calibrator device, then apply the calibration device to the measurement microphone and activate it. Please read the instruction manual of the calibration device for further information.
· If you use an external SPL meter, then the 1kHz sine wave signal is played again and its RMS level is measured, otherwise SATlive measures the signal level delivered by the calibration device.
· The internal level calibration values are calculated.
· Now check the Level at digital Full Scale if it fits to your needs. If the value does not fit, then change the settings of the input mixer and the level control of your I/O device accordingly and repeat the calibration.
· If you want to change an earlier setting, you can use the BACK button.

Do not change any gain setting after the calibration process, because this will void your calibration data.
If possible, set your gain control to a position which can be recalled easily, like the a full left position.

[bookmark: __RefHeading__30380_490587637][bookmark: hs3115]Project
You can use a project to manage different measurements.
· A project contains information about the venue and at least one speaker.
· Up to eight different measurements can be assigned to each speaker.
· The selection of a speaker loads the traces assigned into the Quick – trace memories.
· You can load all traces assigned to one speaker into the[image: ]Tracemanager. See the tracemanager section starting at the page 235 for further details.
· You can create or edit a project in the Setup →  Project section.
· You must assign at least one speaker to a project during creation.
· You can use the[image: ]Project Manager in the menu Quick – Trace Setup (see page 273) to add further speakers or to rename speakers or measurements. You can open the project – manger using the key combination Ctrl + P as well. See page 251 for details about the project – manger.
· A project contains two types of files
· One so called project – file, which is saved using the extension SPN. This file contains the information about the project and links to all the traces assigned.
· All traces in a project are saved as default Quick – traces (see page 270). SATlive saves the trace during assignment into the selected project folder.
[bookmark: __RefHeading__33602_490587637][bookmark: hs3120]Project setup
[bookmark: __RefHeading___Toc41496_2823577171]Basics
The Project Management is intended to ease the handling of larger amount of measurements and supports these features:
· Assignment of groups of measurements to speakers.
· Recall of all the measurement assigned to a speaker by a simple selection of the speaker they are assigned to.
· All measurements are saved when they are assigned to a Quick – trace. SATlive creates a unique file name which is used to save the measurement. See page 270 for details about Quick – traces.

[bookmark: __RefHeading___Toc33271_1174202529]Preparation
[image: ]Start with creating a new project. This is done in the Setup → Project section.
There is some information about the venue which you can edit. A text is needed in the project field. The other fields are optional. The info filed can be used to store additional information about the project. You can edit the information in the Project-Manger as well.
The information is shown in the file-selection window when you select a file to open.
· You can activate the project management separately for the use in FFT module and in the MAT module, where it is linked to the Quick – traces and/or in the Tracemanager. Furthermore, you can use the project management in the impulse-response module.
· See page 270 for details about Quick – traces.
· See page 235 for details about the tracemanager.

[image: ]You have to save your settings before you can add a speaker.
· Use the Load function to open another project.
· Save as new project saves the current project to a new project. It saves only the settings so that the new project does not contain any trace data.
· Delete removes the project, all measurements assigned to it and the projects folder (if possible) from the disk.
· New resets the current values thus creating a new clean project.
· Use Export / Import to open the Export / Import window. Use this window if you want to move the project including all trace – data. See page 326 for a detailed description of the import and export of project – data.
[bookmark: __RefHeading___Toc41498_2823577171]Adding speakers to the project
[image: ]To be able to edit the speaker section, the current project must be saved using either the save or the save as new project function.
[image: ]You can add or remove speakers or measurements using either the speaker area's popup menu or the buttons below the speaker area. First select the item to edit or to delete with a mouse click, then select the option to perform either from the speaker area's popup menu or from the buttons below the speaker area.
Use the Import Speakers function to import the speakers (not the measurements) of another project into the current project. 
This will delete all speakers already assigned to the current project.

[bookmark: __RefHeading___Toc41500_2823577171][bookmark: hs3125][bookmark: Ref_Project_Manager]The Project manager
[image: ]Use the project manager to add a speaker to the current project or to change the label of a speaker or of a measurement directly in the MAT module.
[image: ]You can invoke the project manager only if a project is currently selected.
Use the function[image: ]Project manager in the menu Quick – Trace Setup (see page 273) or use the button[image: ]available in the complex menu display only. You can use the key combination Ctrl + P as well to invoke the project manager.
To add a speaker, to change a label or to delete a measurement just select the item and then select the action to perform from the popup menu.
The lower window shows the global info text of the project.

Hints:
· Any changes performed here are applied directly and there is no possibility to undo them.
· You can delete speakers in the project setup-section only.
· Use the button OK to close the window and to return to SATlive. 
· You must close the window before you could continue to work with SATlive.
· The info text is shown in the file-selection window and in the project-setup window.

[bookmark: __RefHeading___Toc41502_2823577171][bookmark: hs3127]New speaker
· [image: ]This window shows up when you create a new speaker in the current project, which can be done at the project-setup section or in the  project manager using the New Speaker option of the popup menu of the speaker section.
· You can enter the label of the speaker in the edit field. The label can have a maximum length of 40 characters and must not be empty.
· Different speakers of the same project could share the same label, but you should avoid that in order not to mix up different speakers.
· You can edit the memo assigned to the speaker in the project manager or in the project-setup section. During the creation of a new speaker the memo is filled with the speaker's label.
· Use the button Cancel to close the window and to return without adding the new speaker to the current project.
· Use the button OK to close the window and to add the new speaker to the current project.
· You can delete speakers only in the project-setup section.
· See page 248 for details about the project setup.

[bookmark: __RefHeading__24942_1251909600][bookmark: hs3230][bookmark: Ref_TargetTrace]Working with Target Traces
[image: ]You can show a static trace in the background to have a guideline for the adjustment of the frequency response. In SATlive we call these traces Target Traces.
The picture shows the X-Curve including its range of tolerance.
Currently SATlive supports a user-definable target-trace and the X-Curve which is widely used for the optimization of sound systems in cinemas. See page 257 for more information about the X-Curve.
You can configure the kind and display of the target-trace in the popup menu assigned to it. On page 254 you’ll find more information about the entries of the popup menu.

Hints:
· The target race support amplitude response only (no phase information).
· The target trace feature is available in the FFT module and in the transfer-function, FFT, RTA and in the FFT + Spectrograph measurements in the MAT module (see page 117).
· If you would like to show a measured trace in the background you can either use a Quick – trace (see page 270) or the Trace-Manager (see page 235).
· [image: ]If a target – trace shows, its description will show at the lower right corner of the amplitude display area.
Click on this label to show the popup menu assigned to the target – trace (see page 254 for details).

[bookmark: __RefHeading___Toc41504_2823577171][bookmark: hs3240]Create a user defined Target Trace
You cannot build a user-defined target trace in SATlive, but in the software Target-Trace Builder, which is part of the SATlive package.
You can access the Target – Trace Builder from the windows start – menu.
Hints:
· Because the Target-Trace Builder is an external software, you need to save the edited trace to a file and reload it into SATlive.
· Do not try to load other traces then those created in the Target Trace Builder.
· If you want to use stored measurements, load them into a Quick – trace and use the quick trace functionality, described on page 270.
[bookmark: __RefHeading___Toc42945_1075737587]Manage the target trace
[image: ]You can manage the target – trace using the popup menu assigned to it.
[image: ]To invoke this menu use either the key – combination Shift + X on your keyboard or click on the symbol X in the upper menu bar.
If a target – trace shows, then you can invoke the popup menu by clicking on the label shown at the lower right of the amplitude display – area.
[bookmark: __RefHeading___Toc48596_1075737587]Load a user defined Target Trace
[image: ]Perform the steps to load a Target-Trace:
· Open the popup menu of the target trace.
· [image: ]Click on the Load target from file entry of the popup menu.
· Select the file you want to use from the dialog.
· Confirm your selection using the Open button of the dialog-window.
1. The dialog-window will close and the selected trace will be loaded. 
· SATlive will select the loaded file as target – trace.
· The name of the trace will show at the top of the menu and in the sub – menu Select target trace.

[bookmark: __RefHeading___Toc41506_2823577171]Select the target – trace to show
[image: ]Use the sub – menu Select target trace in the popup menu of the target – trace to select the target – trace you want to show.
If a valid user target – trace has been loaded (see page 254) then the first entry will show its name.
The other entries represent the X-Curve (see page 257) for different room sizes.
To select the target – trace to show click on its name.
Hints:
· A user target – trace it will be selected automatically during loading (see page 254).
· [image: ]The type of the target – trace shown is displayed in the lower right area of the amplitude display.
[bookmark: __RefHeading___Toc41508_2823577171]Show or hide the target trace
There are different ways to show or hide the target – trace.
Either use the shortcut X on your keyboard to toggle the visibility of the trace, or open the popup menu assigned to the target – trace and click on the entry Show target – trace.
Hint
· You can use the sub – menu Offset in the pop – up menu of the target – trace to shift the trace vertically.


[bookmark: __RefHeading___Toc41510_2823577171]Configure the display of the target trace
[image: ]Use the sub – menu Layout in the popup menu of the target – trace to configure the display of the target – trace.
[image: ]If the target – trace contains information about its range of tolerance you can limit the display of the target – trace to the trace only by checking the entry Show Target Trace Only.
Use one of the four other entries in this menu to set the width of the target – trace in the display. To change the color used to draw the trace and its range of tolerance use the color setup section of the display setup window (see page 194).
[bookmark: __RefHeading___Toc41512_2823577171]Move the target – trace vertically
[image: ]The entries of the sub – menu Offset will move the target – trace vertically in the display.
The top line shows the current offset value.
Depending on the entry the trace will move in steps of one or ten dB.
The entry Reset to zero moves clears the offset.

[bookmark: __RefHeading___Toc42943_1075737587][bookmark: hs3280]The X-Curve
In order to assure that a movie sounds nearly the same in any cinema, the Academy of Motion Picture Arts and Sciences defined a target-trace for the acoustic in cinemas. This target-trace is called X-Curve. The first X-Curve was presented in 1937, and it has been modified over the years. A much more detailed review about the X-Curve and its development can be found in the paper The X-Curve: Its Origins and History by Ioan Allen, which can be found in the internet.
· [image: ]It's shape varies slightly according to the size of the room, which is defined by the amount of seats in the cinema. You can select that value in the Number of Seats entry in the menu bar of the editor window.
· In addition to the optimum trace, a range of tolerance is defined as well.
· The display of the range of tolerance can be disabled using the Show Target Trace only option in the editor for the Target Trace.

[bookmark: __RefHeading__21853_1251909600][bookmark: hs4100][bookmark: Ref_virtualEQ]The Virtual EQ
· [image: ]The virtual EQ emulates the frequency response of up to eight parametric equalizers, two shelving filters and a high-cut and a low-cut filter.
· The virtual EQ is available in the Transfer – Function measurement in the MAT module and in the FFT of the impulse response.
· You can apply the equalizer in real-time to the live trace and / or to the sum-trace.

Hints:
· The virtual EQ simulates an analogue EQ using a mathematical model. Therefore the result might differ from the result you got from your real world EQ.
· In this description the term 'virtual Eq' covers all available filters, event the x-over settings. Differences in operation are covered in the description.

[bookmark: __RefHeading___Toc41514_2823577171]Setting the virtual Eq
There are two possibilities to edit the virtual EQ. You can either use the mouse in the display area or you can edit the values of the parametric filters in the editor window, described on page 262.
[bookmark: __RefHeading___Toc41516_2823577171]Editing using the Mouse
· In order to edit the virtual EQ the EQ trace must be visible.
· The frequency of each EQ block is marked by a square.
· [image: ]Move the cursor to the square related to the EQ block you want to edit. If the cursor is over one of the squares, then the square gets solid and the values of this filter are shown in the top area.
· Now hold the left mouse button down and move the mouse to edit the filter.
· A horizontal movement changes the frequency and a vertical movement changes the gain.
· In order to change the width of the selected filter, use the right mouse button instead of the left one. Now you can change the width by a horizontal movement of the mouse.
· During the edit of the frequency and/or gain, you can change the width using the key + and the key – on your keyboard.
· As soon as you release the mouse button the filter is released and you can use the mouse as usual.
[bookmark: __RefHeading___Toc41518_2823577171]Editing in the Editor Window
See the description of the Editor Window, starting on page 262, for details.

[bookmark: __RefHeading__21332_1736061587]The menu of the virtual EQ
[image: ]This menu is the popup menu of the EQ Button, which is located in the Quick – trace menu-bar.
Most of its content is also available in the bottom area of the editor window. See page 266 for the description of the bottom area of the editor window.
To open the menu, either click on the PEQ button with the right mouse button or click with the left mouse-button on the arrow right of the button. In both cases the menu will pop up.
· [image: ]Edit Virtual EQ invoke the editor window for the virtual EQ. You find a closer description of this window starting on page 262 of this document.
· [image: ]Invert EQ Trace mirror the display of the EQ trace shown at the zero dB line. This might help you to adapt the EQ Trace to a trace shown on the display.
· [image: ]Use EQ on Sum Trace applies the virtual EQ to the current sum – trace. See page 283 for details.
· [image: ]Invert EQ Trace flips the display of the virtual EQ. Use this setting to adapt the trace of the virtual EQ to a given trace in the display.
· [image: ]Apply Virtual EQ to live Trace if this option is checked then the virtual EQ is applied to the Live Trace in real time. This is indicated by the label Amplitude + Virtual EQ and Phase + Virtual EQ in the upper right corner of the trace display area.
· [image: ]Trace Layout invoke the trace-layout editor for the virtual EQ trace. See page 301 for more details about the trace-layout editor.

Hint:
· [image: ]Use the entry Assign without Filter or EQ in the popup of a Quick – trace to assign the Live Trace without the EQ applied. The entry Assign copies the result into the Quick – trace. See page 276 for details.

[bookmark: __RefHeading___Toc41520_2823577171][bookmark: hs4140]Invoke the Editor Window
[image: ]You can invoke the editor of the virtual EQ either using the menu entry Edit virtual EQ in the popup menu of the button assigned to the virtual EQ, or use the shortcut Q on your keyboard.
[image: ]The button assigned to the virtual EQ is located in the menu bar Quick – trace and in the popup menu of the trace display.
[image: ]You can invoke the editor by clicking with the right mouse-button directly on the virtual EQ button, left of the arrow.
[bookmark: __RefHeading___Toc41522_2823577171]Show or Hide the Virtual EQ
You can show or hide the trace of the virtual EQ in different ways:
· [image: ][image: ]Click on the virtual EQ button in the menu bar.
· [image: ]Click on the entry Show Virtual EQ Trace in the popup menu of the display area.
· Check the entry Show Virtual EQ Trace in the bottom area of the editor window. See page 266 for details.
Hint: 
· The visibility of the virtual EQ traces does not affect the state of the Use EQ on Sum Trace or of the Apply Virtual EQ to Live Trace setting.

[bookmark: __RefHeading__23052_1838177041]The Editor Window of the virtual EQ
The editor of the virtual EQ features two pages, which you can select using the tabs at the upper left.
[bookmark: __RefHeading___Toc41524_2823577171]The page Virtual EQ
[image: ]This page shows all parametric equalizers. If an equalizer is selected, either by changing its values or by selecting it in the display, then the color of the area changes.

[bookmark: __RefHeading___Toc41526_2823577171]The page Virtual X-Over
This page contains the settings for two shelving filters, two x-over filters[image: ] and one All-Pass filter.
You can change the parameters similar as the parameter of the parametric equalizer, either using the arrows beside the parameter display or the virtual fader. See page 267[image: ] for details.
To change the type and the order of each filter click on the areas showing the current setting.
This will open a menu where you can select the desired filter setting[image: ] with a click.
The quality setting is available for the second – order all – pass filter only.

[bookmark: __RefHeading___Toc41528_2823577171]The menu area
The editor contains a menu bar at the top area, where you'll find the entries listed below.
[bookmark: __RefHeading__25354_1307676328]Virtual EQ
· [image: ]Load default settings: Resets the filters, the shelving filters and the virtual x-over.
· Save: Stores the current setting to a file. This option is enabled only if a setting has been loaded or if a setting has been stored before using the Save as entry.
· Save as: Stores the current setting to a file, using a save dialog where you can choose the name and directory where you want to store the file.
· Rope R1 Export allows you to export the eq – settings to Rope R1 devices. 
This option is available only if the DB Rope R1 Controller Mode is enabled in the setup section.
· Load: Load a setting from a file, using an open dialog where you can choose the file to open from.
[bookmark: __RefHeading__37187_490587637]Setup
· [image: ]Bandwidth: the value used to define the width of the filter.
· Quality Factor(Q) shows the center frequency related to the EQ range. Higher values indicate a smaller range.
· Bandwidth shows the width of the EQ range related to the center frequency. Higher values stand for a wider range.
· Bandwidth (Octaves) shows the width of the EQ range related to the center frequency. The relation is shown in octaves.

· Calculation of Bandwidth: There are different approaches how the frequencies used for the definition of the borders used for the calculation of the filter-width.
You can compare a measured response of your equalizer / controller to the virtual EQ in order to check which calculation fits best.
· DB Rope R1 Controller Mode: This option configures the editor according to the specification of the R1 protocol. When this option is enabled you can use the Rope R1 Export entry in the Virtual EQ section of the menu to create a file for a R1 device. According to the R1 protocol only four peq sections are used in the R1 mode. The calculation mode and the bandwidth – display mode will be locked to the values which R1 uses.
Changing the mode will reset the virtual EQ.
[bookmark: __RefHeading___Toc41530_2823577171]Trace Layout
This entry opens the layout-window for the virtual EQ trace. See page 301 for details.

[bookmark: __RefHeading__21330_1736061587][image: ]The Options in the lower Area
The area below the filter settings contains global options for the use of the virtual EQ.
You can find this options in the popup menu of the button [image: ] also.
See page 260 for details of the popup menu.
· Show Virtual EQ Trace check this entry to show the eq – trace in the display area.
· [image: ]Use EQ on Sum Trace applies the virtual EQ to the current sum-trace. See page 283 for details.
· Invert EQ Trace flips the display of the virtual EQ. Use this setting to adapt the trace of the virtual EQ to a given trace in the display.
· Apply Virtual EQ to live Trace if this option is checked then the virtual EQ is applied to the Live Trace in real time. This is indicated by the label Amplitude + Virtual EQ and Phase + Virtual EQ in the upper right corner of the trace display area.
Hint:
· [image: ]Use the entry Assign without Filter or EQ in the popup of a Quick – trace to assign the Live – trace without the EQ applied. The entry Assign copies the result into the Quick – trace. See page 276 for details.

[bookmark: __RefHeading___Toc41532_2823577171]Setting values in the Editor Window
You can change any value by clicking on the small arrows right to the values, or you can use the virtual slider feature described below to change the values.
All settings contain a popup menu with some predefined values.
The topmost edit-field contains the frequency, the area in the middle the width (as described on page 264, the value depends on the selected display-mode) and the lower one the boost/cut setting.
Use the On setting at the bottom of each section to enable the filter. Only filters which are enabled can be edited using the mouse.
[bookmark: __RefHeading___Toc41534_2823577171]Virtual Slider
[image: ]To use a virtual slider, just move the mouse over the value and press the left-mouse button. Now a slider will show up, allowing you to adjust the value by moving the slider up or down.
The slider assigned to the frequency value shows
a logarithmic behavior.



Hints:
· You can change the bandwidth units in the setup section of the menu (see page 264 for details).
· Any of the three settings features a popup menu containing some preset values.
· You can edit the virtual EQ with the mouse as well.
· The shelving filters do not use a bandwidth setting, but a select-able slope.

[bookmark: __RefHeading__24940_1251909600][bookmark: hs4200]Peak Trace
The Peak Trace is available in the FFT measurement of the MAT module.
The Peak Trace shows the highest values of the live trace. The button resides in the Quick – trace menu bar and contains a popup menu.
[bookmark: __RefHeading___Toc41536_2823577171][bookmark: hs4210]Display / Hide the Peak Trace
· [image: ]Use the button Peak Trace in the Quick – trace menu bar to show/hide the Peak Trace.
· [image: ]Use the entry Trace Layout in the popup menu to customize the appearance of the peak-trace.
See page 301 for details about the trace-layout window.
· You can set the color of the Peak Trace in Setup → Display.
· You can configure the display of the Peak Trace using the Peak Trace feed by Live Trace and the Use smoothing for Peak Trace entry in the popup menu of the button assigned to the Peak Trace.
[bookmark: __RefHeading___Toc41538_2823577171][bookmark: hs4220]Select the trace to feed the Peak Trace
If only one signal is selected for the FFT measurement in the MAT module, then the Peak Trace is feed with the signal currently displayed.
[image: ]If both inputs are selected, then you can select the trace which should feed the Peak Trace from the popup menu of the button  assigned to the Peak Trace.
In this case you can also select both inputs. If both inputs are selected, then the Peak Trace will display the value with the highest amplitude value.

[bookmark: __RefHeading___Toc41540_2823577171][bookmark: hs4230]Use averaged Values for the Peak Trace
[image: ]There are two ways how the Peak Trace can scan for the highest amplitude values:
· The Peak Trace scans the result of each calculation. Doing so, it will capture even short peaks. The trace will be higher than the live trace, because the live trace shows the averaged result of a number of measurements.
· [image: ]The Peak Trace scans the live trace. Doing so, only averaged results are scanned and the peak trace will hold the maximum amplitude values of the live trace.
[image: ]To use the averaged values of the live trace select the Peak Trace feed by Live Trace entry in the popup menu of the button related to the Peak Trace.
You can also select whether the Peak Trace scans the values prior to smoothing or after smoothing is performed.
[bookmark: __RefHeading___Toc41542_2823577171]Reset Peak Trace
[image: ]The Peak Trace holds the maximum values of the input signal(s), therefore you must reset it to start a new measurement.
To Reset the Peak Trace you can either use the shortcut Shift + R or the Reset Peak Trace entry in the popup menu of the button  assigned to the Peak Trace.
[bookmark: __RefHeading___Toc41544_2823577171][bookmark: hs4250]Use live trace's smoothing for the Peak Trace
[image: ]You can select whether the peak trace scans the values of the live trace(s) prior to smoothing or after smoothing is performed.
Scanning prior to smoothing will record peaks which might get lost during the smoothing process.
You can use the Use Smoothing for Peaktrace entry in the popup menu of the button assigned to the peak trace.

[bookmark: __RefHeading__23900_1251909600][bookmark: hs5000][bookmark: Ref_Quicktrace][image: ]Quick Traces
The Quick – traces are designed to store the result of a measurement, so that you can access the measurements quickly and easily.
Most of the tools are available for the frequency-response traces only.
· With the project management enabled, you can mange measurements taken on different locations. See page 248 for details about projects.
· You can average Quick – traces into a so called Sum – trace (see page 283).
· You can use a Quick – trace as the selected trace (see page 286) which can be used for many tools, like the Live – Add Trace (see page 290), the Perfect – Addition Trace (see page 291) or the Delta – Trace (see page 293).
· Depending on the measurement currently selected, the virtual EQ (see page 258), the Peak – Trace (see page 268), the Target – Trace (see page 253) or the Sum – Trace (see page 283) are available in the right area of this menu bar.
· Each Quick – Trace features its own popup menu, see page 271.
· [image: ]The menu   Quick -Trace Setup, described on page 273, controls global settings for the Quick – Traces.
[bookmark: __RefHeading___Toc41546_2823577171][image: ]Visualization
The state of the each Quick – trace is indicated by its symbol.
· The background in the upper area always shows the color assigned to this trace.
· No trace assigned: No black rectangle shown (like trace 4 in the picture above).
· Trace assigned but not shown: A black rectangle shows in the upper right area of the symbol (like trace 2).
· Trace shown: The lower part of the symbol shows the color of the trace. The position of the rectangle in the upper area indicates whether the trace shows inverted (like trace 1) or with normal orientation (like trace 3).
· Trace is the Selected Trace (see page 286): The frame draws with a thicker line (like trace 3).
· Use the entry Scale Quick – Trace Buttons (see page 198) in the Setup → Display section (see page 193) to scale the eight buttons to suit your needs.

[bookmark: __RefHeading___Toc30208_1304982545][bookmark: Ref_qtPopUp]The menu of each Quick – trace
[image: ]There is a popup menu assigned to each Quick – trace. 
Click on the symbol with the right – button to open the popup menu. The header shows the name of the trace. A click on to the top will trigger the Rename function (see page 279).
· Hide / Show Quick – Trace: toggles the visibility of the trace.
· Select Quick – Trace: Sets the Quick – trace as Selected Trace (see page 286).
· [image: ]Assign and Assign without Filter or EQ: Used to assign the current trace to the Quick – trace. See page 276 for details about the assignment.
· Invert flips the display of the Quick – trace on the 0 dB line.
· [image: ]Center Quick-Trace changes the offset in a way that the averaged value of the Quick – trace centers at the 0 dB line. If you click again on this entry, then the previous offset value is restored. To move a Quick – trace vertically select the Quick – trace as the selected trace and move it using the offset setting in the right menu-area. See page 286 for details about how to work with a selected trace. You can use the Center all Quick-Traces entry in the popup menu of the Sum-Trace (see page 283) to change this setting for all Quick – traces at once.
· [image: ]Save use this function to store the Quick – trace to a file.
· The Quick – trace is saved during assignment and it will reload when you restart SATlive. So you need to save a Quick – trace if you want to store it using an other name or type of data.
· The Save function opens a dialog-window where you can set the folder and the name to be used for saving.
· In the selection type of file in the dialog-window you can select a text based file-type instead of the default SATlive – File-Format (*.SLD) to export the data in order to use it with other software.

· [image: ]Clear Single Trace use this function to reset this Quick – trace. To reset all eight Quick-Traces at once, use the Clear all Quick-Traces function in Quick – trace menu bar.
· [image: ]Display Coherence this option, which is available only in the transfer-function measurement, hides or shows the coherence of the Quick – trace. It is available only if the option Global Setting of Show Coherence of Quick Traces is not selected in the Setup → Post Process window. Otherwise the visibility of the coherence is controlled globally for all Quick – traces in the sum trace popup menu.
See page 283 for details.
· Rename opens a small window where you can change the label of the Quick – trace. See page 279 for details about the renaming procedure.
· [image: ]Trace-Layout opens the Trace-Layout window for this particular Quick – trace. See page 301 for more information about using the Trace-Layout window.
· [image: ]Load Quick-Trace contains a sub-menu which contains different functions to import a Quick – trace from a file or from a project. See page 276 for details.
[bookmark: __RefHeading___Toc26770_1754252222]Menu Entries in the Impulse-Response module
[image: ]In the impulse-response module (see page 31) the content of the popup menu differs from the other modules.
It is possible to select the kind of display for this trace in the upper area. See page 41 for details about the different ways to display the impulse – response in SATlive.
The entry Display all data controls the data – display for this Quick – trace. See page 45 for details.
The Choose as main trace function assigns the Quick – trace to the main trace, so that you'll be able to apply the post-processing features to it.
Assigning will void the current main-trace.
For a description of the other entries see the global description of the menu, starting on page 271.

[bookmark: __RefHeading___Toc42285_1773020674]The Menu Quick – Trace Setup
This menu configures the settings that will apply to each of the Quick — Traces.
Use the entry[image: ] Open Menu in the Quick – Trace menu bar at the top of the window.
This chapter covers the menu used in the FFT – module and in the MAT – module.
See the page 275 for the description of this menu in the IR – module. 
· [image: ][image: ] Show single trace's coherence select this option if you want the coherence of each visible Quick – trace to be displayed in the graphic. This setting is available only if the option Global Setting for Show Coherence of Quick Traces in Setup → Post Process (see page 208) is selected. Otherwise you can enable the display of the Quick – trace's coherence of each individual Quick – trace in its popup menu. See page 271 for details about the popup menu assigned to each Quick – trace.
· Show QT on Assign with this option enabled, the quick – trace will display immediately after its assignment. Otherwise, you’ll need to show it manually (see page 278 for details). This setting is global and will affect the assignment of all Quick – Traces.
· [image: ] Stop Generator on Memory Assignment select this option when you want the signal generator to stop after the live trace is assigned to a Quick – trace.
· [image: ]Center All Quick-Traces this option is checked if at least one Quick – trace is currently centered. Otherwise this option is not activated. In this case the activation of this option shifts all Quick – traces vertically so that their average amplitude-value centers on the 0 dB line, which will ease the comparison of their frequency – responses, especial if the traces have been created using different levels.
If you disable this option, the previous vertical position of each Quick – trace will be restored. You can center each Quick – trace with the Center Single Trace option in the popup menu of the Quick – trace (see page 271).

· [image: ][image: ] Project Manager opens the project manager's window, where you can add and rename speakers and traces. The project manager is available only if a project is currently selected. Use the lower window to edit the description of the project. This description is displayed in the file-selection window and in the project setup window as well. 
You can use the key – combination Ctr – P to invoke the project manager. See page 251.for details of Project Management.
· [image: ][image: ] Show Labels show the names of the currently shown Quick – traces in the upper right of the trace display area. See page 270 for details about Quick – traces.
· [image: ]Export all visible Quick-Traces as CSV use this option if you want to export more than one Quick – trace into one file using the CSV format. 
The first lines contain the label of the Quick – traces contained in this file, the next line contains date and time of the creation of the CSV file.
The next line contains the header for the columns, followed by the values.

Hint: 
· Depending on the measurement currently selected, not all entries might be available.

[bookmark: __RefHeading___Toc102407_4135664506]The Menu Quick – Trace Setup in the IR – Module
[image: ]To access this menu click on the menu --symbol [image: ] right to the quick – trace buttons.
This menu allows you to modify the display of all quicktraces at one time.
· Show QT on Assign: If checked, then a quicktrace will show automatically after being assigned. Otherwise you need to show it manually, either by clicking on its symbol in the quicktrace – menubar or by pressing its number on the keyboard.
· The next four entries will change the display – mode for all quick – traces according to the selection. See page 41 for more information on the different display – modes.
· Hide all Quick-Traces: Will hide all quicktraces currently visible. This entry is enabled only when at least one quicktrace is showing.
· The four settings at the bottom of this menu provide different levels of transparency for the display of the quicktraces. Transparency will ease the analysis of multiple impulse – responses at the same time.

[bookmark: __RefHeading__27662_1838177041][bookmark: hs5010][bookmark: Ref_QTAssign]Assign a trace to a Quick-Trace
The most common way to assign a trace to a Quick – trace is to assign the Live – trace to a Quick – trace.
· Assign using a shortcut press and hold the shift key and then press the number of the Quick – trace to which you want to assign the live trace. This will overwrite any trace which was assigned to this Quick – trace before.
· Click on the upper part of the symbol of the Quick – trace using the left mouse button. If a Quick – trace is still assigned, the click will toggle the visibility of the Quick – trace. Otherwise the Live – trace will be assigned to the Quick – trace.
· [image: ]Use the Assign entry in the popup menu. This will assign the live trace to the Quick – trace and a previously assigned trace will be overwritten.
· If you’re applying an virtual EQ (see page 258) or a weighting – filter (see page 103) to the current trace and you want to save it without the effects of this filters use the Assign Without Filter or EQ entry in the popup menu.
· Many functions, like the Sum – Trace (see page 283), the Live – Add trace (see page 290) or the Delta – Trace (see page 293) feature a save result to quick – trace functionality, which can be found in the popup menus assigned to that functions.

· The next entries are located in the sub menu Load Quick Trace in the popup menu of the Quick – trace.
·  Load from File load a trace from a file into the Quick – trace.
· Load from current Project opens a selection tree window, containing all speakers and traces of the current project. Select the trace you want to copy into the Quick – trace and then press the OK button to assign the trace. Any trace previously assigned to this Quick – trace will be deleted.
See page 248 for further information related to project – handling.
· Load from other Project performs like the Load from current Project function, but opens a select-project window prior to showing the file-tree window.
You have to select the project file first, after that the tree window is shown.
· Import from CSV File: allows you to import a frequency response from a CSV style text file.

Hints:
· Depending on the selection of the option Edit Name Window on Assignment in the Setup → Post Process window the Rename function is activated when the trace is assigned to the Quick – trace. See page 208 for details about the setup window.
· After the assignment the Quick – trace will show in the display area.

[bookmark: __RefHeading___Toc36684_3341656882][bookmark: hs5020]Show / hide a Quick-Trace
You can show or hide an assigned Quick – trace either by clicking with the left mouse button on the button assigned to the Quick – trace or by using the number key (1..8) assigned to the Quick – trace. You can also use the Show / Hide Quick – Trace entry in the popup menu (see page 271).
[image: ]In the MAT Module you can enable the display of the coherence trace.
If the option Global Setting of Show Coherence of Quick Traces is checked in the Setup → Post Process window then the display of the coherence is controlled globally for all Quick – traces in the popup menu of the quick – trace menu bar.
Otherwise you can control the display of the coherence trace in the popup menu related to the Quick – trace.
You can change the color, the trace-width or the fill of the trace in the Trace – Layout window assigned to a particular Quick – trace. See page 301 for more information about using the Trace-Layout window.
To change other settings, like offset or smoothing, choose the Quick – trace as the selected trace and use the settings assigned to the selected trace. See page 286 for a closer description of the selected-trace feature.

[bookmark: __RefHeading___Toc41548_2823577171][bookmark: hs5030][bookmark: Ref_qtRename]Rename a Quick-Trace
You can label a Quick – trace. The label is used as the hint assigned to the button and is used in the show value of selection menu and in the selection trees used in the project manager and for the load from current project and for the load from other project function.
To change the label of a Quick – trace use the entry Rename which is located in the popup menu of the button related to the Quick – trace (see page 271).
[image: ]If you've selected the Show Edit Name Window on Assignment option in Setup → Post Process, then the Rename function is executed after you've assigned the live trace to a Quick – trace.
You can click on the icon of the particular Quick – trace in the menu bar with the right mouse-button to invoke the rename function.
[image: ]If the option Append delay-time info to the label is selected then the delay used when the trace was recorded is shown right to the trace text label, both in the Quick – trace menu and in the upper right area of the trace – display window.
The Rename function shows a window, where you can edit the label.
After you've edited the label, you can apply the changes using the button OK.
Depending on the current status, the button Cancel works in different ways:
· [image: ]If you executed Rename from the popup menu of the button related to the Quick – trace, then Cancel closes the rename window without changing the label.
· If Rename is executed by default during the assignment, then Cancel will close the window and stop the assignment. In this case the live trace is not assigned to the Quick – trace.


[bookmark: __RefHeading___Toc50916_477632669]The editor window
This editor window will show when you rename a quick – tr[image: ]ace (see page 279).
You can use the setting Show Tags to toggle the display of predefined labels.
[bookmark: __RefHeading___Toc50918_477632669]Editor using Tags
With the option Show Tags checked a list of pre[image: ]set labels will show below the edit area.
Clicking on a tag will add this tag to the label. The first click will clear the label before adding the tag.
You can also type into the edit field using your keyboard.
· the button Clear will clear the edit area.
· the button ← will remove the last letter in the edit area.
· _ will append a white-space.
· Cancel will close the window and reset the label to its previous value when you entered the window via the menu entry Rename (see page 279).
When the name – edit window showed up automatically during the assignment of a quick – trace, Cancel will also stop the assignment.
· OK will close the window and apply the changes.


[bookmark: __RefHeading___Toc79677_4135664506]Modify Tags
You can modify the tags available in the editor (see page 280) to suit it to your needs.
To do so, just click on the tag you want to modify either using the right mouse – button or hold down the shift – key on your keyboard while you click with the left mouse – button.
This will open an editor window, where you can change the tag.
[image: ]Please note the maximum length of eight characters for each tag.
Click on OK to close the editor and to apply the value to the tag – list. Using the Cancel button will close the window but will not modify the tag.
The tag – editor in the web – client (see page 348) will synchronize the tags during the startup of the web – client.
[bookmark: __RefHeading___Toc50920_477632669]The tag Editor
· Cancel will close the window and reset[image: ] the label to its previous value when you entered the window via the menu entry Rename (see page 279). 
When the name – edit window showed up automatically during the assignment of a quick – trace, Cancel will stop also the assignment.
· Clear will empty the label edit area.
· OK will close the window and apply the changes.

[bookmark: __RefHeading___Toc41550_2823577171][bookmark: hs5040]Save a Quick-Trace
All Quick-Traces are saved during the assignment.
If you want to save a Quick-Trace to a file with another file-name, you can use the [image: ] Save entry in the popup menu of the button related to the particular Quick-Trace.
The Save function opens a file name selection dialog. Just click on OK after setting the file name to save the trace.
You can use the file type selection in the save dialog to select another type of file.
[bookmark: __RefHeading___Toc41552_2823577171][bookmark: hs5050]Clear a Quick-Trace
· To clear a single trace use the Clear Single Trace entry in the popup menu.
· [image: ]The Clear all 8 Memories entry in the Quick – trace menu-bar will clear all eight Quick – traces. If a project is selected, this will clear all traces assigned to the currently selected speaker.
[bookmark: __RefHeading___Toc41554_2823577171]Control via Mouse Click
· Left button in the upper half of the symbol: If the trace contains valid data, then toggles the visibility of the trace, otherwise assigns the current trace.
· Left button in the lower third of the symbol: Sets the trace as selected trace (see page 286).
· Right button: opens the popup menu of the trace (see page 271).

[bookmark: __RefHeading__21849_1251909600][bookmark: Ref_SumTrace]The Sum Trace
SATlive enables you to add some Quick – traces together, so that a new trace, the so called Sum Trace. The Sum – Trace can be calculated using up to eight Quick – traces.
The Sum – trace is calculated using the Quick – traces currently shown. So you can create a Sum – trace only if at least one Quick – trace is shown. The Sum – trace is controlled by the button[image: ] and by the popup menu assigned to it.
[bookmark: __RefHeading__25358_490587637]The popup menu
Open this popup menu using the small arrow right to the sum – trace icon.
· [image: ][image: ]Create Sum Trace calculates the Sum – trace using only the amplitude values. The traces are normalized prior to the calculation,  removing the absolute level information, so this calculation is suitable for averaging measurements taken at different locations.
· [image: ]Complex Add calculates the Sum Trace using both amplitude and phase information. The trace will not be modified prior to this calculation. It will show all interference, like comb – filtering (see page 320) will show, which makes this calculation the best choice when you need to add signals from different sources measured using the same microphone position.
· Valid only if all traces valid if checked, then the sum – trace will contain data only at frequencies where all traces averaged contain valid data.
Otherwise the sum – traces will contain data if at least one trace averaged contains valid data.
· [image: ]Flip Sum Trace mirrors the Sum Trace on the zero dB line. This eases the adaption of an EQ to the Sum – Trace.

· Apply virtual EQ before saving this option defines if a virtual eq (see page 258) currently assigned to the sum – trace will affect the trace when the trace is saved or copied to a Quick – Trace or not.
· [image: ]Save save the Sum – Trace into a file.
· [image: ]Copy Sum Trace into a Quick-Trace copy the current Sum – trace into one of the eight Quick – traces. Select the target quick – trace in the entry's sub – menu.
· [image: ]Trace Layout invokes the Trace-Layout window, where you can customize the display of the Sum Trace. See page 301 for details.
· Hide Quick-Traces after creating Sum if you select this option then all Quick – traces will be hidden when you create a sum trace.

Hints:
· Depending on the measurement currently selected, not all entries might be available.
· You can select the Sum – Trace as selected Trace and use the menu assigned to the selected trace to edit the Sum – Trace.
· [image: ]You can show/hide the Sum Trace using the button related to the Sum Trace or by using the shortcut 0 (Zero).
· [image: ]The names of the Quick – traces used to create the current Sum – trace are shown as the button's hint.

[bookmark: __RefHeading___Toc30777_61384670][bookmark: hs4410]The Info Area
[image: ]The Info Area is located at the top of the trace display.
The following information and menus are available in the center of the Info Area:
· [image: ]The top line shows the name of the measurement currently running. Click on the name with the left mouse button to open a menu to select the measurement from.
· [image: ]The middle line shows the name of the selected trace. Left to the name of the selected trace the color of the trace is shown.
Click on the name or on the color area with the left mouse button to open the Choose trace for value read – out menu to change the trace.
· The bottom line shows the values of the selected trace (see page 286) at the cursor's current position.
[image: ]SATlive shows the current settings of the selected trace in the right area of the info area. The global setting phase offset shows the currently applied shifting to the display of the phase trace. The fourth line at the right area contains the wavelength and half of its value calculated using the current cursor frequency and the settings of the setup → features section (temperature and units).
[image: ]In the left area of the Info Area you can see the display of the frequency – range tool (see page 98). You can invoke the menu of the frequency – range tool (see page 99) by a click with the left mouse click on the arrow symbol at the upper left corner of the info – area. During Auto – Freeze (see page 119) this area shows the frequency.
If you click on the Info Area using the right mouse button, then the setup menu assigned to the selected trace shows up.

[bookmark: __RefHeading__21851_1251909600][bookmark: hs4400][bookmark: Ref_Selected_Trace]Select a Trace
There are two reasons why you might want to select a certain trace.
· You want to know the values of a certain trace and you want to change the parameter used to show that trace. This selection is described in the section Select a Trace for Read – out and Modification (see page 286), and starting on page 287 you’ll find information about how to modify the trace you’ve selected.
· You want to use a certain trace for a calculation. This selection is covered in the section Select a Trace for Calculation on page 289.
[bookmark: __RefHeading___Toc30763_1237155952]Select a Trace for Read – out and Modification
[image: ]There are different ways to choose a trace for the read – out.
Note that you can choose only traces which currently show in the display. You can modify the selected trace using the settings related to the selected trace (see page 287 for details).
· Choose a trace in the sub – menu Choose trace for value read – out of in the popup menu of the trace display.
· Click on the name of the trace in the info – area (see page 285) using the left mouse – button to open the same menu.
· The settings of the selected trace menu (see page 287) assigned to the info – area (see page 285) also contains the entry Choose trace for value read – out.
· Click on the name of the trace above the offset setting in the right menu bar, or on the color indicator left to the offset setting in the right menu bar, to open the Choose trace for value read – out menu.
· Click on the name of the trace, shown in the upper right area of the trace – display.
· Use the key T on your keyboard to step through all visible traces.
Hints: 
· The name of the selected trace will show in the info area (see page 285) and the setting menu (see page 287) in the info area (see page 285) will modify it.

[bookmark: __RefHeading___Toc30779_61384670][bookmark: hs4420]Settings related to the trace selected for read – out
This section covers how to modify the trace that is currently selected for read – out. 
See page 286 for information on how to select a trace for read – out.
[bookmark: __RefHeading___Toc41556_2823577171]The menu assigned to the info – area
[image: ]This menu is the popup menu assigned to the info area and can be accessed with a click onto the info area using the right mouse button.
· The header shows the name of the trace selected.
· [image: ]The next line contains the Flip Trace option, which will mirror the selected trace related to the zero dB line. This might be helpful if you want to adapt an EQ to the selected trace. If the selected trace is inverted then (INV) will show at the end of the trace’s name.
· The entry Trace Layout will open the layout – edit window (see page 301) for the selected trace. Use this window to change the color and the width of the trace.
· The next entry will open the sub – menu Smoothing, where you can select the smoothing to be applied to the selected trace. Please note that some traces might not support smoothing. The sub – menu contains fixed settings and the entry Same as live Trace, which links the smoothing of the selected trace to the smoothing applied to the live – trace.
· If more than one trace is currently visible, then you’ll find the entry Choose trace for value read – out at the bottom of the menu. Use this entry to pick an other trace for the read – out. See page 286 for the different ways to choose another trace as the selected trace.
[bookmark: __RefHeading___Toc41558_2823577171]The Gain Menu in the right menu – bar
[image: ]The gain – menu (see page 90) in the right – menu bar will show the name and the color of the selected trace. Changing of the gain setting will move the selected trace vertically.

[bookmark: __RefHeading___Toc28927_2560284633]Calculations using two Traces
SATlive offers you these calculations using the current measurement and one saved trace:
· Live Add Trace (See page 290), calculates the sum of the selected trace and the current trace.
· Delta Trace (See page 293) calculates the difference between the selected trace and the current trace.
· Delay – Suggestion (See page 296) calculates the delay values that will result in maximum addition of the selected trace and the current trace.
Using the Loaded Trace feature (See page 288) will enable you to perform those calculations using two stored traces.
[bookmark: __RefHeading___Toc30155_2560284633]Loaded Trace
[image: ]The Loaded Trace feature, which you can find in the menu Tools (see page 171), replaces the trace of the current measurement by a stored trace.
This will enable you to perform the calculations using two stored traces.
You can either load a trace from a file or select one of the traces still present (Quick – Traces, Trace-Manager, F5-Trace) from a sub – menu. When you load a trace, it will become the ‘current’ measurement trace. To enable/disable this trace use the Use Loaded Trace entry in the menu.
If the loaded trace is active then the delay settings will be locked. The delay changes to the value used during the measurement of the trace. SATlive memorizes the delay currently set and will restore it when the Loaded Trace will be disabled.

[bookmark: __RefHeading___Toc34484_3605433025]Select a Trace for Calculation.
[image: ]Each of those calculations features a sub – menu, available in the top – menu area.
[image: ]At the top of each menu you’ll find the entry Select fixed trace. Clicking on this entry will show a popup menu from which you can select the trace to be used for calculation.
The calculation will start when you click on the entry.
As long as the calculated trace is not visible, the second line contains a trace – name suggested by SATlive. See the next section for further details on how SATlive will chose this entry. Click on this entry to perform the calculation using the trace listed there.
[image: ]When the calculated trace shows, the entry’s label will change to Hide Trace. Use this entry to hide the calculated trace.
[bookmark: __RefHeading___Toc41560_2823577171]The suggested trace.
SATlive chooses the trace that will show in the second line in different steps, using the sequence listed below. It scans for quick-traces (see page 270), tracemanager traces (see page 235) and for the F5 trace.
1. If a trace has been chosen for this calculation before, it will list this trace.
2. If a trace is currently selected for readout (see page 286 for details), this trace will be listed.
3. If only one trace currently shows, it will be listed.
4. If only one trace is available, SATlive will list it.
5. If none of the above occurs, SATlive will list the latest assigned trace.

[bookmark: __RefHeading__23380_1251909600][bookmark: hs4500]Addition of the selected Trace and the live Trace
There are to ways to calculate the addition of the selected trace (see page 289) and the current measurement.
· Live Addition Trace: Calculate complex sum trace of the selected trace and the live trace. This calculation uses the phase value to calculate the interaction of the two traces.
· [image: ]Perfect addition trace: Calculate the sum of the amplitude values of the traces. This yields the amplitude-response which would be reached if both traces are perfectly aligned in time over all frequencies.
The upper picture shows the situation at the start of the time alignment.
The lower picture shows the same situation with adjusted delay settings.
· Light -Red:	Perfect Add Trace 
· Red:		Coherence - Trace
· Green:	Live Add Trace.
· Blue:		Mid/High
· Brown:	Subwoofer

[image: ]

[bookmark: __RefHeading__24938_1251909600][bookmark: hs4520]Menu Addition of Signals
[image: ]This menu is the popup menu of the cursor details area in the right menu bar, and it is located in the popup menu of the trace display and in the upper menu area.
· The header shows the name of the trace currently selected for this calculation (see page [image: ]289).
· Select fixed Trace opens a popup where you can choose the trace you want to use. See page 289 for details about how to select the trace for the calculation.
· Hide Trace hides the live-add trace. This entry shows only when the live-add trace is currently shown.
· Virtual Time Shift invokes the control window for the virtual – time – shift feature. See page 300 for further details.
· [image: ]Use Offset in Calculation of the Live-Add Trace enable this option if the offset settings should affect the result of the addition.
· [image: ][image: ]Lock Live – Add Trace stops the update trace. A locked trace is indicated by a lock symbol left of its description in the upper right area of the trace display. You can toggle the lock state by clicking on the description in the display area using the left mouse – button. You can toggle the visibility of a locked trace without deleting its content.
· Copy Add-Trace to Quick-Trace stores the currently displayed Live-Add Trace into a Quick – trace. See page 270 for details of the Quick – trace feature. Simply select the target Quick – trace from the sub-menu.
· [image: ]Show Perfect-Addition Trace display the amplitude response of the sum of the live trace and the selected trace, assuming their phase values will match perfectly at every frequency. This is simply the sum of the values of both amplitude – traces.

· Use Offset in Calculation of the Perfect-Addition Trace if you want the offset settings affect the result of the addition for the perfect – addition trace, activate this entry.
· [image: ][image: ]Trace Layout opens a sub – menu which contains different options for the customization of the display.
· Live Addition opens the trace – layout window (see page 301) for the Live Addition trace.
· Perfect Addition opens the trace – layout window (see page 301) for the Perfect Addition trace.
· Show phase – trace toggles the visibility of the phase – trace. Note that only the Live Addition trace will deliver phase – information.
· Bring to front shows the Live Addition trace in front of all other traces.


[bookmark: __RefHeading__24551_148520068]The Delta – Trace
[bookmark: __RefHeading___Toc41568_2823577171]Purpose
[image: ]The delta-trace shows the difference in amplitude between the current measurement and the selected trace. See page 289 for details about how to select a trace for calculation.
The Area of Interaction (see page 295) function, which will indicate different ranges of difference in level, is also controlled by the settings of the delta – trace.
[bookmark: __RefHeading___Toc41570_2823577171]Requirements
· Transfer-function measurement in MAT Module (see page 148).
· A stored trace, valid for the calculation, selected for the calculation. See page 289 for more information about the selection.
· The calculate of the delta – trace is possible only at frequencies where both the selected – trace and the current measurement contain valid data. 
So the current measurement and the selected trace must contain valid data at at least one frequency.

[bookmark: __RefHeading___Toc41572_2823577171]Controls
The Delta trace is controlled by the entries of the menu assigned to the trace. This menu is located in the top – menu area. The Delta trace and the menu are available only during the measurement of the transfer – function.
· [image: ]The top line shows the trace selected for this calculation (see page 289).
· Select fixed trace opens a popup menu, where you can choose the second trace for this calculation from. See page 289 for details.
· Hide trace this entry will hide delta – trace.
· Flip Trace mirrors the trace at the zero dB line.
· Lock Delta Trace freezes the current Delta trace. As soon as the trace is locked, it is not updated anymore. You can show / hide a locked trace without loosing its content. A lock left to the label in the upper right of the trace – display area indicates a locked trace. You can toggle the lock state by clicking on the name using the left mouse button.
· Bring to front shows the Delta trace in front of (nearly) all other traces.
· Mark Area of Interaction controls the visualization of the difference in level (see page 295).
· Show Phase – Trace toggles the display of the difference in phase.
· [image: ]Trace Layout opens the Layout – Window (see page 301) related to the Delta trace. Use this window to configure the display properties of the Delta trace.
· Copy Delta Trace to Quick Trace places a copy of the Delta trace in one of the eight Quick – traces. Select the target Quick – trace from the sub – menu.
· [image: ]Save as allows you to store the Delta trace in a file or to export as a txt or csv type file. Use the file – type selection in the save – dialog to select the file type you want to use.
[bookmark: __RefHeading___Toc41574_2823577171]Additional Information
· The gain setting of both traces will affect of the calculation of the Delta trace.

[bookmark: __RefHeading___Toc27168_2012612786]Interaction Area
As mentioned in the comb – filter section of this document, which starts at page 320, the interaction of two signals depends on their relation in level and on there relation in time. While the comb – filter tool helps you to spot cancellation caused by difference in time, the interaction area indicates the area(s) where we mainly should pay attention to the arrival in time. SATlive uses three colors to indicate the areas with different ranges of difference in level. You can adjust the threshold – values in Setup → Post Process (see page 208).
These values are the default ones:
· [image: ]Minimum difference: Marked red, this range indicates a difference in level ranging from 0dB to 4dB. A difference of 4dB will result in a ripple (difference in level between peak and dip) of the resulting trace of approx +/- 6dB.
· Medium difference: Marked yellow, this range indicates a difference in level ranging from 4dB to 10dB.
A difference of 10dB will result in a ripple of the resulting trace of approx +/-3dB
· Large difference: Marked green, this ranges indicates a difference in level above 10dB
· Areas where at least one trace lacks information will not be colored.
The visualization of the interaction area shows as a semi transparent overlay on the frequency scale(s). You can control its opacity in Setup → Post Process (see page 208).
You can use the Select Area of Interaction entry in the menu of the frequency – range tool (see page 99) to select a frequency range based on the interaction.

[bookmark: __RefHeading__25191_1248855964]The Delay Suggestion Tool
[bookmark: __RefHeading___Toc41576_2823577171]Functionality of the Delay Suggestion Tool
The Delay Suggestion Tool will calculate the addition of both the live trace and the trace selected (see page 289) for the calculation using the phase relation between both traces.
The calculation covers a certain range of time.
The delay values which will yield the best result will show in the result window.
[image: ]The Delay – Suggestion tool menu is located in the calculation – toolbar in the top menu area. See page 299 for details about this menu.
The tool offers three targets for the optimization
· Maximum Power the result targets to as much energy in the selected range as possible. Therefore it will focus on the areas of high amplitude.
· As flat as possible targets to the most flat frequency response in the selected range. The minimum of the standard deviation is the criteria used here.
· Difference of Phase less then +/- 60° optimizes for the most frequency values with a difference in phase below 60°. A phase difference below of 60° will deliver at least 3 dB of addition.
[bookmark: __RefHeading___Toc41578_2823577171]Parameter for the Delay Suggestion Tool
The Delay-Suggestion Tool needs the following parameter:
· Which quick – trace to use. 
This selection is done by selecting the fixed – trace in the menu of the delay – suggestion tool. See the page 289 for details about selecting a trace for calculation.
· The frequency range to check.
By default the frequency range is defined by the visible part of the display window. If an area is marked using the cursor-range tool (see page 96) then the tool will use the marked range for the calculation.
· The time range in which the tool searches for the optimum values.
By default, the tools scans the range from -30ms to 40ms. If you check the Search long time range option in the menu (see page 299), the tools will scan from -30ms up to 250ms.

[bookmark: __RefHeading___Toc30059_1645873506]The display of the results
[image: ]The Delay-Suggestion Tool creates a window of its own to display the results. You can move the window or close it using the Close button. Again will restart the calculation using the most current values of the measurement.
To show a window closed before, use the Show last suggestion entry in the menu (see page 299 for details).
The upper areas show the delay which yields the best fit to the target of optimization.
· If the result is less than zero, then a second value, labeled @Delay > 0ms will show at the bottom of the area. It will report the positive delay which will give the best result. The percentage shown right to the delay time indicates the deviation related to the optimum.
· INV will show right to the delay value when this result was reached with the polarity of one trace inverted.
· [image: ]Click on an area to open a list for a detailed view of the result. The values for a positive Delay will show only when the optimum delay is negative.
This information will help you for example to determine the difference in power if you use a delay on the sub instead on the top in order to keep your system’s latency low while accepting a certain loss of energy.
The bar at the right indicates the optimum.

The third area shows the settings used for the calculation.
· [image: ]The first line contains the frequency range used for the calculation.
· The second line shows the time interval used for the calculations.
· The third line shows the name of the traced used for the calculation.
· If the delay used during the measurement of the selected trace differs from the delay currently used for the measurement, SATlive compensates the difference between those delays. In this case the value used for compensation shows in the fourth line. Otherwise only the first three lines will show.
· [image: ]Click on this area to show or hide the result of a  optimization. The maximum energy optimization will show always.
Hints
· Take care if you use the result for maximum flatness. In this case there could be a strong loss of energy in order to flatten out the results.
· For the alignment in time you should calculate the result only for the crossover area.
· The results of the Delay – Suggestion Tool are copied to the Preset menu of the setup window for the Live-Add Trace. See page Fehler: Verweis nicht gefunden for details.
· The menu Tools of the setup window for the Live – Add Trace (see page Fehler: Verweis nicht gefunden) contains an entry to invoke the Delay-Suggestion Tool.
· Use the entry Show last Suggestion in the Delay – Suggestion menu to show the results again. See Page (299) for details of that menu.
· The results will also show in the pop-up menu of the Virtual – Time – Shift window. See 300 for details.

[bookmark: __RefHeading___Toc32337_990106565]The menu of the Delay – Suggestion Tool
[image: ]The menu assigned to the delay – suggestion tool is located in the calculation toolbar in the top menu – area.
You can also invoke it in the pop – up menu of the Virtual – Time --- Shift window, described at page 300.
· [image: ]Select fixed trace use this entry to select the second trace for the calculation. You’ll find a description of the selection of the second trace for a calculation on page 289. The calculation will start directly after the selection of the trace.
· File Name Suggestion the second line contains a trace chosen by SATlive. You can perform the calculation using this trace by clicking on this entry. See page 289 for further information about this feature.
· Search long time – range check this option to extend the time – interval used for the calculation to -30ms to 250ms. This will increase the duration of the calculation. If the option is not checked the time – interval will range from -30ms to 30ms.
· Show last suggestion will re – open the display – window (see page 297). The results of the last delay – suggestion will be available until you restart a new delay – suggestion or you choose an other kind of measurement.

[bookmark: __RefHeading___Toc31421_1880682800]Virtual – Time – Shift
[image: ]The virtual – time – shift feature, which is available only during the measurement of the transfer – function, allows you to manipulate the phase of the live – trace by adding virtual delay and/or by inverting its polarity. The virtual delay and polarity – inversion is applied prior to other operations, so that the Delta – Trace (see page 293) and the Live – Add Trace (see page 290) will reflect this changes.
To invoke this window either use the entry Virtual Time Shift in the menu Addition of Signals (see page 291) or press the key V on your keyboard.
Use the slider or the arrow keys to change the virtual delay.
The larger arrows will change the value in steps of 0.25 ms, while the smaller ones will change the value by one sample (approx. 0.021 ms).
The arrow at the lower center resets the delay to zero. 
Use the switch on the right to invert the polarity. An inversion of the polarity is indicated by red background color or the switch.
To open the pop-up menu, either click on the menu symbol[image: ]at the upper right or click on the value display.
[image: ]You can choose a predefined value for the delay in the left row. The right row contains the results of the Delay – Suggestion tool (see page 296).
The entry Suggest Delay at the bottom of the right row will open the menu assigned to the Delay – Suggestion tool described on page 299.
Hints
· Closing the virtual – time – shift window will reset all virtual changes.
· The distance shown below the delay – time value is calculated based on the settings in Setup → Features (see page 207).

[bookmark: __RefHeading__23378_1251909600]The Trace – Layout
The trace-layout window enables you to customize the style of each trace displayed.
The trace-layout window is available in the MAT module and in the FFT module.
[image: ]Use the menu entry Trace Layout to invoke the trace-layout window.
This entry is located at different locations, referring to different traces, so that you can configure each trace individually.
· In the popup menu related to trace display, in the sub – menu Layout. Assigned to the live trace.
· In the popup related to the layout-bar on the bottom. Also assigned to the live trace.
· In the popup of each Quick – trace. Assigned to the Quick – trace. For more information about Quick – traces see page 270.
· In the popup menu assigned to the Sum – trace. You'll find details on the Sum – trace at page 283.
· In the popup menu assigned to the selected trace, assigned to the selected trace. See page 286 for more information about the concept of the selected trace.
· Editor for the virtual Eq, assigned to the trace of the virtual eq. See page 258 for more details.
· Editor for the live-add trace. This entry is assigned to the Live-add trace. You'll find more information about the live – add trace starting on page 290.

[bookmark: __RefHeading__21116_189244930]The trace layout window
[image: ]The top of the window shows the name of the trace, which is modified using this window.
[bookmark: __RefHeading___Toc41580_2823577171]Fill to Center
This function fills the area between the trace and the center of the display (in the transfer-function measurement) or to the bottom of the display in the FFT measurement.
You can activate the fill for the phase – trace and for the amplitude – trace separately.
The fill is transparent, so intersections remain clearly visible.




[image: ][image: ]







Hints:
· The changes are applied immediately.
· Use the transparency setting in Setup → Display to modify the transparency of the filled area. See page 193 for information about this setup window.

[bookmark: __RefHeading___Toc41582_2823577171]Trace Width
Select the width of the trace in this area.
[image: ]This setting is used to draw the line of the trace, but does not affect the filling (if any). The changes are applied immediately.
[image: ]







Red: Thin, Lime: Normal, Yellow: Thick and Green: Extra
[bookmark: __RefHeading___Toc41584_2823577171]Color
Click on this area to open the color-selection dialog for the trace. Any change is applied immediately.
[bookmark: __RefHeading___Toc41586_2823577171]Close
Click on this area to close the window.

[bookmark: __RefHeading__24662_1172738176]The combfilter – pattern menu
This menu controls the combfilter – pattern tool. 
You'll finde a close description of combfilters and of the combfilter – pattern tool starting on page 320 in this document.
[image: ]You'll find the menu in the upper menu area. It shows only during the measurement of the transfer – function.
[bookmark: __RefHeading___Toc67561_3203483348]Display Modes
[image: ]The upper three entries active the combfilter – pattern (see page 322) in the display area.
· [image: ]Combfilter Area: 
The pattern shows in the background of the amplitude – trace display. The range of addition is marked green and the range of cancellation is marked red.
· [image: ]Combfilter Arrows:
The points of maximum addition and maximum cancellation are marked with small arrows, where the arrows for the addition show on the top of the display area and the arrows for the cancellation show on the bottom of the display area.
· [image: ]Combfilter Bar:
This display uses the same colors as the Combfilter Area display, but it shows as a solid bar at the bottom of the display area.


Hint: You can use multiple displays at the same time.

[bookmark: __RefHeading___Toc29665_1773020674]Calculation Control
[image: ]The next entries in the menu affect the calculation of the combfilter – pattern (see page 322).
· Cursor is Addition activate this entry if you want to use the cursor position as the frequency of the maximum addition instead as the frequency of the maximum cancellation.
· Shift Right and Shift Left modify the shift factor (see page 323) used for the calculation of the combfilter – pattern.
· Reset Frequency Shift resets the shift factor (see page 323) to its default value of 1, which means that the cursor represents the cancellation (or addition) with the lowest frequency value.
· Reset Combfilter Display hides all combfilter – patterns (see page 322) resets the shift – factor (see page 323) to 1 and the deactivates the Cursor is Addition option.

[bookmark: __RefHeading__23376_189244930]Markers
[image: ]Markers are vertical lines which you can use to mark a frequency or a time of interest.
Furthermore time – markers will server as delay – memories.
Markers are available in the impulse-response, in the frequency-response display and in the delay – finder window (see page 135).
A marker will display as a dashed line marking its position and a 'head' containing the information about its position.
Moving the mouse to the ‘head’ will show further information.
[image: ]You can use the delay – matrix to calculate difference in time between each time – marker. See the page 46 for more information about the Delay – Matrix.
[bookmark: __RefHeading___Toc41588_2823577171]How to set a marker
Perform these steps to set a marker
· Place the cursor at the frequency or time you want to mark.
· On your keyboard, hold down the Alt key and press a number key, ranging from 1 to 6 for frequency – markers and ranging from 1 to 10 for time – markers.
The number pressed becomes the ID of the marker.
· You can assign a marker that has not been assigned yet by a click on its label in the in the menu time – marker (see page 308).
· If the option Edit Label on Assign in the menu Marker (see page 308) is selected, then the Name Editor for the Marker will show up when you assign a marker.


[bookmark: __RefHeading___Toc41590_2823577171]How to show or hide a marker
There are two ways to show or hide a marker. You can show only markers that have been assigned.
· [image: ]On your keyboard, hold down the CTRL key and press the ID (number) of the marker you want to show or hide. Use 0 (zero) for the time – marker 10.
· You can click on the label of a marker in the sub – menu Marker (see page 307) to show or to hide a frequency marker.
· You can set the visibility of a time – marker in the menu Time Marker.
[bookmark: __RefHeading__22804_189244930]The Sub – Menu Marker
This sub menu is located in the popup menu assigned to the trace-display area. Its content varies with the measurement currently running.
The menu Time Marker (see page 308) is available in the IR – Module, in the Delay – Finder and, during the measurement of the impulse – response (see page 130), in the pop – up menu of the trace – display area (see page 93).
The menu Frequency Marker (see page 309) can be found in the pop – up menu of the trace – display during the measurements transfer – function, FFT, FFT + Spectrograph and impedance in the MAT – module and in the FFT – Module.

[bookmark: __RefHeading___Toc35651_3672662817]Time Marker
[image: ]On page 306 you'll find more details related about how to use markers in SATlive.
This menu will show when you choose the entry Markers in a menu.
· Delay Matrix invokes the Delay Matrix described on page 46. Use the Delay Matrix to calculate the difference between two time markers.
· The next ten lines contain the labels of the time markers. Click on a label to open the sub – menu time – marker (see page 309 for details).
· Show all Markers enables the display of all valid time – markers. This entry is available only if at least on valid time – marker is not showing.
· Hide all Markers hides all time – markers currently shown. Available only if at least one time – marker is showing.
· Reset all Labels resets the labels assigned to all ten markers, but not the position values, to the default labels Marker X.
· [image: ]Clear all Markers resets both the data and the label of all ten time markers.
· Edit Label on Assign activate this setting when you want the Label Editor (see page 310) to open up each time you assign a marker.
In this case you must exit the editor – window using the OK button in order to complete the assignment.
· Show marker on assign. If you disable this option then the marker will not show after its assignment. Otherwise its visibility will be set to on during the assignment.
· Read from file allows you to load all ten time – markers from a file.
· Save to file exports all ten markers
· Show True – Zero Marker activate this option to mark the real time zero in the display of the impulse – response (see page 130 for details). The impulse – response relates to the current delay, so the real time zero is shifted by the value of the current delay.

[bookmark: __RefHeading___Toc47912_3672662817]Single Time Marker Menu
[image: ]This menu will show when you click on one of the time – marker label in the time – marker menu (see page 308).
· The header shows the label of the time – marker.
· Show Time – Marker show the time – marker in the display.
· Hide Marker hide the time – marker.
· Rename Marker open the editor for the label of the time – marker (see page 310).
· Clear clear the data assigned to the time – marker and reset its label to the default value Marker X.
[bookmark: __RefHeading___Toc45452_3672662817]Frequency Marker
[image: ]This menu will show when you click on the entry Marker in the pop – up menu of the trace – display area (see page 93) in a frequency – domain based measurement.
· The upper six lines refer to the six frequency – markers.
· Click on a line to toggle the visibility of the marker assigned to it.
· To access the editor for the label (see page 310) hold down the shift key on your keyboard while clicking on the entry.
· Reset all labels will reset the label of all six labels to their default value Marker X.
· Clear all markers will remove all data assigned to the markers and will reset their labels to the default value Marker X.
· Edit Label on Assign with this option checked the editor for the label (see page 310) will show up each time you’ll assign a marker.
Please note that you’ll need to close the editor using the OK button in order to complete the assignment.

[bookmark: __RefHeading___Toc30925_1773020674]Edit a label of a marker
[image: ]You can edit the label of a marker in the Label Editor. This small window contains an edit area where you can change the current label.
There are different ways to open this window:
· If you've activated the Edit Label on Assign option in the menu Marker then the Label Editor will show each time you assign a position to a marker.
See pages 307 and 309 for a description of this menu.
In this case you must exit the editor – window using the OK button to complete the assignment. Closing the window using the Cancel button will void the assignment.
· In the menu Marker for frequency markers (see page 309) hold down the Shift key on your keyboard and click onto the marker whose label you want to change. This will open up the Label Editor for this trace. See page 307 for a description of the sub menu.
· In the Delay Matrix (see page 46), which is available in the impulse response display only, you can invoke the Label Editor by holding down the Shift key while clicking on the label assigned to the marker.

[bookmark: __RefHeading__22395_1518725143]Configuration Handling
The configuration handling, which is currently available in the measurements Transfer – Function and Impulse – Response, both in the MAT module, allows you to store and recall up to ten different settings for the trace display.
[bookmark: __RefHeading__22392_1518725143]Information contained in the Configuration
· Kind of measurement
· Gain (Transfer-function only)
· Y-Range 
· Line-gap  (Transfer-function only)
· Averages
· Size of IR (Impulse-response only)
· Zoom of the lower IR display (Impulse – response only)
· Amplitude Threshold (Transfer – function only)
· Coherence Threshold (Transfer – function only)
· Noise Threshold (Transfer – function only)
· Position of the vertical split
· Frequency Range displayed (Transfer – function only)
· The waveform of the output signal (only if enabled in the menu).
[bookmark: __RefHeading__33575_1082827234]The Configuration menu
[image: ]You can open the configuration in different ways:
· Select the Configuration entry in the layout sub-menu of the popup menu assigned to the display area.
· Select the Configuration entry in the popup menu assigned to the layout-edit section.
· As the popup menu of the right menu area.
· Use the key K on your keyboard.
· Click on the configuration menu – bar. See page 313 for details.
· Click on the menu bar Configuration.

[bookmark: __RefHeading___Toc41594_2823577171]Menu entries
· [image: ]At its top the menu contains a list of ten entries, either showing the label and some of the values assigned, or in the case that no configuration has been assigned the message No configuration assigned. 
The icon on the left indicates the measurement assigned to this configuration.
To recall a configuration, just click on the entry to load the settings.
If you click on a No configuration assigned entry, SATlive will open the Assign configuration window.
· Assign configuration this entry opens the Assign – Configuration window, described on page 313. To assign the current measurement including its settings, use either this entry or click on a No configuration assigned entry.
· Clear all configurations deletes all the settings stored in the configurations.
· Show Configuration – Bar activate this function to display the configuration – bar (see page 313) in the upper menu area.
· Activate on selection recalls the selected configuration as soon as you select it in the configuration – bar. If this option is not activated, then you have to recall the selected configuration using the recall button in the menu – bar. See the page 313 for a closer look to the configuration menu – bar.
· Control Audio Output with this option enabled changing the configuration will also change the wave – form of the signal – generator (see page 226). Otherwise changing the configuration will not affect the signal – generator.

[bookmark: __RefHeading__25930_2001208651]The Assign-Window
To assign the current measurement and its settings (see page 311 for a list of the settings handled by the configuration tool) to a configuration, click either on the Assign Configuration entry or on a No configuration assigned entry of the configuration menu.
This will open the Assign Configuration window.
[image: ]Click on an entry in the Select Target area on the left to choose the location to store the settings to.
You can edit the label of the configuration selected in the Label area on the upper right. The label will show in the configuration menu.
To save the configuration click on the OK button, to close the window without saving the current setting click on Cancel.
Please note: Saving the current settings to a location which still contains settings will override the settings without asking for confirmation.
[bookmark: __RefHeading__30661_1082827234][image: ]The configuration menu – bar
If the option Show Configuration – Bar is enabled in the menu Configuration (see page 311) then the configuration menu – bar will show in the upper menu area. The bar shows the name of the last used configuration.
This menu – bar is available only in the measurement of the impulse – response and of the transfer – measurement.
A click onto the menu – bar will open the menu Configuration (see page 311 for details).

[bookmark: __RefHeading__25361_1307676328]Averages
[bookmark: __RefHeading___Toc41596_2823577171]Basics
Averaging means that you take the results of different measurements of the same system and calculate an averaged value for the result.
Because external noise is not the same during all the measurements, its influence on the result is reduced by the averaging process. Averaging does not reduce effects related to the measurement, like clipping or resonances. 
As higher the amount of averages as better is the suppression of random interference like external noise. 
[bookmark: __RefHeading___Toc41598_2823577171]Averaging in SATlive
SATlive supports averaging for all measurements. Except for the RTA (see page 147), which averages over a certain period of time, all measurements use the averaging of different counts of measurements.
[bookmark: __RefHeading___Toc41600_2823577171]Fixed number of averages
This setting allows the user to select the amount of measurements to be averaged for the result. The amount of averages ranges from 2 up to 64. 
A higher amount of averages means better rejection of external interference, but takes more time.
[bookmark: __RefHeading___Toc41602_2823577171]Average all Values
This setting averages all measurements since the start or since the reset of the current measurement. The quality of the result increases when the amount of averages increases.  This setting yields very stable results when you allow enough time for measurement, especial if you select the RMS Averaging mode (see page 315) in the transfer – function measurement.
Due to the large amount of averages, the display responds very slow to changes, especial after a longer time of measurement. Therefore you should restart the measurement each time you changed something in your signal – path.

[bookmark: __RefHeading__25356_1307676328]Dynamic Averaging (Transfer – Function only)
The transfer – function measurement uses smooth – FFT calculation (see page 242), which causes very fast measurements at high frequencies, but long measurement times in the area of low frequencies.
Dynamic Averaging uses higher values for the high – frequency range as for the mid and low frequency – range, so that the quality improves in the mid/high range without extending the time needed for a full-frequency result.
There are three presets for the dynamic-averaging available in the popup menu of the trace – layout area (see page 175).
[bookmark: __RefHeading__26134_1307676328]Algorithm used for averaging (Transfer – function only)
There are two different algorithms available for the calculation of the transfer – function. 
· The default one, called complex averaging averages both values (real and complex part) of the complex transfer – function. This calculation delivers both, the phase – trace and the amplitude trace.
· [image: ]The RMS averaging calculates the amplitude trace before the averaging takes places. Therefore the result does not contain information about the phase, but has even better rejection of external interference. 
The RMS averaging is indicated by the letters RMS in the value – edit field.
[bookmark: __RefHeading__25363_1307676328]The setup – menu
[image: ]The setup menu for the averages, whose content varies depending on the measurement selected, is available in the trace – layout area in the bottom menu area and as a sub – menu of the entry layout in the popup menu of the trace display.

[bookmark: __RefHeading___Toc41604_2823577171]Part two: Using SATlive
[bookmark: __RefHeading___Toc32613_2560284633]Open a File
SATlive uses its own file – selection window to ease the selection of the file to load.
[image: ]See the next pages for a closer description of each section.
· Left top: folder – selection (See page 317).
· Left bottom: file – information (See page 317).
· Right top: file – type selection (See page 318).
· Right upper: file – list (See page 318)
· Right bottom: file – preset area.

[bookmark: __RefHeading___Toc33845_2560284633]The Folder – Selection
[image: ]Use this section, which is located in the upper left area of the file – open window (see page 316) to select the folder where the file is located.
To open a folder just click on the plus – sign left to the folder’s name.
If the folder is opened then a minus – sign shows left to its name. In that case a click on the sign will close the folder.
To select a folder just click on its name.
[bookmark: __RefHeading___Toc35083_2560284633]The Info – Section
[image: ]The info section, located at the lower left area of the file – open window (see page 316), shows information about the content of the file currently selected.
Full information is available only for files created using the SATlive – data format (*.SLD).

[bookmark: __RefHeading___Toc29105_1122110466]The File – Type Selection
[image: ]At the upper right area you find a selection box, where you can select the type of file you want to load.
The SAT File is the default *.SLD file, which will cover nearly all situations. The other selections, which are available depending on the measurement selected, can be used to import older file formats or files created by other applications.
[bookmark: __RefHeading___Toc29107_1122110466]The File – List
[image: ]The file – list shows all valid files available in the selected folder. 
Please note, that the files are filtered according to the setting of the file – type selection and based on the intended purpose. For example, no impulse – response files will show during a measurement of the transfer – function.
[image: ]You will find a description of the filter currently used in the status bar at the bottom of the window.
As soon as you click on a file – name, this file is selected and the info – area (See page 285) shows details about the selected file.

[bookmark: __RefHeading___Toc41606_2823577171]The Folder – Preset Area
[image: ]At the lower right of the file – open window you can find five preset buttons. You can assign a folder to each button and afterwards a click on the button will navigate to that folder.
The Cancel button closes the window and discards your selection, while the OK button keeps your selection.
[bookmark: __RefHeading___Toc41608_2823577171]Assign a Folder to a Button
If no folder is assigned to the button, simply click on the button to assign the current folder to it. The function Assign current Folder in the popup menu (See page 319) of each button assigns the current folder to the button, regardless if an other folder as been assigned before.
[bookmark: __RefHeading___Toc29109_1122110466]The popup menu of each button
Each of the five folder – preset buttons contains a popup menu. To invoke the popup menu, click on the button using the right mouse button.
· [image: ]Go to Folder navigates to the folder assigned to this button.
· Assign current Folder assigns the currently selected folder to the button. This will overwrite any folder previously assigned to this button without a warning.
· Clear Latch removes the folder link from this button.
· Clear all Latches removes all five folder links.

[bookmark: __RefHeading__26642_1819804763]Combfilter
[bookmark: __RefHeading___Toc41021_1773020674]What is a combfilter?
The combfilter is one of the basic problems you'll face when you try to optimize a sound system. A combfilter occurs when the same signal reaches the same point more than once, with a delay between the arrivals. If both signals have similar amplitude values, then a certain pattern containing cancellations and additions occurs.
The spacing between the dips is constant in time and defined by the difference in time between the arrivals of the signals.Combfilter create[image: ]d using 250 us delay

This pattern is called a combfilter.


[bookmark: __RefHeading___Toc41610_2823577171]Which parameters affect a combfilter?
Mainly there are two parameters which affect the combfilter. 
The first is the difference in time between the two signals.Violet: 125us delay, [image: ]yellow: 250us delay

The distance between two dips is given by 1 /T, where T is the difference in time.
The first cancellation occurs after half of the distance, which yields 
f1 = 0.5 / T. 

The second factor is the difference in level. If both signals share the same level, then the addition and the cancellation will be perfect, which means that there is a maximum addition of 6 dB and a total cancellation. While the level –  difference increases, the ripple of the resulting signal will reduce. You can use the Interaction – Area function (see page 295) to indicate the frequencies where the difference in level is low.Violet: Same level, yellow: 3dB, green: 6dB, 
brown: 9dB, red: 12dB [image: ]difference in level

[bookmark: __RefHeading___Toc41612_2823577171]Dealing with Combfilters
Because a combfilter is an effect caused by time-difference you can not correct it in the frequency – domain using an equalizer or controller. Furthermore, the pattern of a combfilter changes for every location, because the difference in time will vary. 
Therefore the only approach possible is to try to minimize the comb – filtering.
· Avoid the arrival of a signal from more than one source wherever possible. Try to let only one signal reach a listener's position.
Try to aim your speakers properly, so that each speaker covers its own area.
· Avoid or reduce reflections: reflections, especial the early ones, are similar to your source signal, both in content and level. So avoid and reduce any, especial early, reflections. Avoid putting speakers, especially those reproducing high and mid-frequency content near reflecting surfaces like walls, ceilings or closed windows. If you can not change the position, try to damp the reflections by treating the surfaces.
· Sync both signals in time. If you could not avoid overlapping, you should try to archive a synchronous arrival of the signals.

In order to locate the reason for a comb – filter it will be very helpful to know the difference in time and distance of both paths from the source to the listener.
The comb – filter pattern tool is designed to help you to locate these values.

[bookmark: __RefHeading__27968_1310246189]The Combfilter – Pattern Tool in SATlive
The starting point when you try to locate the reason for a combfilter is to find out the difference in time that caused the combfilter. This will lead to physical distance, calculated from the speed of sound, temperature and the difference in time. 
Knowing this distance, you can start the search for the source of the second signal. In most cases this would be a surface generating a strong reflection.
[bookmark: __RefHeading___Toc41614_2823577171]How to find the difference in time
Based on the basics mentioned above, it is possible to calculate the difference in time if you know the frequency of the first cancellation. 
But not any cancellation is caused by a combfilter, and not always all cancellations are clearly visible. So the best way to locate a combfilter is to compare the amplitude trace with the pattern of a perfect combfilter.
SATlive can show this pattern in order to help you to locate the combfilter.
[bookmark: __RefHeading__25375_204716178]The combfilter pattern tool
The combfilter pattern tool calculates a perfect combfilter based on the frequency of the cursor's position and indicates the position of the additions and  cancellations.Combfilter pattern tuned to the frequency response[image: ]

There are three different ways of displaying this. Please see the description of the menu (see page 304) for details about the different ways of displaying the areas of addition and cancellation.
[image: ]The difference in time and the physical distance calculated from it is shown above the trace display.
You can change both the temperature and the units used for the display and the temperature in Setup → Features (see page 203).

By comparing the amplitude trace to the combfilter pattern, you can decide whether the dip is caused by a combfilter or by another problem.The pattern does not fit to the amplitude trace[image: ], so the dip is not caused by a combfilter.






[bookmark: __RefHeading__25377_204716178]Using the Shift – Factor
It is possible that you put the cursor on an other cancellation as the one with the lowest frequency. In this case, the pattern will not match, too. The spacing of the cancellations will be too wide for the amplitude trace.The cursor is not on the first cancellation, so the pattern does not match the trace.
[image: ]Note that there is a cancellation where the pattern indicates one. Compare to previous image.

You can shift the position of the cancellation to solve this problem.
When you shift, the calculation of the combfilter pattern is performed assuming that the cursor is located on an other cancellation than on the cancellation with the lowest frequency.
The number of cancellation starts with one at the lowest frequency and increase towards higher frequencies. So the standard shift factor is one, but you can increase it.

To increase the shift factor, either use the key B on your keyboard or the entry Shift Right in the menu (see page 304).Shift factor set to two. Now the pattern fits to the amplitude response[image: ]

If you've increased the shift factor then you can decrease it using the key combination shift – B on your keyboard or the entry Shift Left in the menu (see page 304).
Use the entry Reset Shift Factor in the menu (see page 304) to reset the shift factor to one. You can also use the key O (letter) on your keyboard to reset the shift factor.

[image: ]As long as the shift – factor is higher than 1, the shift – factor is displayed in the info – display in addition to the values of the combfilter – pattern. 

Using the option Cursor on Addition in the menu (see page 304) you can put the cursor on the frequency with the maximum addition instead on the frequency of cancellation, but in most cases the cancellation is easier to detect as the maximum addition. Furthermore the width of the area of addition is wider than the area of cancellation and the cancellation often shows a low correlation value.

[bookmark: __RefHeading___Toc41616_2823577171]Administrate Projects
[bookmark: __RefHeading___Toc41618_2823577171]Basics
Projects consist of two different kind of files. Beside of the trace – data files, which contain the data of each individual trace, there is the project – file.
The project -file contains the common data of the project, like the location and the name and the location of each Quick – trace.
Therefore the project – file acts as a kind of 'master mind' for the whole project.
Due to this combination of files, you must take some care when you want move the files to another location.
[bookmark: __RefHeading___Toc41620_2823577171]Moving the project – file
You can move the project file without any problem as long as the file remains on the same computer, so that the access to the stored trace – files using the stored file – name remains possible.
You can either use the Save As entry in the setup – project section (see page 248) or you can move the project – file outside of SATlive using the windows explorer.
Moving the project – file to an other computer will break the links to the trace – data files, so that the project will not work anymore. Use the Export Project function (see page 326) to transfer the whole project to the new computer.
[bookmark: __RefHeading___Toc41622_2823577171]Moving the project directory
Because the links to the trace – data files are kept in the project files, it is neither possible to move or rename any of the trace – data files nor to rename or to move the folder ('directory') containing the trace – data files.
That directory is defined in the Setup – Project section (see page 248), where it can be changed at anytime. All files stored before the change will remain at the previously defined folder and will be still accessible due to the full file – name stored in the project – file.
Any file assigned after the change will be stored in the new folder.
To move the trace – data files to an other location, either on the same computer or on an other pc, you need to export the project and import it afterward. See page 326 for details.
This is the only way to ensure that the links in the project – file remain intact.

[bookmark: __RefHeading___Toc41624_2823577171]Delete a project
When you delete only the project – file, all trace – data files will remain as orphans in the project – folder.
The Delete function located at the left bottom area of the Project – Setup section (see page 249) removes, both the project file and all files linked to it.
[bookmark: __RefHeading___Toc33273_1174202529]The export / import window
[image: ]Use the button Export / Import Project at the lower left area of the Project – Setup section (see page 249) to invoke this window.
[bookmark: __RefHeading___Toc41626_2823577171]Operation of the import / export function
[image: ]Both the export and the import of a project is performed in several steps.
You'll find a short description of the next step at the lower left area of the window.
Use the NEXT button to proceed to the next step.
[image: ]The window starts up with the selection of Export or Import. Choose the desired operation by a mouse – click on the corresponding button.

[bookmark: __RefHeading___Toc24998_12105137]Export of a project
The export will create a project – package file, which is a single file containing all the information of the project – file and all the trace – data. 
You can use this file to transfer all data of a project easily.
For the export perform these steps:
[bookmark: __RefHeading___Toc41628_2823577171]Select the project file to export
A file – selection window opens up, where you can select the project – file which you want to export.
[bookmark: __RefHeading___Toc41630_2823577171]Verify the project – file
Now the content of the project – file is shown in the window. At the top you'll find some of the data entered in the Setup – Project section (see page 248). Below the names of all speakers contained in the project show up, each followed by the file – names of the trace – data files associated to this speaker.
You can use this information to verify that you've selected the correct project – file.
[bookmark: __RefHeading___Toc41632_2823577171]Choose the name of the project – package file-load
An other window opens up, where you can select the folder and the desired name for the project – package file. If you select a file that is still present a warning will show up.
[bookmark: __RefHeading___Toc41634_2823577171]Start the export
Now the project – package file is created and populated with all the trace – data information assigned to the selected project.
Depending on the amount and on the size of the trace – data files, this step might take some time.
[bookmark: __RefHeading___Toc41636_2823577171]Close the window
After the end of the creation of the project – package file, the label on the right button changes to DONE. Click on it to close the window and to return to SATlive.

[bookmark: __RefHeading___Toc41638_2823577171]Import a project – package file
You can import a project – package file, which has been created using the export section of this window (see page 327). During the import you can define the name and folder for the project – file and the project – directory where you want to put the trace -data files into.
SATlive will modify the project file according to the settings, therefore you can use this functions to move the trace – data files without destroying the project – configuration.
The steps for the import are:
[bookmark: __RefHeading___Toc41640_2823577171]Select the project – package file
After clicking on the IMPORT button on the first page of the window, a file – selection window opens, where you can pick the project – package file which you want to import.
You can import only project – package files.
[bookmark: __RefHeading___Toc33847_2560284633]Choose name and folder for the project file
In the next step you can set the name and define the folder for the project – file. If you choose a file – name still in use, then a warning message will show up.
[bookmark: __RefHeading___Toc41642_2823577171]Choose the folder for the trace – data files
Now you need to define the project – folder ('directory'), which is the folder where all the trace – data files will be copied to, and where all traces you will assign will be saved in.
[image: ]In order to avoid that a trace still present is overwritten during the import or when you assign an other trace to this project, it is strongly recommend that you use an empty folder or create a new folder for this data.
A warning message will show up, when you choose a folder which still contains SATlive data – files. 
Click on Ignore to use the selected directory, click on Retry to select an other folder or click on Cancel to close the import – export window without importing the project – package file.

[bookmark: __RefHeading___Toc41644_2823577171]Perform the import
During the next step, which might take some time depending on the amount and size of trace – data files contained in the project – package file, SATlive will create the project – file and expands the trace – data files into the project – folder.
All the links to the trace – data files are updated to match the new location of the traces.
[bookmark: __RefHeading___Toc41646_2823577171]Finish and close the window
[image: ]As soon as the import finishes, some of the information contained in the project -file shows in the window.
Below of the information you can find the Load Imported Project in SATlive option.

If this option is selected (default setting) then the project – file imported is loaded as the current project – file in SATlive when you leave the window with a click on the Done button. 
Do not forget to save the changes when you leave the setup – project section.

[bookmark: __RefHeading__23847_1682689129]Direct Reference
[bookmark: __RefHeading__22826_1819804763]Basics
Over more than a decade the Dual – FFT is used for Audio measurements, especial for live sound reinforcement.
The Dual – FFT needs two signals for the calculation. One signal is the measurement signal, which in most cases is picked up by a microphone. 
The other input-signal needed is the so called reference signal, which is fed into the system under test. Using those two signals enables the Dual – FFT to perform with a lot of different signals.
[image: ]In most situation the audio signal used for measurement is generated by the measurement software itself.
In most cases a simple cable loop is used to feed this signal direct into the reference input.

[image: ]The Direct-Reference feature in SATlive uses the internal output of the software to feed it into the reference signal. This avoids the loop-back cable, which frees one input and allows SATlive to operate with audio interfaces which feature just one input (or with an interface that delivers the microphone signal on both inputs).

The internal link has some tradeoffs:
· There is a delay between the two signals, which is affected by many factors. On some audio interfaces this delay might vary on every start of SATlive.
· The reference signal lacks the influence of the D/A and A/D conversion performed on the measurement signal. Therefore the amplitude-response of a direct connection between the output and the measurement input is not flat anymore, neither in phase nor in amplitude.
· The measurement is limited to the signals generated by SATlive.
The software features a build in delay to compensate for the difference in time and a possibility to flatten the frequency-response.
[bookmark: __RefHeading__23600_1270454357]Using Direct Reference
[bookmark: __RefHeading___Toc41648_2823577171]Select the Direct-Reference Input
· Go to Setup → I/O devices
· Select the ASIO driver type in the upper left area (see page 180)
· Select the ASIO device you want to use in the area below
· Click on Edit ASIO Settings (see page 187)
· In the ASIO setting window, either choose an existing connection and press EDIT or press NEW to create a new assignment.
· In the Edit window select DIRECT – REFERENCE as the Audio Input Ref,
and the input where your measurement signal will arrive as Audio Input Mea.
· Close the window using the OK button.
· Close the ASIO setting window using the Apply button.
· Save your settings using the SAVE button in the menu bar on the top.

[bookmark: __RefHeading__20956_1819804763]Adjust the Direct-Reference settings
In order to compensate the delay and the difference in frequency response, perform the steps listed below. 
The Direct Reference input assignment must be selected.
· Setup a simple 'loop' measurement, by just connecting the output with the measurement input. Make sure that the phantom-power is not enabled.
· Start a transfer-function measurement with pink noise. (see page 124)
· Either use the delay-finder (see page 135) or the automatic delay (see page 144) to set a delay for the display.
· Now you should see a full, nearly flat phase and amplitude response.
· If the trace does not look good, you need to reset the Direct-Reference delay in the delay-finder first. Just open the delay-finder (see page 135) and click on RESET.
After that, try again to set the delay.
· Navigate to Tools → Direct-Reference and click on Auto set Direct-Reference
· Now you're ready to go.

Hints
· The latency of some ASIO drivers, especial ASIO converters for internal soundcards, might vary on each restart of the driver. Therefore your delay-setting might be correct only until the driver restarts.
· If you want to use an internal audio-device, which has no ASIO driver available, you might check out ASIO4all (http://www.asio4all.de).
· You'll find a deeper description of the direct – reference menu on page 151

[bookmark: __RefHeading___Toc752_2300379342]The Web – Control
The web – control allows you to control SATlive via network.
· Currently only the MAT Module is supported.
· Javascript has to be enabled in your browser and the browser must support HTML5 functionality, which is true for all ‘up to date’ browsers.
1. At least one ip – address has to be selected in the net – control setup window. See page 214 for details on this setting.
[bookmark: __RefHeading___Toc41650_2823577171]Connect to SATlive
[image: ]


[image: ]To start a connection to SATlive make sure that SATlive is running and that at least one valid ip – address has been enabled in the net – control setup window (see page 214 for details).
Now start your browser and navigate to the ip – address selected.
If you changed the port setting to a value different from 80, you need to add a colon and the port number to the ip – address.
SATlive shows the ip – address below the signal – generator at the lower right and in the version – information window (press Ctrl + Alt + V to view).

[bookmark: __RefHeading___Toc41652_2823577171]Hints:
· The web – client adapts to the size and resolution of your device. Therefore the display on your device might differ from the pictures in this document, but all functions will be available.
· The browser must support javascript and HTML 5 to show the web client.
· The web-client does not need a connection to the internet, but the network of some mobile devices might not work properly while not connection to the internet is established. 
· [image: ]Some entries of a menu are linked to an other menu. When you click it the other menu will show. An arrow at the right side indicates that an other menu is linked.
· If the connection fails, check the settings of the firewall of the computer running SATlive.
· The display settings will be stored on the device and will be recalled during the next start of the client.

[bookmark: __RefHeading___Toc959_2300379342]The areas of the web – client
The web – client consists of different sections. See the next pages for details about each section. The description contains information about the values shown and the menus assigned to the area.
· [image: ]The Top bar (see page 336).
· The Info bar (see page 338).
· The Trace display 
(see page  338).




· The Parameter bar 
(see page 342).
· The Quick – trace area(see page 346).


· Control buttons (see page 349).

· Status area (see page 350)

[bookmark: __RefHeading___Toc26233_6142990361][image: ]The top bar
[bookmark: __RefHeading___Toc606_676710535]Display
[image: ]The top bar shows the type of the currently selected measurement.
During a measurement of the transfer – function the delay – status is displayed in the top bar. 
In this case the symbol on the left indicates the polarity and the symbol on the right the match of the delay values. A vertical green line at the center indicates the correct setting of the delay, otherwise a red line will show.
An inversion of the polarity will change the horizontal line at the left to red.
On the right side you’ll find the VU Meter showing the input levels.
[bookmark: __RefHeading___Toc26601_12387279501]Actions
· Click on the delay – status at the right selects the delay value calculated for the current data as the current delay for the measurement.
· [image: ]A click on the center of the top – bar to open the display – mode selection. 
To select a measurement simply click on the menu entry. You can find this menu in the menu Main (see page 337) also.
· Click onto the symbol Menu at the left to open the menu Main of the web – client.
See page 337 for details.
[bookmark: __RefHeading___Toc41654_2823577171]Hints
· To open the delay – finder (see page 340) use the entry Delay – Finder in the menu Delay (see page 343).
· To show just one of the two display areas of the transfer – function click on the entry assigned to it.
· To return to the transfer – function measurement using the previous display mode, click on the entry Transfer-Function.
· Except for the Delay – Matrix (see page 340), a selection of a measurement will change the measurement globally.

[bookmark: __RefHeading___Toc718_2300379342]The menu Main
[image: ]To open the main menu click onto the symbol at the upper right corner of the window.
The content of this menu varies depending on the measurement selected.
· Delay opens the menu Delay (see page 343[image: ]).
· Mode opens the menu Mode (see page 336).
· Master QT Colors enable this entry to use the same color for the quick – traces as defined in SATlive.
Otherwise the color scheme of the web-client will be used.
· The entry Clear QT Gain resets the gain values for each quick – trace to zero.
The gain used for the display of the quick – traces in the web – client is independent from the value used in SATlive.
· Local Freeze use this option to select the operation of the freeze button (see page 349). When you select the option, then the button freezes only the display of this web – client while other clients and SATlive continue to update their display.
· Autoshow QT enable this option to show a quick – trace immediately after you’ve assigned it. Otherwise it will show automatically only on the SATlive host.
· Auto Edit QT enable this option to show the tag – editor (see page 348) for the label of the a quick – trace during its assignment.
· Show Q / Show Oct use this entry to define the display of the width of the selected range in the range tool (see page 350).
· Show PEQ will display the current settings of the virtual – eq (see page 258) and of the virtual – crossover.
· [image: ]IO Routing will open a sub – menu where you can choose the routing (see page 187) for the ASIO I/O.
This entry will show only when SATlive uses ASIO (see page 184) and more than one routing is currently available.

[bookmark: __RefHeading___Toc29378_15075418641][image: ]The info bar
[bookmark: __RefHeading___Toc41656_2823577171]Display
The info bar shows the values at the current position of the cursor. If the cursor locks to the peak, then the word Peak: is shown. The square on the right side indicates the state of the range tool (see page 350).
If the square is filled, then the display shows the frequency of the latched cursor, the width of the range and the amplitude value at the position of the latched cursor.
[bookmark: __RefHeading___Toc716_2300379342]Actions
· Click in the center area to toggle the lock cursor on peak functionality.
· Click on the arrows at the left or at the right to move the cursor one step in the direction of the arrow. 
This will disable the lock cursor on peak functionality.
· Click on the square area at the right to control the range tool. See page 350 for details about the range tool.
[bookmark: __RefHeading___Toc1001_2300379342]The trace – display
[bookmark: __RefHeading___Toc41658_2823577171]Display
[image: ]The display area shows the result of the current measurement.
You can choose the kind of measurement from the menu Display – Mode assigned to the top – bar (see page 336). 
Depending on the range mode, the borders of the ranges will show as red lines.
The horizontal line on the right shows the amount of gain currently used. The line shows only if the gain differs from zero.

[bookmark: __RefHeading___Toc45759_2930152931]The display in IR – Module
[image: ]While the IR – Module runs in SATlive you can start and save the measurements using the web – client.
In order to run this control, you need to open the window of the automated file – name creation tool (see page 79).
The web – client will change to the IR – control mode as soon as you’ll open the window of the automated file – name creation tool (see page 79).
The info – bar will show the current progress of the measurement. 
· During a measurement it will show the percentage of the measurement completed.
· After the completion it will show Data available as long as the result is not saved.
· While saving it will show Saving
· When the current trace has been saved, it changes to Saved.
If you’ve enabled the Save automatically option in the window of the automated file – name creation tool, then only the button START will show and the label Autosave enabled will inform you that the trace will be saved immediately after the measurement.
Use the button START to start the measurement and the button SAVE to save the result using the trace – name predefined by the automated file – name creation (see page 79) tool.
The button’s label showing in red color indicate that the function is currently locked.
Below the buttons the display will show the file – name that will be used for the next saving of the trace.
The parameter bar will show the file – name used for the previous save.

[bookmark: __RefHeading___Toc44229_2930152931]The delay – matrix
[image: ]The delay – matrix display mirrors the delay – matrix (see page 46).
The info – bar shows the difference in time and the distance between the two time – markers (see page 306) at the selection (marked by a red rectangle).
The parameter bar shows the labels of the selected time markers and their difference in time.
To edit the label of a time – marker click on its current label in the parameter – bar.
Please note, that labels and times of the time – markers are global. Therefore any modification will occur allover SATlive.
[bookmark: __RefHeading___Toc51899_2930152931]The Delay – Finder
[image: ]The offers a functionality similar to the delay – finder in SATlive (see page 135).
Use the arrows in the info – bar at the top to move the cursor. To set the cursor back to center, click in the middle of this area.
In the parameter bar below the display use Zoom In and Zoom Out to adjust the horizontal range of the display.
Use Latches to assign the current position of the cursor to one of the ten time – markers.
Use the button GET IT to generate an new impulse – response and the button APPLY to use the cursor’s position as the current delay.
Apply will also close the delay – finder and return to the previous display. To exit the delay – finder without applying the new delay choose a measurement from the mode – menu (see page 336).

[bookmark: __RefHeading___Toc41660_2823577171]Actions
The four corners of the display area control the layout of the display area. A click outside of the corners will set the cursor to the position of the click and will disable the Lock on Cursor setting.
To lock the cursor to the peak again just click on the Info bar (see page 338).
[bookmark: __RefHeading___Toc62862_477509012]Left corners
[image: ]A click on one of the left corners zooms the display vertically.
· The top – left corner (Symbol: +) zooms into the display.
· The bottom – left corner (Symbol: -) zooms out. 
The current range of the y – axis will display in the parameter – area (see page 342).
[bookmark: __RefHeading___Toc41662_2823577171]Right corners
[image: ]During the display of an impulse – response a click on one of the right corners will zoom the display horizontally. During all other measurements a click will shift the trace vertically by one dB. 
The small line will show the offset. If the offset differs from zero the line will show red.
The current offset will shown in the parameter area (see page 342).
[bookmark: __RefHeading___Toc41664_2823577171]Additional functions during the measurement of the transfer – function
If both traces of the transfer – function show, then the four positions described above will locate in the amplitude – display area (upper area of the display).
The two arrows on the right side of the phase – display area will shift the phase trace vertically in steps of 45°.


[bookmark: __RefHeading___Toc26503_20790591641][image: ]The area parameters
This area is located below the display.
[bookmark: __RefHeading___Toc41666_2823577171]Display
· On the left the currently selected display – range is shown. During the measurement of an impulse – response the zoom – factor of the vertical axis will display here.
· The center position shows the current delay applied to the reference – channel.
· The right position contains information about the vertical shift applied to the trace. During the measurement of the impulse – response the horizontal range of the display will show here.
[bookmark: __RefHeading___Toc41668_2823577171]Actions
· [image: ]During the FFT and transfer – function measurement a click on the left side will bring up the menu display – range. Choose the frequency – range you want display from the menu.
· During IR measurement a click on the left area will set the vertical scaling according to the peak value of the current display.
· [image: ]A click on the right side of this bar shows some preset values for the vertical shift of the trace. Choose the offset you want to apply to the trace from the menu by clicking on the value displayed.
During the display of the impulse – response the menu Time Marker (see page 344) will show here.
· A click on the middle of this bar brings up the delay menu.
This menu is available for all measurements except the RTA mode. See page 343 for details.

[bookmark: __RefHeading___Toc919_2300379342]The menu Delay
[image: ]Open this menu with a click on the display of the delay time in the parameter area (see page 342). You can open it in the menu Main (see page 337) also.
· Calculated this entry sets the delay to the delay – value calculated based on the current measurement.
You can click on the symbol in the top bar also (see page 336).
· 0.0 ms sets the delay to zero.
· Inc coarse increments the current delay by one millisecond.
· Inc fine increments the current delay by one sample.
· Dec coarse decrements the current delay by one millisecond.
· Dec fine decrements the current delay by one sample.
The next three entries will show only when you measure the impulse – response.
· Cursor use this entry to use the current position of the cursor as the delay value.
· Time – Marker navigates to the menu Time – Marker described on page 344.
· Hide all Latches this entry will hide all latches currently visible.
The entry Delay – Finder will open the delay – finder window.
Hint
· The delay value is used as reference in the display of the impulse – response. The read out in the info bar (see page 338) will show the distance relative to this value.
The delaylatches (see page 344) use distances related to time zero.

[bookmark: __RefHeading___Toc1001_1272522533]The Time – Markers
[image: ]You can use the time – marker functions to mark times in the impulse – response display.
There are ten time – markers available. Because the time – markers are global, each client and SATlive will show exactly the same values.
You can use the delay – matrix feature, either in SATlive (see page 46) or in the web – client (see page 340) to read the distances between the time – markers.
In the web – client you can also see the distances for each time – marker.
The time – markers will show as dashed vertical lines.
On the top of each line you’ll see the number of the time – marker shown.
[bookmark: __RefHeading___Toc1057_1272522533]Set a time – marker
[image: ][image: ]The time – marker will always copy the current position of the cursor to. So the first step is to move the cursor to the position desired. 
You can click on the display or use the arrows in the Info bar (see page 338).
Once the cursor is set, open the menu time – markers, which can be found in the menu Delay (see page 343) and in the main – menu (see page 337).
If there is a value assigned to the time – mareker, then it will show an arrow at the right. Click on the entry to open the sub – menu (see page 345). In this sub – menu click on Assign.
Otherwise start the assignment by a click on the name.
Now a window will show where you could edit the label of the time – marker.
Confirm the assignment by a click on OK.
[bookmark: __RefHeading___Toc41670_2823577171]Hints
· You can change the labels in SATlive (310) or in the sub – menu of the marker. (see page 345).
· To cancel the assignment click on CANCEL in the window.
· The appearance of the window varies with the browser used.

[bookmark: __RefHeading___Toc1053_1272522533]The menu Time – Marker
[image: ]You can open this menu, which is available only during the measurement of the impulse – response by a click on the entry Time – Marker in the menu Delay (see page 343).
Each entry represents a time – marker. If you’ve assigned a position to it, an arrow will show at the right, indicating that the sub – menu (see page 345) is available for this entry.
If no position had been assigned so far, then you can assign the position by a simple click on the entry. See page 344 for details on the assignment.
[bookmark: __RefHeading___Toc1055_1272522533]The sub – menu of each Time – Marker
[image: ]This menu is assigned to each time – marker.
It is available only if a value had been assigned to the time – marker  before. To invoke the menu click on the label of the time – marker 
in the menu time – marker (see page 345).
At the top of the menu you can see the number and the label of the selected time – marker.
Click on the label entry to edit the label of this time – marker.
The next line holds the time related to time zero.
Please note that the values shown in the Info bar (see page 338) relates to the delay currently set for measurement (see page 343).
· Show / Hide toggles the visibility of the time – marker.
· Assign assigns the current cursor position to this time – marker. See page 344 for details on assignment.
· Clear reset the time – marker. This entry will reset the time assigned, but not the label. Use SATlive or the delay – matrix (see page 340) to edit the label.
· To X: The delay you need to apply to this time – marker to reach the position of the time – marker indicated by its number.
A negative value indicates that you need to apply the delay to the other signal.

[bookmark: __RefHeading___Toc26505_20790591641]The quick – trace buttons
In the lower part of the web – client you can find eight buttons, each of them assigned to one quick – trace. The buttons are not available during the RTA measurement.
[bookmark: __RefHeading___Toc41672_2823577171]Display
[image: ]The look of the buttons indicates the state of the quick – trace assigned.
· No trace assigned: The button is filled with the background – color of the client, like the QT4 button in the picture.
· Trace assigned and quick – trace not shown: This state is indicated by a dark gray color fill of the button, like the QT1 and the QT3 button in the picture.
· Trace assigned and quick – trace shown: The button is filled with the color which is used to draw the quick – trace, like the QT2 button in the picture.
For details about quick – traces see the section quick – traces starting on page 270 in this document.

[bookmark: __RefHeading___Toc41674_2823577171]Actions
The actions available depend on the state of the quick – trace assigned to the button.
· No trace assigned: In this state, a click onto the button assigns the current measurement to the quick – trace.
· Trace assigned: If the quick – trace contains valid data then a click on the button will open the quick – trace menu.
· The top row shows[image: ] the label of the quick – trace and the color used to draw the trace. A click on it will open the tag – editor (see page 348) for the label.
· Show: displays the quick – trace. With the trace shown, this entry and its functionality will change to Hide and vice versa.
· Assign: replaces the quick – trace data with the current measurement. This will delete the trace previously assigned.
· Clear: removes the currently assigned trace from the quick – trace.
· The next entries show only during the display of the FFT or the transfer – function. They allow control the gain (vertical shift) of the quick – trace. This value will not affect the display of the quick – trace in SATlive or in other instances of the web – client.
· Gain X dB: information about the set gain set for this trace.
· Inc: increments the gain in steps of one dB, moving the trace upwards.
· 0dB: resets the current gain of this trace to zero. 
· You can zero all eight quick – traces at once using the entry Clear QT Gain in the menu Main (see page 337 for details).
· Dec: decrements the gain in steps of one dB, moving the trace downwards.


[bookmark: __RefHeading___Toc55932_477632669]The tag – editor for the quick – trace labels
[image: ]You can use this editor to label a quick – trace. To invoke the editor click on the top entry in the menu of each quick – trace (see page 346).
With the option Auto – Edit QT selected in the menu Main (see page 337), the editor will show automatically when you assign the current trace to a quick – trace using the web – interface.
The first click will empty the label area at the top and afterwards insert the tag assigned. A space will be added after each tag contained in the two rows at the top. The numbers will be added without a space character. You can use the _ entry to add a space manually or the ← entry to remove that last character of the label.
Use Clear to empty the label, Cancel to abort editing and Apply to close the editor and to apply the changed label. Please note that an empty label will be ignored.
The tags will synchronize with the tags set in SATlive (see page 281) at each start or refresch of the web client.

[bookmark: __RefHeading___Toc28624_20790591641]The control buttons
The three buttons at the bottom allow the control of the current measurement.
[bookmark: __RefHeading___Toc41676_2823577171]Display
[image: ]The status of the action assigned to the buttons is indicated by the color of the button. An activated option is indicated by a dark – gray color.
[bookmark: __RefHeading___Toc604_676710535]Actions
The action assigned to each button is indicated by its label.
· FREEZE: Toggles the freeze state of the display. A frozen display will latch the current state until freeze will be disabled. Use the entry Local Freeze in the menu setup (see page 336) to select if this button will freeze the web-client only or both, web-client and SATlive.
· RESET: This button resets the current measurement and clears the trace of the measurement.
· SOUND: Toggles the state of SATlive’s signal – generator.
· LESS: Decreases the output – level of SATlive’s signal – generator.
· MORE: Increases the output – level of SATlive’s signal – generator.
· See page 223 for more details on the signal – generator.

[bookmark: __RefHeading___Toc25537_12387279501]The status area
[bookmark: __RefHeading___Toc41678_2823577171]Display
This area shows the current state of the network connection.
· [image: ]Connected to SATlive 
· [image: ]Network connection interrupted or SATlive no longer running.

Hint: The web – client tries to reconnect every second.
[bookmark: __RefHeading___Toc1374_3015388841]The range tool
The range tool enables you to get the parameter for equing easily. It is available in the FFT and the Transfer – function measurement.
The tool uses the Info bar for readout and control.
· Set the cursor to the center of the area you want to equalize.
· [image: ]Latch the cursor by a click on the square at the left of the Info bar. The square will change to solid fill.
· Now you can mark the range of interest by moving the cursor, either by clicks on the display or by using the arrows in the Info bar.
· [image: ]As soon as you move the cursor, the range will be marked in the display.
· The thick red solid line indicates the cursor,
· The red dotted line is the latched cursor
· The thin red solid line is calculated by the client assuming the latched cursor is the center of the range.

· [image: ]The parameters show in the Info area.
· The frequency of the latched cursor shows at the left. Use this value as the center frequency of the eq.
· The next entry shows the width of the marked range. Use the entry in the menu Main (see page 337) to toggle the display between Q (Quality) and Oct (Octaves) according to your processor.
· The third value shows the amplitude at the position of the latched cursor. Opposite to the normal read – out this value will use the currently set gain. That allows you to use the center line of the display as a your target by shifting the trace up or down using the gain setting.
· [image: ]To release the latch, just click on the square again. It will turn back to the framed display, the range lines will disappear and the info bar will show the parameters of the current cursor again.

[bookmark: __RefHeading___Toc41680_2823577171]Fixing Problems
[bookmark: __RefHeading___Toc41682_2823577171]Basic checks
If you're facing problems with SATlive, you should check these things first
· Is your audio-device properly connected and powered?
· Are you using the most current drivers for your audio-device?
· Are you using the most current version of SATlive? 
Use the update – check function (see page 357) or look at the web site https://www.satlive.audio/en/portfolio/the-current-version/ for the most current version.
· If the audio-device does not work via ASIO but does with the other audio-driver types (see page 180) then check if other software might use the audio-device at the same time.
· If none of the above solves the problem, you can reset the current settings to their default values (see page 353). 
· If the problem is related to a certain kind of audio driver, you can use the Enable/Disable Driver window (see page 354 for details) to disable the problematic audio drivers.
[bookmark: __RefHeading___Toc53423_3057959138]Solving Display Problems
· The key – combination Ctrl – Alt – M will reset the menu-area.
· The key – combination Ctrl – Alt – R will scale the main window to 1024 by 768 pixels and center it on the current monitor.
· Recall one of the display – presets in Setup → Display (see page 193).

[bookmark: __RefHeading___Toc41684_2823577171][bookmark: Ref_reset1][image: ]Resetting the settings to default
A lot of problems will be fixed if you reset the current settings to their default values.
Resetting the values clears all of your settings to the default settings.
[image: ]To access the reset dialog, keep the F10 key pressed when you start SATlive.

If SATlive has crashed during the last run, then the dialog[footnoteRef:4] is shown automatically. [4: 	The images are taken on a pc with German language settings. On a pc with English language settings the labels on the buttons may vary (Ja = Yes, Nein = No, Abbrechen = Cancel).] 


[image: ]If you choose to reset the settings, a second security question has to be confirmed before the settings, both for the audio-IO and for the software itself is renamed. After that SATlive starts and creates a new setting files with default values.
[bookmark: __RefHeading___Toc41686_2823577171]Where are the setting files located?
SATlive creates a directory where it stores the setting-files and other files, like the Quick – traces. You can access this directory using the shortcut Ctrl – Alt – F.
The directory stays open after you've closed the main program. 
Because SATlive updates the files on its shutdown, changes in this directory make sense only when SATlive is not running.
Any change in this directory might affect the stability of SATlive.

[bookmark: __RefHeading___Toc53425_3057959138]Audio Error Message
[image: ]If SATlive faces a problem related to the audio I/O, it will show you a warning window, containing different options.
· Exit SATlive closes SATlive.
· Start working offline SATlive will disable the audio I/O and continue. In this case you can work with stored traces only, because no measurements can be performed without audio input.
· [bookmark: __RefHeading__21447_1132721720][bookmark: Ref_enableDriver]Open the setup window opens the audio setup (see page 180), where you can choose an other device or adjust the parameters of the current device.
[bookmark: __RefHeading___Toc53427_3057959138]Enable/Disable Audio Driver
SATlive supports three concepts of audio-device interfacing. You can use the setup → I/O device section (see page 180 for details) to select the concept ('kind of driver') you want to use. In order to offer only driver concepts which will work with your current hardware, SATlive checks the functionality of all three concepts during start-up.
Under some circumstances SATlive may freeze during the check due to erratic behavior of the audio-interface drivers. 
To avoid this problem, you can disable a driver concept in the Enable/Disable Audio Driver window. 


[bookmark: __RefHeading___Toc41688_2823577171]How to open the window
There are three different ways to access the Enable/Disable Audio Driver window:
· In Setup->I/O device (see page 180) click on the button Enable/Disable Audio Driver. 
· Press and hold down the F10 key during the start of SATlive. This will open the Reset Settings (see page 353) window and after you've closed that window by clicking on Cancel, the Enable/Disable Audio Driver window shows up. 
· If SATlive fails to start or was not closed properly, the Reset Settings (see page 353) window will show up on the next start of the software. After you've closed that window by clicking on Cancel, the Enable/Disable Audio Driver window shows up. 
[bookmark: __RefHeading___Toc41690_2823577171]The settings
[image: ]To disable a certain audio-driver concept, simply uncheck the box left to the concept's name. 
To enable an audio-driver concept, just check the box left to the name of the concept.
To check or uncheck simply click on the box with the left mouse button.
Click on OK to apply the changes or click on Cancel to discard the changes.

[bookmark: __RefHeading___Toc41692_2823577171]The menu Help
[image: ]You can find the menu Help in the upper menu bar.
· [image: ]Connections: This entry shows you how to hook up your external devices. You can find this information in this document starting on page 25.
· About SATlive: This function shows a small window containing information about the version of SATlive you're currently using.
· [image: ]Help: Opens the windows help – file assigned to SATlive. You can use the F1 key also to invoke the help – file.
· [image: ]Register: Choose the registration task to perform from the sub – menu.
This entry is not available if a valid dongle is plugged in. See page 17 for information about using a dongle.
· Full Version: Order a full version key and perform the registration process. See page 220 for details about the steps of a registration.
· Demo Version: Request and install a demo – key. See page 16 for details.
· [image: ]Show all Errors: Open the error – report window. See page 219 for details.
· Search for Updates: Checks if a newer version of SATlive is available for download. See page 357 for details about the update – check function.

[bookmark: __RefHeading__28544_823354303]The update – check function
Use this feature to check if you're running the most current version of SATlive.
[bookmark: __RefHeading___Toc41694_2823577171]How to check for Updates:
· If you've set an interval for the update check, then SATlive will check for an update automatically during the start of the program, when the interval is reached.
You can set the interval in the Setup → Features window (see page 203 for details).
· [image: ]The menu Help in the upper menu area contains the entry Search for Updates, which performs an update check.
· [image: ]An update check is performed also when you invoke the version information window, which can be done using the key combination Ctrl + Alt + V on your keyboard.
In the case of an update available, the information update available is shown in the display.
[bookmark: __RefHeading___Toc41696_2823577171]Details about the Update – Process
[image: ]During the update check SATlive loads a small text file from the SATlive server.
This file contains the ids of the most current versions available for each language.
Now SATlive compares it's version with the version information in the file. If there is a new version, then SATlive will show a small window, indicating that a new version is available.
If you close the window by a click on the YES button then your internet browser will start and the SATlive download page is opened in the browser.
SATlive will not send any information to the internet nor does SATlive perform any download except of the version – information file.
So you must trigger the download and run the installer by your self.

[bookmark: __RefHeading___Toc41698_2823577171]Appendix
[bookmark: __RefHeading___Toc41700_2823577171][bookmark: hs161]Thanks to
· Bill Waslow (www.libinst.com) for sharing his knowledge and experience.
· Uli Müller (www.audiotester.de).
· The beta testers Stefano Bettinsoli, Tamas Tako, Lukacs Sudar, Steffen Romeiß, Wolfgang Rathke, Marco Habeck, Ziheng Wang, Jan R. Šafařík (Soundman.cz) and Maciej Blachnio.
· Ziheng Wang for proofreading this document.
· Jan Goyvaerts creates HelpScribble (http://www.helpscribble.com), the software which creates the help file.
· Jordan Russel (http://www.jrsoftware.org) for his Toolbar-Component and the Inno Setup installer software.
· [image: ]Martin Fay (www.martinfay.com) created the openASIO DLL which was used in previeous versions of SATlive.
· Frederic Vanmol (www.axiworld.be) who made a Delphi Interface to access ASIO drivers, which enables SATlive to use ASIO drivers.
· David Barton (www.cityinthesky.co.uk) builds the cryptographic software used in SATlive.
· SATlive uses the graphics32 (www.graphics32.org) library. 
· All SATlive users who send suggestions, report errors and shared ideas.
· To my wife, allowing me to spent so much time on the pc.
· To the LIVING-WATER gospel choir (www.living-water.de) for all the challenges. 
I love those old church buildings here in Germany.
· Last but not least to my lord and savior Jesus Christ.

[bookmark: __RefHeading___Toc65253_3672662817]License information for the libraries used
[bookmark: __RefHeading___Toc65255_3672662817]Graphics32
www.graphics32.org
[bookmark: __RefHeading___Toc65257_3672662817]The contents of this file are subject to the Mozilla Public License Version 1.1 (the "License"); you may not use this file except in compliance with the License. You may obtain a copy of the License at http://www.mozilla.org/MPL/
[bookmark: __RefHeading___Toc65259_3672662817]Software distributed under the License is distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the License for the specific language governing rights and limitations under the License.
[bookmark: __RefHeading___Toc65261_3672662817] Alternatively, the contents of this file may be used under the terms of the Free Pascal modified version of the GNU Lesser General Public License Version 2.1 (the "FPC modified LGPL License"), in which case the provisions of this license are applicable instead of those above.
[bookmark: __RefHeading___Toc65263_3672662817]Please see the file LICENSE.txt for additional information concerning this license.
[bookmark: __RefHeading___Toc65265_3672662817]The Original Code is Graphics32
[bookmark: __RefHeading___Toc65267_3672662817]The Initial Developer of the Original Code is Alex A. Denisov
[bookmark: __RefHeading___Toc65269_3672662817]Portions created by the Initial Developer are Copyright (C) 2000-2009 the Initial Developer.
[bookmark: __RefHeading___Toc65271_3672662817]All Rights Reserved.
[bookmark: __RefHeading___Toc65273_3672662817]Contributors:
[bookmark: __RefHeading___Toc65275_3672662817]	Michael Hansen <dyster_tid@hotmail.com>
[bookmark: __RefHeading___Toc65277_3672662817]	Andre Beckedorf <Andre@metaException.de>
[bookmark: __RefHeading___Toc65279_3672662817]	Mattias Andersson <mattias@centaurix.com>
[bookmark: __RefHeading___Toc65281_3672662817]	J. Tulach <tulach at position.cz>
[bookmark: __RefHeading___Toc65283_3672662817]	Jouni Airaksinen <markvera at spacesynth.net>
[bookmark: __RefHeading___Toc65285_3672662817]	Timothy Weber <teejaydub at users.sourceforge.net>


[bookmark: __RefHeading___Toc65287_3672662817]DcpCrypt
[bookmark: __RefHeading___Toc65289_3672662817]www.cityinthesky.co.uk/

[bookmark: __RefHeading___Toc65291_3672662817]DCPcrypt is copyrighted (c) 1999-2003 David Barton.
[bookmark: __RefHeading___Toc65293_3672662817]Permission is hereby granted, free of charge, to any person obtaining a 
[bookmark: __RefHeading___Toc65295_3672662817]copy of this software and associated documentation files (the "Software"), 
[bookmark: __RefHeading___Toc65297_3672662817]to deal in the Software without restriction, including without limitation 
[bookmark: __RefHeading___Toc65299_3672662817]the rights to use, copy, modify, merge, publish, distribute, sublicense, 
[bookmark: __RefHeading___Toc65301_3672662817]and/or sell copies of the Software, and to permit persons to whom the 
[bookmark: __RefHeading___Toc65303_3672662817]Software is furnished to do so, subject to the following conditions:

[bookmark: __RefHeading___Toc65305_3672662817]The above copyright notice and this permission notice shall be included in 
[bookmark: __RefHeading___Toc65307_3672662817]all copies or substantial portions of the Software.

[bookmark: __RefHeading___Toc65309_3672662817]THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER 
[bookmark: __RefHeading___Toc65311_3672662817]LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.


[bookmark: __RefHeading___Toc65313_3672662817]openAsio
[bookmark: __RefHeading___Toc65315_3672662817]Steinberg Audio Stream I/O API
[bookmark: __RefHeading___Toc65317_3672662817](c) 1997 – 2005, Steinberg Media Technologies GmbH
[bookmark: __RefHeading___Toc65319_3672662817]--------------------------------------------------------------------------------
[bookmark: __RefHeading___Toc65321_3672662817]Delphi translation by Frederic Vanmol (frederic@axiworld.be)
[bookmark: __RefHeading___Toc65323_3672662817]Thanks to
[bookmark: __RefHeading___Toc65325_3672662817] - Martin Fay for OpenAsio.dll
[bookmark: __RefHeading___Toc65327_3672662817] - Florent Ouchet for the asm code that makes OpenAsio.dll unnecessary
[bookmark: __RefHeading___Toc65329_3672662817]          (http://www.delphigroups.info/2/2/1024225.html)

[bookmark: __RefHeading___Toc41702_2823577171]Release information
· 05-07-2020 (1-70-60)
· Layout of the Amp – Threshold setting changed (see page 162).
· Visibility of the button Noise – Threshold (see page 163) can be configured in Setup → Measurement (see page 200).
· 04-17-2020 (1-70-58)
· All-pass filter added to virtual X-Over (see page 263).
· Added sample steps to virtual time – shift (300) tool.
· Fixed: Leaving transfer – function measurement takes to much time.
· 04-09-2020 (1-70-56)
· Fixed some minor issues.
· Improved frequency – range tool (see page 96).
· 03-10-2020 (1-70-54)
· Fixed some issues in the RTA.
· 02-17-2020 (1-70-52)
· Added tags to the quicktrace name editor (see page 280).
· Added tags to the web – interface (see page 348) for labeling quicktraces.
· Added autoadjust for vertical scale in IR display (web – interface).
· Added global quicktrace display options in the IR module (see page 275).
· Improved performance and stability of the web – interface.
· 10-23-2019 (1-70-50)
· Added +/-60° option to the delay – suggestion tool (see page 296).
· Added single – shot / free – run buttons to the oscilloscope (see page 74).
· Added Transfer – function fast refresh option to setup → measurement (see page 200).
· Added polarity information to the time – markers ( see page 306).
· Added global show / hide function to the time – marker menu (see page 308).
· Added save / recall function to the time – markers.
· 07-19-2019 (1-70-48)
· Fixed: virtual Eq not working for sum – trace (in MAT module)
· Fixed: Flipped Butterworth and Bessel filters.
· 06-18-2019 (1-70-46)
· Added a simple wav-player, see page 232.
· Tracemanger traces will show in the background of the impedance display (see page 129 for details).
· Impedance display now supports single window display.
· Reworked the tracemanger (see page 235).
· Added a scaling option for the quick – trace buttons (see page 198).
· Internal fixes and improvements
· 02-25-2019 (1-70-40)
· Key combination Shift + A fits vertical scaling to delay zoom window (see page 132).
· Key combination Shift + P sets cursor to peak in the delay zoom window (see page 132).
· Changes in the menu Main (see page 337) of the web – interface. 
· Added selection of ASIO connections (see page 187) to the menu Main of the web – interface.
· Fix: Complex Compensation not working for MLS white and MLS pink.
· Fix: Problem loading quick-traces (especial using projects) created with previous versions of SATlive.
· Fix: Not all peq – settings will show in the web – interface.
· Fix: Header not updated when changing Q values in the peq using sliders.
· 09-02-2019 (1-70-40)
· Combined delay – latches and time – markers ( see page 306).
· Automated File – Name Creation in the IR module (see page 79).
· Delay Zoom Window in MAT → IR can now center at the cursor position (see page 132).
· Local peak – finder in the Delay Zoom Window (see page 132).
· Peak position and local – peak now available in the delay – matrix (see page 46).
· Web – client (see page 333) modified to work with all ten time – markers.
· Delay – Matrix (see page 340) added to the web – client.
· Delay – Finder (see page 340) added to the web – client.
· Fixed an issue affecting the quality of the impulse – response in MAT.
· Fixed a synchronization related issue in IR module.
· Improved drawing routines.
· Reordering / Clean – up of some menus.
· A lot of internal changes (hopefully improvements).
· 09-13-2018 (1-70-34)
· Standardization of the trace selection for calculations (see page 289).
· Fixed a buffer – overflow in the calculation of the perfect – addition trace.
· 09-01-2018 (1-70-32)
· Added Keep Alive option to the delayfinder. (see page 138).
· Modified the auto mode of the range – selection tool. (see page 99).
· 08-08-2018 (1-70-30)
· Multi – Trace support in room acoustic.
· Improvements for high – res displays.
· Added ‘Block Screensaver’ option (see page 205).
· Project management modified.
· Weighting affects color option added (see page 241).
· On demand of steinberg: Added some of their ASIO artwork.
· 01-28-2018 (1-70-28)
· Fixed: Mic-correction will not load from TXT file
· Faders will not show in virtual Eq
· some internal improvements
· 12-13-2017 (1-70-26)
· Improved support for multi display configurations
· Added D50 and D80 to display in room – acoustic window (see page 52)
· Added display of regression lines for RT values.
· Reworked windowing in IR modul.
· Difference in time will show in delay – finder window.
· File system improvements.
· Range selection mode will be indicated by an icon. 
· Key W will toggle the range – selection mode.
· Range – tool (see page 350) added to the web – client.
· Delaylatches now available in web – client, too (see page 344).
· Added Mute freezes Display option to the signal – generator (see page 224).
· Reworked the windowing section of the IR – module.
· Fixed a lot of errors and oddities.
· 05-28-2017 (1-70-24)
· Added the Valid only if all Traces Valid option to the menu Sum – Trace.
· Moved the Quick – Trace related content from the menu Sum – Trace to the new menu Quick – Trace Setup (see page 273).
· Added a Clear File List entry to the mic – correction sub – menu.
· Added a button to invoke the popup menu Configuration directly.
· Fixed: Loading of static trace into live – trace not working.
· 04-20-1027 (1-70-22)
· Fix: Moving the mouse in the info – area in Mat → Impulse – response causes an error.
· Fix: Popup menu oddities.
· Fix: Spectrograph display not working (in some configurations).
· 04-12-2017 (1-70-20)
· Fix: Distance display shows zero all the time.
· Fix: Recalling a delay – value in the previous – delay section of the delay popup menu fails with an error.
· Fix: Value display in IR module slow when moving the cursor.
· Fix: Popup menu oddities in MAT – module.
· Extended display range for groupdelay.
· 11-28-2016(1-70-16)
· New colors for the visualization of the Quick – trace status (see page 270)
· Changed menu for live – add trace (see page 291)
· Changed menu for Delta – trace (see page 293)
· Changed the audio – error handling window (see page 354).
· Some fixes
· 11-21-2016(1-70-14)
· New: Virtual Time Shift (page 300)
· New: Configure Schroeder Trace (43)
· Fix:   Wave – I/O not starting
· Fix: Import of wave – files in IR fails sometimes
· Fix: Live Add Trace not showing at high frequencies
· Fix: Smoothing might shift Live – Add Trace.
· Fix: Exporting quick – traces as TXT or CSV does not work for transfer-function traces in MAT module.
· 10-25-2016(1-70-12)
· Changed links to fit the new website (https://www.satlive.audio).
· 09-21-2016 (1-70-08)
· New: Peak Hold in RTA display
· New: Reset on Sound Start option in the popup menu of the signal-generator (see page 224)
· A lot of fixes
· Reworked the GUI
· 08-13-2016 (1-70-06)
· New: Interaction area (see page 295)
· Quick – trace menu extended (see page 271)
· Fix: Room size edit field much to small
· Fix: Pink Grid not showing
· Fix: Color preview shows wrong color in setup → display
· Fix: Cursor read out shows no negative values (IR module, linear display)
· Fix: Quality of calculation decreases when input levels are low
· Fix: Display of Delay – Suggestion tool (not fully shown in some cases)
· 03-21-2016 (1-70-04)
· Fix: Web-Client showing strange phase (when smoothed)
· Fix: Peak finder not working in web-client during IR display
· Add: Local – Freeze for web-client (freezes display in client only)
· 03-16-2016 (1-70-02)
· Fix: Fq Display Zero in room – project if only one data set assigned
· Fix: Sooth – Handling (quick – trace)
· 03-14-2016 (1-70-01)
· Added: Resolution 1/48 octave.
· Added: Room Project (see page 62).
· Added: web – control (see page 333).
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